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1.1 Document Structure

The SiteManager User Reference Manual is a reference document for users of the AASHTO
SiteManager application. The user should refer to this manual only when a question cannot be
answered by referring to the SiteManager online help system. This manual describes all of the
SiteManager components, including their purpose, functions, and how to use them.

The SiteManager application is organized into the following eight major functional areas, which are
represented by icons on the main panel:

e Contract Administration

e Daily Work Reports

e Pipeline

e Contractor Payments

e Change Orders

e Civil Rights

e Materials Management

e Laboratory Information Management System (LIMS)

This manual is organized into the same eight functional areas plus introductory and supplemental
information. The topics Key Dates, Checklist Scheduled Events, and Checklist Event Dates are
covered in a separate section of the manual due to their importance throughout the life of the
Contract. The manual’s main sections are described below:

Section 1 Introduction

The Introduction describes the structure and objective of this manual. Refer to this section for an
overview of the manual’s topics, or to find out how this manual is intended to be used.

Section 2 Getting Started

The Getting Started section includes information to help the user get started using SiteManager.
This includes information about starting and exiting SiteManager, changing your password, and In-
Box message functions. This section also includes descriptions of SiteManager’s graphical
components and how to use them to navigate within the application and to accomplish tasks.

Section 3 General Concepts

The General Concepts function describes the menus, toolbars, and the components that are common
throughout the application. It includes common procedures for using online help, security, and
reporting.
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Section 4,5,and 6 Contract Administration

The Contract Administration section describes the reference tables that store standard Contract data,
such as default date types, Contract Item descriptions, and Vendor information. It provides an
overview of how to add Contracts to the system, and describes each panel that is used to view,
modify, or delete Contract data. It also describes the panels that are used to maintain data related to
Contracts, such as Contractor (Vendor) information, conference records, force accounts, dispute
records, evaluations, correspondence records, required documents, and Contract reports. This
section also describes how the system validates Contract status and how the Project Manager
finalizes a Contract.

Section 7 Key Dates, Checklist Scheduled Events, Checklist Event Dates

This section describes how the user views and maintains Key Date and Checklist Scheduled Event
data. This data is used to administer the Contract and to monitor compliance with Civil Rights
provisions.

Section 8 Daily Work Reports

The Daily Work Reports section explains the concept of reporting, transferring, and storing daily
Contract activity data. This section defines the data that is collected by the Daily Work Report
function, and describes how to record the data on SiteManager panels. It also describes how Daily
Work Reports are approved, combined to make Diaries, and maintained in the database.

Section 9 Pipeline

The Pipeline section describes the SiteManager components that are used to upload and download
data to and from the Server database, and to transfer data from one workstation to another in the
field. These components are provided specifically for the Project Manager and Inspector who must
transfer Contract data, Materials data, and Sample and Test data. This section explains how Pipeline
is used in conjunction with the Daily Work Report function and Materials Management.

Section 10  Contractor Payments

The Contractor Payments section describes the estimate generation process and the reference tables
that store data related to Contractor Payments. This section defines the estimate types and
generation parameters, and gives an overview of calculations performed by the system. It explains
how the system identifies Contract discrepancies and how the user can adjust Contracts and Contract
Items. It also explains the estimate approval cycle and the Contractor Payment reporting options.
The reference tables described in this section define the price adjustment indices, Autopay ltems,
discrepancy options, and Contractor payment approval levels.

Section 11  Change Orders

The Change Orders section describes the Change Order reference tables, types of Change Orders, the
approval process, and Change Order reporting options. It explains how the user creates and tracks
Change Orders.



Trnseport SiteManager®
1. Introduction 1.1 Document Structure

Section 12 Civil Rights

The Civil Rights section describes the reference tables and panels used to add and monitor data
related to Civil Rights. These components let the user define programs, maintain trainee records,
monitor compliance with DBE commitments, record wage decisions, and run reports on these
records.

Section 13 Materials Management

The Materials Management section stores Materials information, including inventory, specifications,
testing requirements, mix designs, and lists of approved suppliers, personnel, labs, equipment, and
fees. It explains how to build and maintain a Contract Materials List, how to enter sample data and
track test results, and how to run reports. It also provides online access to sampling and testing
procedures.

Section 14  Laboratory Information Management System (LIMS)

The Laboratory Information Management System section streamlines the sampling and testing
workflow from recording a sample to reviewing and authorizing samples. It explains how to capture
sample details, assign default tests, assign and receive at destination lab, and how to enter test
results, review test results, and authorize.

Appendix A Glossary
The Glossary defines terms used in the SiteManager application.
Appendix B SiteManager Navigation

This appendix includes an overview map of the SiteManager application and detailed maps for each
functional area of the application.

Appendix C Estimate Generation Calculation

This appendix describes the components of the estimate generation process and explains how the
system calculates the values reported on an estimate.

Appendix D Retainage Calculation

This appendix describes one component of estimate generation, retainage calculation, which
involves relatively complex calculations. Examples show the calculation results.

Appendix E  Materials S & T Calculations

This appendix gives an overview of the parameters and calculations for comparing sampling &
testing results to contract sampling & testing requirements.

Appendix F  Price Index Adjustment Calculation

This appendix gives an overview of the methods used by the system to calculate price adjustments.
Examples show the calculation results.
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1.2 Objectives

This document serves as a supplement to the SiteManager and SiteManager LIMS online help
system. The user can refer to this manual for information that is not covered in depth in the online
help. This includes field descriptions, expanded topic discussions, calculations performed by the
system, error message definitions, and system administration functions. Some of this information is
presented as separate appendices in this manual.

This manual assumes that the user is authorized to use every function provided by the application.

In actual usage, some SiteManager functions can only be used by the System Administrator, Project
Manager, or central office personnel with global Contract authority. Some users will have view only
rights to certain panels. In most cases, this manual does not identify the transportation agency
personnel who will have the authority to use each function; this is done by the transportation agency.

The transportation agency should keep at least one copy of this manual in every office for occasional
reference. The local technical support personnel should have a copy of this manual as part of a basic
reference set.

1.3 Procedures

SiteManager Procedures, the steps the user follows to access a component of SiteManager, vary
depending on whether the user has just entered the system or has been in some other component and
has already selected a common variable.

For instance, if the user enters the application and navigates directly to the Contractor Payments
component, the Estimate Summary window requires the selection of the desired Contract and
Estimate.

However, if the user has been working in the Contract Records component, already has a Contact
selected, and then navigates to the Contractor Payments component, the Estimate Summary window
displays for selection the Estimates for the Contract previously selected in Contract Records.

Note: The procedures in this manual describe how to access components of
SiteManager as if the user just entered the application.
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2.1 Understanding the General Workflow

2.1.1 Trnseport SiteManager Software

SiteManager is a comprehensive construction management and lab information management
software product that covers the complete construction and materials management process from
contract award through contract finalization in one enterprise-wide software package.

2.2 Starting and Exiting SiteManager

2.2.1 Starting SiteManager

The AASHTO Trnseport SiteManager Construction Management System is

a Windows application, which will run on several different windows #
graphical user interfaces — Microsoft Windows XP and Microsoft

Windows Vista. For your operating system, you will start SiteManager the Figure 2-1.

same way you would any program on your computer. The SiteManager Icon

In Microsoft Windows, the SiteManager program will be located with its own icon displayed on the
main desktop, as illustrated in Figure 2-1..

For Microsoft Windows XP and Windows Vista

To start on the AASHTO SiteManager system:

1. Double-click the SiteManager desktop icon.
Type your logon identification name.
Press the Tab key.

Type your password.

o & w0 DN

If appropriate in the Connect to drop-down list, click the expand arrow to the right of the
current selection and click the desired database choice.

6. Press Enter.
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7. If appropriate in the Available Group for ... dialog box, click the group ID.

8. Press Enter.

SiteManager Logon

Figure 2-2. The SiteManager Logon Dialog
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Available Groups for SYS1 |

Central Office test

Group Hame

Audit Section

|District Conztruction Engineer

|Fec|era|

|Inspec:tur kd ar

Select the Group for the zezsion.

1] 4

Figure 2-3. The Group Dialog Box

2.2.2 End-User Security — Changing Your Password

In addition to your network logon identity, SiteManager also has password protection. Your
SiteManager ID determines what information you have access to and whether you can update the
data or not. If you have any questions regarding your SiteManager security access, contact your

SiteManager system administrator.

Change Password for SYS1 Ed

0Id Pazsword: ||

Mew Password: |

Confirm Password: |

114

Cancel

|Enter the Od User Password,

Figure 2-4. The Change Password Dialog Box
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When a user fails to logon to SiteManager successfully after 3 attempts, a message appears advising
the user to contact the System Administrator. The System Administrator resets the user’s password.
The password is always reset to PASSWORD and is case sensitive. When any User logs on using
the default password PASSWORD, the only option visible (besides Cancel) is the Change Password
option. Users are forced to change their password before they can access the application.

There is an exception to the rule that 3 failed logon attempts lock the users out of the system. An
Inspector using SiteManager in standalone mode may have an infinite number of failed logon
attempts without being locked out of the system.

To change your password:
1. Start SiteManager.
On the logon screen, type your old password.
Click the Change Password button.
Type your old password.
Press the Tab key.
Type your new password.
Press the Tab key.
Type your new password, again.

Click Ok.

© 0o N o g B~ W D»

2.2.3 Exiting SiteManager

As with all Windows applications, the File menu’s Exit choice allows you m_q-
to end your SiteManager work session and exit the application.

Additionally, SiteManager has an Exit button on the Toolbar that is even
more convenient. If you have been performing work and have changed
your data (or even if SiteManager is not sure) a warning message will
allow the data to be save before the application is closed or to cancel the
exit process.

Figure 2-5. The Exit Button
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To exit SiteManager:
1. Click the Exit button.
Or
2. Click the File menu and click the Exit choice.

3. If appropriate, click the Yes or No button.

Figure 2-6. The Exit Warning Message

2.3 SiteManager Main Panel

After starting the SiteManager application, the SiteManager Main Panel will display the components
of the system as icons. The central functionality of SiteManager is divided into ten icons: Contract
Administration, Daily Work Report, Pipeline, Contractor Payments, Change Order, Civil Rights,
Materials Management, Accessories, System Administration, and Manuals. The icon representing
SiteManager Lab Information Management System (LIMS) is embedded within the Material
Management- Maintain Sample Information window.
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Figure 2-7. The SiteManager Panel

2.3.1 Security and the SiteManager Components

The panels and icons to which an end-user has access are defined by the transportation agency. The
panel above and all following documentation will describe and illustrated the content of the all
components of SiteManager. A given end-user’s panels may not conform to the illustrations
(figures) unless they have security access to all components of SiteManager.

2.3.2 The SiteManager Status Bar

The SiteManager Status Bar at the bottom of the SiteManager window indicates your mode,
connection, database region, logon group and individual ID.

| Ready

\

Mode

Connection

[Server [STest

/

Region

Figure 2-8. The Status Bar

Group ID

[traind

/

Logon ID

[Inspi
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Panel Icons - SiteManager Functional Areas

Icon Description

Automates recording of important Contract data, including
_f’ Contractor contacts, Contractor documents, and plan
- discrepancies.

Contract Automates verification of Contractor payrolls.
Administration Provides a mechanism to modify a Contract and document that
change.

Tracks critical dates for recurring contract items and special events.
Calculates liquidated damages and contract retainage.

Supports Contract Management with reference table viewing and
maintenance for funding sources, item masters, vendors, and
administrative offices.

Allows SiteManager users to enter and maintain SiteManager
Contract data, including project items and funding.

Controls Contract access through Contract specific and
administrative office authority.

Maintains Contractor and Subcontractor details.
Assists project management by tracking Contract status.

Furnishes capability to monitor Contract disputes/claims.

Collects Inspector Daily Work Reports data, field samples, field
tests, and stockpiled materials used.

Automatically transfers (download) base Contract data for
Daily Work Report reference (Contract items, quantities, etc.).

Collects and maintains Contractor data including Contractors
working, work performed, and equipment used.

Collects and maintains installed item quantities, weather conditions,
staff/consultant hours, and Force Account information (labor,
equipment, and materials).

Links to reference documents stored in third party packages such
as word processors, spreadsheets, sketching tools, etc.

Allows on-line review of the Daily Work Report and authorization for
incorporation into the Estimate process.
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Icon Description

Allows collected data on a laptop or pen-enabled laptop computer
in the field or a workstation in a project office to be transferred
(uploaded) to the SiteManager database.

Allows the Project Manager and Inspector to upload and download
|_ data.
s
Pipeline
% Automatic generation and approval of payment estimates, based on

e the Contract and any Liquidated Damages, Contract Adjustments,
i and stockpiled data.

Automatic calculation of DOT-defined adjustments for liquidated
damages, incentives, disincentives, and Contract item price
adjustments.

Contractor Payments

Automatic calculation of retainage amounts, encumbered amounts
for securities, and escrow accounts, based on Contract parameters.

Discrepancy reporting and resolution during the estimate process
for certified payrolls, DBE commitments, item overruns, and
material testing deficiencies.

Tracking the estimate from the generation process through the
approval process.

Creation of voucher data from the payment process which can be
used as input to a DOT-specific financial management system.

Automatic management of stockpiled material as the material is
being used.

Provide Stand Alone capability (i.e., Installed Work Summary
Report).

Ensures Contractor acceptance of changes by including
G Contractors in change order review and approval process.
Ensures consistency in the change order process.

Change Order Establishes, maintains, and approves Force Accounts which
includes details on labor, equipment, and material cost.

Tracks review and approval process to ensure accountability.

Assists in future planning by providing a means to track and identify
reasons for change.
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Icon Description
I Automates recording and tracking of Disadvantaged Business
m Enterprise goals/commitments, including the ability to track DBE
= work performed on non-goal contracts.
Civil Rights Automates generation of Federal Highway Administration DBE

report detailing the level of DBE earnings on federal contracts.

Allows for planning and tracking of contract On-the-Job Training
goals, including number of trainees, number of hours, and wage
rate adjustments.

Automates reporting of potential wage rate violations based on pre-
defined Department/DOL wage decisions.

Automates generation of annual Equal Employment Opportunity
reports based on contractor payrolls.

Automates accrual of department trainee experience (even across
contracts) based on contractor payrolls and alerts department
personnel to potential violations

Automates tracking of training experience on non-department
contracts.

P

Material Management

Maintains Material Information.

Documents Sampling and Testing for a Contract or Client.
Incorporates Sampling and Testing requirements.
Maintains Approved lists.

Creates and maintains five types of Mix Designs.
Provides thirty Test windows.

Provides Stand-alone capability (Sampling & Testing and Approved
list).

Lrs

-
Pl |
—

Lab Information
Management System

Groups SiteManager Lab Information Management System (LIMS)
process functions into one area and provides a point of access for
LIMS users.

Integrates seamlessly with Material Management to streamline the
sampling and testing workflow from recording a sample, to
reviewing, enter test data, and authorizing the sample.

Provides Stand-alone capability
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Icon Description

Allows access to the In-Box, SiteManager’s e-mail facility and to the

Process Status Monitor.

Accessories

Groups SiteManager system functions into one area and provide a
single point of access for System Administrators.

Provides comprehensive security features with flexible

System Administration administration.

Facilitates adding of custom templates.

Allows access to on-line versions of the User Reference Manual
|¥m~‘ and Sampling and Testing Procedures.

I-..

Manuals

s Allows a user to navigate directly to agency defined custom reports
and documents.
=)

Reparts

Reports

Table 2-1. SiteManager Icons Table

2.3.3 Navigating in SiteManager Using the Main Panel

The SiteManager Panel is used to navigate to the components of the SiteManager application. The
highest level is the SiteManager folder tab that contains the different functional groups, with each
group individually represented by an icon. Double-clicking the icon of a functional group brings up
another folder tab consisting of the sub-groups or the actual windows contained within that
functional group. As icons are selected, the next level’s folder tab appears next to the previous level.

To select a main panel component of SiteManager:

1. Double-click the component’s icon.

11
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To select up or down a level in SiteManager:

1. Click the level’s folder tab.

Click the folder tab to go Double-click the component’s Click the folder tab to go
up a level icon to open it down a level

Figure 2-9. Navigating in SiteManager

2.4 Accessories

The Accessories panel provides access to the SiteManager communications and process monitoring
components. These components include:

= In-Box,
= Distribution List,
= System Attachments,

= Process Status Monitor, and

12
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To access Accessories:
1. On the Main Panel, double-click the Accessories icon.

2. Double-click the icon of the desired Accessories component.

(B SiteManagerPanel | | | | | [ | | | J]1 1L 1T e
Main Panel T Accessories[+) ]

1T 4 [i2

Distribution List UserJob Monitor  Custom List ~ ADHOC Query  View Saved System

Record Usage Tool Reports [PSR)  Attachments

Process List

Figure 2-10. The Accessories Panel
2.4.4 In-Box Concepts

The SiteManager In-Box provides three types of electronic messaging:

= User generated messages using the SiteManager In-Box, a
= Access to compatible electronic mail systems, and

Figure 2-11.
= System Generated Messages received in the SiteManager In- The In-Box Icon

Box.

In-Box E-mail Capability

The SiteManager In-Box provides electronic mail capability for users, allowing them to send and
receive electronic mail messages to each other through SiteManager mail. SiteManager users can
send, receive, reply, forward and print SiteManager mail, but cannot send attachments. Users also

13
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have the option to delete a single message or, if desired, several messages at a time. When a user
deletes mail messages, SiteManager marks them for deletion so they will no longer appear in the
user’s In-Box. The marked messages are retained until the next archival process, when SiteManager
will permanently delete the messages.

5 In-Box
[ UsorName____[patefine _[oubiet r
S pztem Administrator 1 04/23/9915:54:02  |[Change Order Approval Cycle

SYSTEM 04113499 17:13:29 |Estimate Nbr 0002 of Contract ID 011999 Awaiting

L oL

Figure 2-12. The In-Box Window

Additionally, SiteManager’s In-Box provides menu level access to DOT’s native mail system. The
native mail system must conform to one of two messaging standards:

= Messaging Application Programming Interface (MAPI) or

= Vendor Independent Messaging (VIM).

Mail systems, such as Microsoft Mail or Exchange are MAPI compliant while packages such as
Lotus Notes and CC:Mail are VIM compliant.

Although SiteManager provides a menu option to access the external mail, it does not display the
external mail message headers in SiteManager.

In-Box as a Workflow Manager

In addition to SiteManager mail and external mail, the In-Box acts as a workflow manager by
routing System Generated Messages to the appropriate users. These messages are automatically

14
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generated by SiteManager and provide any number of users with access-specific SiteManager
functions. System Generated Messages are primarily used to automatically jump to specific
windows when further action is required by a user.

For example, when the user generates an estimate, SiteManager delivers a System Generated
Message to the user’s In-Box.

After the user opens the In-Box message,

= |f the estimate generation was successful and the request was for a progress or final
estimate, SiteManager will display the Estimate Summary window.

= |f the estimate generation was successful and the request was for a supplemental estimate,
SiteManager will display the Contract Adjustments window.

= |f the estimate generation was unsuccessful, then SiteManager will display the Estimate
Activity Log report.

Using the In-Box
The In-Box is accessed using the Accessories panel.
To start the In-Box:

1. Double-click the Accessories icon.

2. Double-click the In-Box icon.
To open a mail message:

1. Click the message.

2. Click the Services menu and click the Read Mail choice.
To close a mail message:

1. Click the Close button.
To check for new mail messages:

1. Inthe In-Box, click the File menu and click the Refresh choice.

15
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To delete a mail message:
1. Click the message to be deleted.
2. Click the Delete button.
To delete two or more mail messages:
1. Press and hold down the SHIFT key.
2. Click the first and last mail message in the range of messages to be deleted.
3. Click the Delete button.
To delete two or more mail messages that are not in a range:
Select the first mail message to be deleted.
Press and hold down the CTRL key.

Click each one of the remaining mail messages to be deleted.

W dpoE

Click the Delete button.
To print a message:

1. Open the message.

2. Click the Print button.
To close the In-Box:

1. Click the File menu and click the Close choice.

Replying to or Forwarding a Message

When a message is opened, the Reply and Forward menu choices allows the user to reply to or
forward a SiteManager message to other SiteManager users. When replying to a SiteManager
message, the original mail message is not attached with the reply message. When forwarding a
SiteManager message, the original message is included.

16



Trnseport SiteManager®

2.4 Accessories 2. Getting Started

5 Reply From Project Manager 1 |- [O] x|
From: |F'l0iec:t Manager 1
TO: |Pl0iect Manager 1

cc: |

Subject: |F|ep|y - Forward Submitted Documents

Message
The Document # 1 For Contract #SITEMGR_30 iz available for review

|v

4 =
Reply
[=rom : Project Manager 1 I

To: Project Manager 1
CC:
Subject : Forward Submitted Documents

Ki HE

Figure 2-13. The Reply Window
To reply to a message:
1. Open the message.
2. Click the Services menu and click the Reply choice.
3. Click to place your insertion point below the subject in the text area.
4. Type your reply.
5. Click the Services menu and click the Send choice.
To forward a message:
1. Open the message.
2. Click the Services menu and click the Forward choice.
3. Address the message
4

Click the Services menu and click the Send choice.

17
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Creating a Message

2.4 Accessories

A SiteManager mail message may be sent to other SiteManager users using the Compose menu
choice of the In-Box.

¥ Read / Forward 7 Compose Mail [_ O] x|
From: |F'roiect Manager 1
TO: [Systemn Administrator T
CC: ISystem Administrator 2
Suhiecl:| Contract #5SITEMGR_30
Messzage
Please update your contract information by close of business on 5/31/33) =
i o

Figure 2-14. The Compose Window

To create a message:

18
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Click the Services menu and click the Compose choice.
Address the message

Press the Tab key to advance to the Subject heading.
Type a subject for your message

Press the Tab key.

Type your message.

Click the Services menu and click the Send choice.
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Addressing a Message

When creating a new message or forwarding an existing message, it can be sent to an individual
SiteManager user or to multiple SiteManager users. However, it can NOT use SiteManager
distribution lists which can only be accessed by system generated messages.

Select a user

iction Engines
District Construction Engineer 2
|bistrict Testing Engineer 1
|bistrict Testing Engineer 2

Field Materials Engineer 1

Field Materials Engineer 2

JlameTst1
|hameTst1 0
bt U
|

oK Cancel |

Figure 2-15. Addressing - Control+Clicking Allows Multiple IDs to be Selected

To address a message:

1.

2
3.
4

Click to place the insertion point in the To: or CC: field.
Click the Services menu and click the Select Users choice.

Select the recipient’s name.

Click Ok.

To select multiple names next to each other:

1.
2.

Click the first name.

Hold down the Shift key and click the last name.

19
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To select multiple names NOT next to each other:

1. Hold down the Ctrl key and click the each name.

2.4.5 Distribution List

To facilitate easier handling of multiple users, SiteManager provides a Distribution list. These lists
are typically created by users only for system generated messages. The user can assign these lists to
specific processes that generate system messages through specific SiteManager functions. For
example, the Distribution List field on the Contract Key Dates window allows the user to select a
user group to which a message is automatically sent, when a key event does not occur.

¥ Distribution List

Distribution List I -

erf Test List

-

Elsel Name - User Name Iil
32 bit l.dams Construction Corporation
iz Sl _ Add > | Cential Office 1
Ezg::LETz:lMat3llals Engineer 2 Contial Oifios 2
- <- Remove I Central Dffice Materials Engineer 1
Diane Menz
GregTeal D ay in Life - Central Office
NameT st Add All >> | D' ap in Life - Field Inspector
MameT st10 D ay in Life - Project Manager
MameT st3 <<- Rem All | Day in Life - System Admin
NameT std4 = District Construction Engineer 1 —
. e ol | i

Figure 2-16. The Distribution List Window
To add a new distribution list:
1. On the Accessories panel, double-click the Distribution List icon.
2. Click the New button.

3. Type the descriptive name of no more than 20 characters (including spaces and special
characters) for the distribution list.

4. Inthe User Name list box on the left side of the window, scroll to and click the user’s name.

5. Click the Save button.

20
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6. Continue steps 4-5 until all recipients are included.

7. Click Ok.

8. Click the Save button.
To modify an existing distribution list:

1. Inthe Distribution List box, scroll to and click the list to be modified.
To remove a user:

1. Inthe User Name list box on the right side of the window, scroll to and click the user’s
name.

2. Click the Remove button.
To add a new user:
1. Inthe User Name list box on the left side of the window, scroll to and click the user’s name.
2. Click the Save button.
To delete a distribution list:
1. Inthe Distribution List box, scroll to and click the list to be deleted.
2. Click the Delete button.
3. Click Ok.
4

. Click the Save button.

2.4.6 Process Status Window

The Process Status window is accessed through the SiteManager Accessories functional area. This
window is available almost system wide by selecting Process Status from the Services menu. The
window consists of two tab pages: Regular and Scheduled.

Regular Tab

The Regular tab page lists DPS submitted processes; that is, RTF custom report processes,
SiteManager PowerBuilder reports, and background or batch processes. Here, authorized users can
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see the current status of submitted processes, delete submitted or complete jobs, or drill down to
view or print the output produced by completed or failed processes.

[EProcess stanes | LT S N I=TEY

" Regular ~ Scheduled

Process Name Date Start Time | End 4

Submitted
£ RE>X Error

RCPCSUM1E REXX Error 6/23/0 10:14am  |10:14 am 1014 an
RCPCSUM1E RE>% Error 6/28/01 1017 am  [10:17 am 10:17 an
RCACONSTA Daily RE Errar 6/26/01 05:11 pm 10:00 am 10:46 an
RCAITATYA Weekly RE>Z< Errar 6/26/01 05:14 pm 10:46 am 10:46 an
Monthly Contract Status RE Erar B/26/01 05:13 pm 10:50 am 10:50 an
SONYATSTA Application Error 6/28/01 10:58 am 10:58 am 10:53 an
RCAITATYA Weekly RE>Z< Erar 6/26/01 05:14 pm 11:09 am 11:09 an
RCPCSUM1A Completed 6/28/01 11:13 am 11:13 am 11:13 an
test] Completed 6/28/01 12:03 pm 12:03 pm 12:03 pn
SONYATSTA Completed 6/28/01 12:40 pm 12:40 pm 12:40 pn
TEST41014 Application Error 6/28/01 01:27 pm 01:48 pm 01:43 pn
Monthly Contract Status RE Errar 6/26/01 05:13 pm 01:49 pm 01:43 pn
RCAITATYA Weekly RE Errar B/26/01 0514 pm  |01:49 pm 01:49 pn
RCAITATYA RE> Eror 6/28/01 02:36 pm 02:36 pm 02:36 pn
I:\I'I',AITDTYH RF>X Frenr R/2R/M N2-3R nm | N2-3R nm 23R : -

Figure 2-17. The Process Status Window Regular Tab

Field Description

Process Name The name of the process.

Status Textual description of the process status; for example, Process

Running, Application Error, Complete.

Date Submitted

Date the job was submitted.

Queue Time Time the job was submitted.

Start Time Time the job started processing.

End Time Time the job finished processing.

Server IP address of the server to which the job was submitted and run.

Table 2-2. The Process Status Regular Tab Field Names Table
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Scheduled Tab

The Scheduled tab page lists DPS submitted processes; that is, RTF custom report processes,
SiteManager PowerBuilder reports, and background or batch processes. Here, authorized users can
see the current status of submitted processes, delete submitted or complete jobs, or drill down to
view or print the output produced by completed or failed processes. The processes listed on the
Scheduled tab are those processes which have be set to run on a specific schedule by an authorized
user.

Standard SiteManager window and tab-level security applies to the Scheduled tab page window.
Only those processes to which the user has been assigned security access will be presented on the
displayed list.

B Pocoss stewe | (|| 110 00T |- TR

" Regular Scheduled

Schedule

S 22 PM on Tue, every week 07/03/0 05:17 pm  |07/10/01  |05:22 pm
SMBAPP RCOCORPTA MiAt 5:24 PM on day 3 of the month 07/03/01 05:18 pm  |03/03/01  |05:24 pm

SMBAPP RCAITATYA Dailat 5:19 PM every day 07/03/01 05:16 pm |07/06/01  |05:19 pm
SONYATST SONYATSTA  |At5:35 PM every day 07/03/01 05:30 pm  |07/06/01 | 05:35 pm

| | »

Figure 2-18. The Process Status Window Scheduled Tab

Field Description
Process The name of the process.
Schedule Textual description of the process schedule; for example, Time,

Day of Week and Frequency

Date Submitted Date the job was submitted.
Queue Time Time the job was submitted.
Next Run Date Date the job will next run.
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Field Description
Next Run Time Time the job will next run.
Last Run Time Time the job was last run.
Server IP address of the server on which the job is scheduled to run.

Table 2-3. The Process Status Scheduled Tab Field Names Table

2.4.7 System Attachments

System Attachments are a stand-alone version of the URL, Plug-In and

OLE functionality of SiteManager. The stand-alone feature allows URL

links, Plug-In applications, and OLE objects to be accessible to the User by @
clicking the System Attachments icon through the Accessories panel.

URL attachments are links to html documents Figure 2-19.
The System
Plug-In attachments allow access to other programs similar to the OLE Attachments Icon

function. The Plug-In functionality also allows a limited amount of data to
be automatically passed to a Plug-In application upon execution.

OLE object attachments are links to external documents.

URL and Plug-In Attachment Icons

Icon Description

Activates the Attachments window.

Appears on the Accessories panel, and activates the stand-alone
Attachment window.

Appears on the toolbar of any window that may have an attachment
associated with it. An Attachment icon without a paperclip signifies there are
currently no attachments associated with the current record

24
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Icon Description

Activates the Attachments window.

@ Appears on the Accessories panel, and activates the stand-alone

Attachment window.
Attachments .
Appears on the toolbar of any window that may have an attachment

associated with it. An Attachment icon without a paperclip signifies
there are currently no attachments associated with the current record

Allows User to activate Plug-In applications or URLs associated with the
window.

B

Run Attachments

Opens a dialog box allowing the properties of a URL attachment to be
modified or entered.

=

New URL

Opens a dialog box allowing the properties of a Plug-In attachment to be
modified or entered.

k2

New Plug-In

Opens a dialog box allowing the properties of an OLE attachment to be
["-Ei modified or entered.
New OLE

Table 2-4. The Attachment Icon Table
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Attachment Usage

2.4 Accessories

75ystom Atochmens 101 M 0 /%]
Name Type Description
BCD.COM IURL ltest

ICNBC JURL jenbe:

[Pushkar'sPlugln Plug [This is a test

[character map [EXT [
[Jcaloulator ExT I
[hhhhhhbh [URL [Hotmailgfahagh
jii calculator EXT 3
[t website [URL irfotech fie
ftest [Plug [agfaff
fry again [Plug fresdarth
ahooo UL Jnew yahon

Figure 2-20. The System Attachments Window

To use Plug-In, URL, and OLE attachments:

1. The previously-created URL, Plug-In, and OLE attachments appear on a table grid on the
Attachments window. Sort and Filter features may be used on this window by right-clicking
and choosing a feature from the Object menu.

2. Double-click the desired attachment to activate, or highlight the desired attachment and click
the Run Attachments icon.

3. Activating a Plug-In opens the specified application in a separate window. Activatinga URL
or HTML File item launches the system’s default browser. Activating an OLE opens the
specified document.

4. Once the User has completed work with the URL, Plug-In application, or OLE document the
browser or application may be closed as normal.

2.4.8 Reports

The Reports icon will allow an agency to define an external link to Custom Reports or documents.
When a user double clicks the Reports icon, an external reporting tool or application of the Agency’s
choosing will be launched. The Reports icon will not appear on the Main Panel by default. If an
agency chooses to use the Reports icon from the Main Panel, the Agency’s System Administration
will have to define the external application and provide users with appropriate Group Security.
Please refer to the External Applications section located in Section 10 — System Settings of the
SiteManager System Managers Guide for further information.
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To access the Custom Agency Reports:

1. On the SiteManager panel, double-click the Reports icon.

27






Trnseport SiteManager®
3.1 Menus 3. General Concepts

3. General Concepts



Trnseport SiteManager®
3.1 Menus 3. General Concepts

3.1 Menus

The following guidelines apply to the use and structure of SiteManager menus.
= SiteManager menus may have up to three levels with the main menu as the first level.

= Menu choices that invoke dialog boxes have an ellipsis (...) at the end of the choice.

= Menu choices that invoke a cascading submenu will have an arrow () at the end of the
choice.

FEJAASHTO SiteManager [_[=21%]
File Edit Services “Window Help

08|82 D[] |E| O[]

. ———————————

C—= Description Location FPayment Data ~ Critical Dates
— ]!

- Contract ID: SITEMGR_30 Fed St/Pr Prj Nbr: [NONE/OD;
Status: | £y Primary PCN: lm
Division: IEIZ— District: I— Area: I—
Progress Schedzl VYariance Pct: I_EIEI
Desc: |E><TEND ACCELLERATION LANE & CLOSE CROSS-OVER

Time Charges: IW Bid Days: I_SD Bid Amt:
Contract Type: Im [T Fed Dversight

Work Type:|25— [T Local Dversight Proposal Fund Type:

1f<

—~ ol

1

Spec Yl:l 1991 Unit System: IEninsh Suppl 5pec Bk YI:I AltlD _
Y

Figure 3-1. SiteManager Menus

Some menu choices will be applicable in some instances and not applicable in others. For example,
a menu choice may be applicable for one folder tab and may not be applicable for the second folder
tab. When the menu choice is applicable for the active folder tab, it will display normally. When
the menu choice is not applicable for the active folder tab, it will not appear on the menu.

Other menu choices may be applicable but only if a preliminary step is performed. For example, a
menu choice may be applicable if you are in a new record, but not applicable when you have an
existing record open. When the menu choice is applicable, it will be enabled and will display
normally. When the menu choice is NOT applicable, it will be disabled and will display in gray.
The menu choice will be enabled or disabled depending on the circumstances.

Menu choices often have a corresponding toolbar button.

Keystroke shortcuts are assigned to all menu choices that do not invoke a dialog box or a cascading
submenu. Keystroke shortcuts appear in the menu to the right of the menu choice. Keystroke
shortcuts do not clash with those commonly used by the Microsoft Windows standard. For instance,
even when there is no Edit menu, the CTRL+C keystroke shortcut will copy the current selected
column value to the Clipboard.
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All menu choices will have keystroke accelerators assigned. The menu itself will be invoked using
the underlined letter in the menu name in combination with the ALT key. The menu choice will be
invoked by typing the underlined letter in the menu choice’s name.

When appropriate, an object menu can be invoked by right clicking the column.

The SiteManager application has two menus to display. One is at the frame level and the other is at
the sheet level.

The sheet level menu could be any one of the several functional level sheet menus which in turn
were inherited from the frame, with additional menu choices added for relevant functionality. The
Frame level menu contains only a few menu choices that provide access to the application level
functions such as bringing up the SiteManager Main Panel and exiting the application. At the sheet
level, each window will display only one menu bar and one tool bar, with some of the frame level
menu choices incorporated on the sheet menu itself.

3.2 Using SiteManager Menus and Toolbar

SiteManager menus can be accessed using the mouse or using the keyboard. Many SiteManager
menu choices can also be accomplished using a keystroke shortcut. Keystroke shortcuts appear in
the menu to the right of the menu choice.

To use a SiteManager menu using the mouse:
1. Click the desired menu and click the desired choice.

The following guidelines apply to the use and structure of SiteManager toolbars.

= The most often used menu choices have a corresponding toolbar button for ease of use.
= Buttons used on toolbars are consistent throughout the application.

= All toolbar buttons have Tool Tips — text associated with the button that describes what
the button does.

If a toolbar button is sometimes applicable, it will be enabled or hidden depending on which folder
tab is active. For example, a toolbar button may be applicable for one folder tab and may not be
applicable for the second folder tab. When the toolbar button is applicable for the active folder tab,
it is enabled and displays normally. When the toolbar button is not applicable for the active folder
tab, it does not appear on the toolbar.

3.2.1 Accessing SiteManager Menus With the Keyboard

As an alternative to using the mouse, all SiteManager menus can be selected using the keyboard.
Some SiteManager menu choices can also be performed using keystroke shortcuts.
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To use a SiteManager menu using the keyboard:

1. Hold down the ALT key and press the underlined letter in the menu name.
2. Type the underlined letter in the menu choice’s name.
To perform a SiteManager menu choice using a keystroke shortcut:

1. Hold down the CTRL key and press the letter that performs the shortcut (e.g., CTRL+C
copies the selected data).

3.2.2 Toolbar Buttons

Main

Panel Exit New Close Save

[l [ R ) =2 = D = )
Toolbar Help Open Delete Remarks

Figure 3-2. The SiteManager Toolbar

To identify what a button does, use the Tool Tip for the button. If you check the menus, you will
find a comparable capability on the menu.

The SiteManager Toolbar is accessed using the mouse. Buttons, unlike icons, require only a single
click. The SiteManager Toolbar has seven common toolbar buttons to display: Exit, New, Open,
Close, Delete, Save, and Help.

Toolbar Tool Tip Comparable Description
Button Menu Function
Exit File menu’s Exit | Exits the application. It asks for
+ . . .
M- choice saving of changes if the there are
unsaved changes.
e Help Help menu’s Brings up the SiteManager Help
Lﬁll Contents choice | Contents Window.
New File menu’s Is used in context to clear all the
|__h| New choice columns for data entry. If the sheet

contains more than one control
capable of creating new rows, the New
option creates a new row on
whichever control is currently active.
If changes have been made to the
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Toolbar Tool Tip Comparable Description
Button Menu Function

current record, it prompts you to save
changes before clearing the current

record.
~a Open File menu’s Allows another record to be selected.
E? Open choice Typically, it is applicable to the
current tab.
K, Close File menu’s Closes the current sheet. It prompts
L=~ Close choice for saving any changes before closing
the sheet.
Delete Edit menu’s Like the New choice, the Delete
Delete choice choice contextual and is applicable for

the current control. It prompts for a
confirmation from the user through a

message.
H Save File menu’s The Save button saves your current
3 Save choice work. If you performed some deletion

during a work session, you may need
to reconsider whether the deletion was
correct before saving. After you have
saved, you may not be able to undo
the deletions.

[:]I Remarks | Services menu’s | Displays the Remarks dialog to attach
Remarks choice | freeform comments.

Table 3-1. The Toolbar Button Table
To display a Tool Tip:
1. Position the mouse point on the button (and hold the mouse still).
To use a SiteManager toolbar button:
1. Click the desired button.

Depending on what SiteManager window you are using, other buttons may appear on the Toolbar.
These other buttons are equivalent to some SiteManager menu option that you use.

3.3 Frame Menus

At the frame level, there are three menus: File, Window, And Help.
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The File menu has the standard choices of Print Setup, Main Panel and Exit. The Print Setup choice
invokes the standard Windows Print Setup dialog. The Main Panel choice displays the SiteManager
Panel window, which is useful in cases where the panel was closed at the frame level through the
Close choice of the control menu. The EXit choice exits the SiteManager application.

Print Setup  Chrl+U

tain Panel Chrl+kd

E it Alt+F4

Figure 3-3. The File Menu

The other two menu options, Window and Help, are the standard Microsoft Windows menus with
choices that function according to Microsoft Windows standards.

Wafind o
Tile Shift+F 4
Layer Shift+F3
LCazcade Shift+F5

Figure 3-4. The Window Menu

Help
Contentz F1
Search for Help on...  Chil+y'
Gloz=ary Crrl+G

Current Wfindow Ctrl+F1

About Sitetanager  Chil+Shift+b,

Figure 3-5. The Help Menu

3.4 Window Menus

The window level has five menus: File, Edit, Services, Window and Help. These options are
applicable at the tab level.

3.4.1 File Menu

The File menu at the sheet level includes the frame level choices with the same functionality: Print
Setup, Main Panel and Exit. It also contains several sheet specific choices: New, Open, Close,
Delete, Save, Refresh, Print Preview and Print.
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Dpen Chrl+0
Cloze Clrl+F4
Mew Clrl+M
Delete Chrl+Dr
Save Chrl+5

Refresh Clrl+F

Print Setup  Chrl+L
Print Preview  Chil+w
Print Chrl+P

Main Panel  Chrl+bd

Ezit Alt+F4

Figure 3-6. The Sheet’s File Menu

The following SiteManager File menu choices are standard throughout the application and are
always performed in the same way. Sheet-specific menu functions are discussed with the applicable
SiteManager functionality.

Menu Choice Description

Open Allows another record to be selected. Typically, it is
applicable to the current tab.

Close Closes the current sheet. It prompts for saving any
changes before closing the sheet.

New Is used in context to clear all the columns for data
entry. However, if the sheet contains more than one
control capable of creating new rows, the New option
creates a new row on whichever control is currently
active.

Delete Like the New Choice, the Delete choice is contextual
and is applicable for the current control. It prompts
for a confirmation from the user through a message.

Save Saves the current unit of work.

Refresh Clears the current changes to the record and retrieves
the record again.

Print Setup As with the Frame option, Print Setup displays the
standard Windows Print Setup.

Print Preview | Displays a preview of the current print selection.
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Menu Choice Description
Print Prints the current data.
Main Panel Opens another window or another instance of the

same window. It invokes the navigation panel from
which the appropriate choice of the window can be
selected.

Exit Exits the application. It asks for saving of changes if
there are unsaved changes.

Table 3-2. The File Menu Choices Table

Changing the Print Setup
The File menu’s Print Setup choice is used to change the standard Window print setup dialog.
To change the print setup:

1. Click the File menu and click the Print Setup choice.

2. Make the desired changes to the dialog.

3. Click OK.

Printing

The File menu’s Print choice is used to print. In a report, the Print choice prints the entire report. In
a window, it prints the current focus of the window. Most SiteManager windows are divided into
two or more zones. The results of the Print choice varies depending on which zone is active.

$20,000.00 |
$1,500.00

Other Adjustment {See Remarks] train

1
Supplemental Amount has been applied  |SYSTEM

A SiteManager
Window with
Three Zones

N Entered Date: |05/28/37 User ID: iraint Est. Nbr: [0001

Adjustment Description: |Dther Adjustment (See Remarks)
Adjustment Amount: |$20,000.00
Reference Doc:

Remarks: [Dondra -]

Figure 3-7. The Zones of a SiteManager Window
To print:

1. Inawindow, click the area of the window that you wish to print.
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2. Click the File menu and click the Print choice.
3. Make the desired changes to the dialog.
4. Click OK.

Using Print Preview

The File menu’s Print Preview choice is used to preview what will print. Since most windows print
the current focus of the window, the Print Preview choice helps you determine that the focus is
correct before you print.

To preview what will print:
1. Inawindow, click the area of the window that you wish to preview.
2. Click the File menu and click the Print Preview choice.

3. View the selection that will be printed.

4. Click OK.
Components Description

Next button Displays the next page of a multi-page selection.

Prior button Displays the prior page of a multi-page selection.

Print button Invokes the Print dialog.

Setup button Invokes the Print Setup dialog.

Zoom button Invokes the Zoom dialog to magnify or reduce the display of
the print preview.

Close button Closes the print preview

Rulers check Displays or hides the rulers

box

Save As button | Invokes the Save As dialog allowing the results of the print
preview to be saved in other file exportable file formats.

Table 3-3. The Print Preview Components Table
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EEslimale History M=

Contract ID: (021333

Descriptionl: Iblidge work.
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Estimate Met Pay

Number

$18.000.00 M /0799

Period

End Date

3

£t

PH
User ID

PM
Appr. Date

02/23/33

Last Appr.
User ID

it

000z $6,940.0001/06/93
0001 $5,500.0001/05/93 551 02/23/99 551 02/23/93 |APR
el

Figure 3-8. A SiteManager Window with a Multi-Row Focus

Print Preview

Close | v Rulers

Mext | Prior | Print | Setup... i | Save As . |
.|.I.|.|.|.I.|.1|.|.I.|.|.|.I.|.2|.|.I.|.|.|.I.|.3|.|.I.|.|.|.I.|:‘|.|.I.|.|.|.I.|.5|.|.I.|.|.|.I.|.G|.|.I.|.|.|.I.ﬂ
4 Estimate Net Pay Period PM PM Last Appr. Last Appr. Est
- Number End Date User ID Appr. Date User ID Date [Stat
] 0003 $18,000.00 0100739 Syse 0311899 sYs2 03118093 APRV
1 4 000z $6,940.00 01406433 SYst 02023433 SYS1 02023133 SRRV
- oot $5,500.00 01/05/33 SYS1 0223133 SY51 02023133 APRV
2]
33
3
KNS

s

Figure 3-9. The Print Preview of a SiteManager Window With a Multi-Row Focus

Exporting A Window’s Print Results —The Print Preview’s Save As Button

The Print Preview is a File menu choice only available in a window, not as a report. The Save As
button of the Print Preview allows the current focus to be saved in other exportable file formats.

To save the print preview results in another format:

1. Inawindow, click the area of the window that you wish to preview.

2. Click the File menu and click the Print Preview choice.

3. Click the Save As button.

10
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4. Inthe Save File As Type drop-down list, click the expand arrow to the right of the current

selection and click the desired choice.

Trnseport SiteManager®
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5. To include column headings, choose a With Headings file type.

6. Highlight the text in the File Name field.

7. Type the name for the file.

Note: The Save Rows As dialog also does not have the more traditional Windows

methods of changing drive and folders. An exported file is created in the default directory
and drive on which SiteManager is installed. A path can be typed in front of the filename

to control where the file is created. The path C:\DATA\ACTCONT.PSR creates a file
named ACTCONT.PSR in a directory named DATA on the C drive.

8. Click OK.

Radio Button

File Extension

File Format Description

Text TIXT ASCII Tab Separated (Delimited) format

Csv .CSV ASCII Comma Separated (Delimited)
format

Dbase 2 .DBF dBase 2 format

Dbase 3 .DBF dBase 3 format

DIF DIF Date Interchange Format

Excel XLS Microsoft Excel Spreadsheet format

HTML Table HTM Hyper Text Markup Language table
format (Can be viewed in a web
browser.)

PowerSoft Report | .PSR PowerSoft Saved Report format (Can
also be viewed in SiteManager.)

SQL .SQL ASCII text file containing the SQL
syntax required to recreate the
datawindow object when run through the
database.

SYLK SLK Microsoft MultiPlan format

Text TIXT Text file format (Can be viewed in any

text editor.)

11
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Radio Button File Extension File Format Description
Windows Metafile | WMF Windows Metafile graphical format
WKS \WKS Lotus 123 early format
WK1 WK1 Lotus 123 later format

Table 3-4. The Print Preview Save As File Formats Table

Save As HE
File name: Folders:
* xls | c:smapp

Cancel
- e t 4‘
; o Metwork._.. |
[ checkin
L1 checkout
] cms T
= L3 smdb hd
Save file as type: Drives:
Excel ﬂ I = c: j

Figure 3-10. The Print Preview Save A Dialog

Displaying the SiteManager Panel

The File menu’s Main choice is used to invoke the main SiteManager navigation panel. Typically,
the SiteManager navigation panel is activated to open another SiteManager component without

closing the current active component.

To display the SiteManager Panel:

1. Click the File menu and click the Main Panel choice.

2. Click the desired icon.

12
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E SiteManager Panel

Main Panel

Accessores(+]

@] Reports(+]

Doaily Wfark Pipeling(+]

M anuals(+] Reportz

System
Administration(+]

System Administration[+) T

@Iliﬁmx

Contractor
Payments(+]

Contract Administration[+]

I aterials
Management|+]

Change Ciwil Rights(+]

Orders(+]

Exiting SiteManager

Figure 3-11. The SiteManager Main Panel

The EXxit choice exits the SiteManager application. The command can be accessed from the File
menu or from a toolbar button. If current work has not been saved, a warning message displays to
allow you to save the data before the application is closed or to cancel the exit.

To exit SiteManager:

1.

Click the File menu and click the Exit choice.

OR

m_i-

Figure 3-12. The Exit Button

Click the Exit button on the toolbar.

If the warning message displays, choose the desired choice.

¥ Contract funding E

[ ? Save changes?

vee |

Cancel |

Figure 3-13. The Exit Warning Message
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3.4.2 Edit Menu

The Edit menu has standard Microsoft Windows choices: Undo, Cut, Copy and Paste. These
function as they would in any Windows program. The Undo choice has a limited functionality. If
you delete a field and immediately choose Undo, the field value will most likely be brought back.
However, if you have deleted a record, the Undo function will not undo the deletion.

The following SiteManager Edit menu choices are standard throughout the application and are
always performed the same way. Sheet specific menu functions are discussed with the applicable
SiteManager functionality.

Edit
Undo Chil+£

Cut  Chil+
Copy  Chl+C
Pazte Chl+y

Figure 3-14. The Edit Menu

Menu Choice Description

Undo Undoes the last change.

Cut Cuts the selected area from
the item.

Copy Copies the selected area
from the item.

Paste Pastes the contents of the
clipboard.

Table 3-5. The Edit Menu Choices Table

If menu item does not pertain to the current window, the menu item is unavailable. For example,
you cannot cut or copy a column unless a column is selected.

To select a field using the mouse:
1. Inthe desired field, position the I-beam in front of the current entry.
2. Press the mouse button and drag to highlight the current entry.

To select a field using the keyboard:

1. Press the Tab key repeatedly until the field is highlighted.

14
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Undo

The Edit menu’s Undo choice changes a field back to the previous entry if the user has not
performed a Save on the record.

To undo:

1. Click the Edit menu and click the Undo choice.

Cutting, Copying, and Pasting

When a column value is selected, the value can be moved (cut) if the entry is incorrect. A field
value that needs to be entered repeatedly may also be copied to reduce typing.

To move (cut) the current selection:

1. Select the column value(s) to be moved.

2. Click the Edit menu and click the Cut choice.
Or

3. Hold down the Ctrl key and press the letter X.
To copy the current selection:

1. Select the column value(s) to be moved.

2. Click the Edit menu and click the Copy choice.
Or

3. Hold down the Ctrl key and press the letter C.
To paste the current contents of the Clipboard:

1. Position the insertion point in the column location to receive the value.

2. Click the Edit menu and click the Paste choice.
Or

3. Hold down the Ctrl key and press the letter V.

3.4.3 Services Menu

The Services menu has several menu options grouped together. Some of the options like Address
and Remarks extend the functionality. The other choices provide extended services.

15
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The Services menu is also the most variable SiteManager menu. It contains choices specific to the
active SiteManager window in addition to the ones listed in the following table. When there is a
Service menu, it is a good habit in SiteManager to check its contents for the additional choices.

The Services menu is the most important menu for accessing custom SiteManager functionality.

The options that appear in the Services menu may suggest the next logical step to take, such as
Choosing Keys, or may suggest additional actions which could easily be overlooked, such as adding
a Remark or recording an Address. On the other hand, the absence of these options might suggest an
alternative course of action such as clicking the Open button, rather than Choose Keys.

Window  Help
Hemark.s Crl+alk+H
Addreszs Chrl-r b+,

Genenc Fields  Chrl+alk+(

Cuztom Record  Crrl+5 hift+L

Figure 3-15. The Services Menu

Menu Choice Description
Choose Keys Becomes available when the New choice is invoked. It brings
up the pick list from which the appropriate value(s) can be
chosen.
Address Invokes the address (context sensitive).
Remarks Invokes the remarks dialog.

Generic Fields | Displays a standard set of customizable, generic fields.
Depending on the customization, these fields can be strings,
codes, flags, or numbers.

Other menu Other functional area specific menu choices (such as
choices Approve) are incorporated under Services.

Table 3-6. The Service Menu Choices Table

Not every options available from the Services menu is listed here. It is a good idea to check the
menu to see what options are available for the window.

16
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Choose Keys

The Choose Keys choice displays a list of key field(s) to be selected. In many instances in
SiteManager, the Choose Keys choice must be selected before a new record can be created.
Choosing Keys is fundamental to using SiteManager.

To choose keys:
1. Click the Services menu and click the Choose Keys choice.
2. Inthe list box, scroll to and double-click desired value.

3. Repeat step 2 until all initial values are selected.

— Sel

Item |
Spec Year |
Find :
— ltem
Item Code English/Metric Description =
English MISC ITEMS
007-0000 English MISC ITEMS
(0070000 Metric MISC ITEMS
001-0000 Metric MISC ITEMS
007-0001 English BOMD INTEREST
001-0001 Metric BONWD INTEREST
001-0100 English COWNSTR SUPYR DONE BY OTHER THAN DOT PERSONEL -
001-0100 Metric CONSTR SUPYR DONE BY OTHER THa&N DOT PERSOMEL - =
oK | Cancel |

Figure 3-16. The Choose Keys Window

Address

Address information is tracked by a variety of components in SiteManager. The Address choice
displays an address dialog that allows this information to be recorded.

17
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PYMT AND/ORBILLN i ~| | Address For: |
BILLING ADDRESS —Address
RECORD FOR FAX ONI Line 1: |
HOME ADDRESS [ALL Line 2: |
MAILING ADDRESS [P _ Line 3 [

|

I

City:

State/Prov:

Zip/Postal: I
Country: | | E

—Contact Numbers
Phone:| Ext: |

FAX: |

=]

Figure 3-17. The Address Dialog
To attach an address:
1. Click the Services menu and click the Address choice.
2. In the address type list box, scroll to and click the desired type of address.

In the first field, type the appropriate information.

W

Press the Tab key.

o1

Repeat step 2-3 until all text address information has been entered.

6. In the State/Prov drop-down list, click the expand arrow to the right of the current selection
and click the desired choice.

7. In the Country drop-down list, click the expand arrow to the right of the current selection
and click the desired choice.

8. Click outside the Address dialog to close the address.

9. Click the Save button.

Remarks

As with Addresses, Remarks may be attached to a variety of records in the various components of
SiteManager. The Remarks choice displays a freeform dialog that allows any comment to be
recorded.

When Remarks are available for a SiteManager window, the presence of the Remarks button on the
Toolbar serves as a reminder that they are appropriate, makes it easier to access Remarks, and,
unlike other Service menu choices, precludes the need to check the Services menu to see if Remarks
are available.

18



Trnseport SiteManager®
3.4 Window Menus 3. General Concepts

[=

Figure 3-18. The Remarks Button
To attach a remark:
1. Click the Remarks button.
Or
2. Click the Services menu and click the Remark choice.
3. Type the desired comment.
4. Click outside the Remarks dialog to close the Remark.

5. Click the Save button.

Generic Fields

Generic fields are agency-defined fields attached to some of the SiteManager windows. After the
installation of SiteManager, an agency attaches descriptive labels to the generic fields of
SiteManager. Data entered in these fields is unique to that agency. Once this customization has
been performed, the agency sets up procedures for the uniform maintenance of the data in its
customized fields.

The components of SiteManager that have this Generic Fields option are:

= Contract

= Vendor

= Office Information
= Address

= Vendor Personnel

» Item Master

= Affiliates

= Vendor Work Class
= Vendor Security

= Project Category

=  Contract Item
19
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Sub Contract
Contract Project
Contract Milestone
Change Order
Checklist Events
Contract Estimates

Diary Milestone Credit

Registration Number |

Amount |0
Reg Date [00/00/00 |

Figure 3-19. A Generic Fields Dialog Customized by an Agency

To update generic fields:

1.
2.

W

Click the Services menu and click the Generic Fields choice.

In the first field, type the appropriate information.

Press the Tab key.

Repeat steps 2-3 until all data field information has been entered.
Click outside the Generic Fields dialog to close.

Click the Save button.

3.4.4 Window Menu

3. General Concepts

The Window menu contains the Microsoft Windows standard menu choice. All active SiteManager
windows are displayed at the bottom of the Window menu.

The following SiteManager Window menu choices are standard throughout the application and are
always performed in the same way. Sheet specific menu functions are discussed with the applicable
SiteManager functionality.
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Wafind o
Tile Shift+F 4
Layer Shift+F3
LCazcade Shift+F5

Figure 3-20. The Window Menu

Menu Choice Description
Tile Tiles the open sheets
Layer Layers the open sheets
Cascade Cascades the open sheets

Table 3-7. The Window Menu Choices Table

Window menu choices are used when you have more than one component of SiteManager open.
Controlling the way the windows display can aid in navigation between these components.

Tiling

Tiling evenly divides the screen into the number of SiteManager components that you have active.
Tiling is used to display two SiteManager components side by side to compare the entries in each or
to return a single component to full screen once you have closed the other component. Typically, it
is not used when more than two components of SiteManager are active since you would not be able
to see enough of each component to make it worthwhile. Unless you have a very large display, tiling
with more than two SiteManager components open may not be very useful.

To change your screen to a tile display:
1. Open the SiteManager components that you want to tile.

2. Click the Window menu and click the Tile choice.
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FIAASHTO SiteManager
File Edit Services ‘Window Help
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(O] ]

ﬂ Maintain Producer/Supplier [_ Ol <] EAppmved Materials

e
Description Plants

I [=] 3

Producer Supplier Code: |DEIDDDD4 Producer S| [Material Code 000001

lAddilivEs

Producer Supplier Name: lJim's Guarry

Vendor ID:
Locaon:|  [7]

Geog
App| |[Admisture B

Product Name

Location Description: |

bee:[ [

Admizure C

Status:
Last Modified User ID: [lab1339 Last Mc Product Name: [Adnmidure &

Effective Date: |03/01/96 Expiration Date: |ﬁl

Product Category: [&dmisture =l
Manufacturer Name: |Manu¥acturev
Method: [Manufacturer Certification =]

\ Ready

Figure 3-21. Two SiteManager Components Tiled

Cascading makes the number of SiteManager components that you have active an equal size and
arranges each component in an overlapping offset window. Typically, cascading is used to display
more than two open SiteManager components. When you have a need to navigate between more
than two open SiteManager components, the Cascade choice may make it easier to move between

them.

To cascade:

1. Open the SiteManager components that you want to cascade.

2. Click the Window menu and click the Cascade choice.

3. Click the visible portion of the window you want to display.
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Layering

Layering displays the SiteManager component that you have active in the most efficient full screen
display. Typically, layering is used to give each active component a full window for display or to

Trnseport SiteManager®

FJAASHTO SiteManager - =] x|

File Edit Services “Window Help

2882 | W =S| | @] o]
& ~=10] x|

LU F Contracts - [O] x|
C — ‘iption Location Payment Data ~ Critical Dates Primary Frime DBE Comr_*
— 1 Personnel Caontractar

~ontract ID- BT Fed SUPr Pri Nbr I—
Status: IW Primary PCN: I:
Divisiun:lIE District: :E Area: |:|3 F 1
iess Sched: | [=] Variance Pct: I—UEI ~ S:

— Desc: | " Ba

| :l;: ne Charges: | |[=] Bid Days: l_ Bid Amt: I—
| . : tract Type: |Spaces [=] T Fed Oversight
Ll Work Type:|8paces B [ Local Oversight Proposal Fund Type: I_ .

m N 4

'Fleady [Server [STEST [SMADMIN  [5S52

Figure 3-22. hree SiteManager Components Cascaded

3. General Concepts

return a single active component to full display after you have closed the other components that were
tiled or cascaded.

To layer:

1. Open the SiteManager components that you want to layer.

2. Click the Window menu and click the Layer choice.

To move between multiple layered SiteManager components:

1. Click the Window menu and click the name of the SiteManager component from the list.
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Window
Tile Shift+F4
Layer Shift+F 3
LCazcade Shift+F5

v 1 Server to PM Pipeline
2 Price Index Maintenance

Figure 3-23. The Window Menu With Two SiteManager Components Active

3.4.5 Help Menu

The Help menu contains the standard Microsoft Windows options. The non-standard exception,
Current Window choice, displays the help for the current window including the fields. All other
options work in the standard format.

The Help menu contains standard Help choices: Contents, Search Help on, and Glossary. Help in
SiteManager works like any other Microsoft Windows Help.

Cantents F1
Search for Help on...  Chl+y
Gloz=zary Chrl+G

Current %indomw Chrl+F1

Ahout Sitetanager  Chl+Shift+4,

Figure 3-24. The Help Menu

Menu Choice Description

Contents Brings up the SiteManager Help Contents Window.

Search for Help on Brings up the SiteManager Help Search Window.

Glossary An alphabetized list of the items on the Help Contents
Window.
Current Window Brings up help window and displays the help on the

current active window.

About SiteManager Information about SiteManager Version.

Table 3-8. The Help Menu Choices Table
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Accessing Help Using the F1 Key

SiteManager help is context sensitive. When you are in a SiteManager window and have a question
about the window, pressing the F1 key invokes the help for that particular window.

& CMSAPPO4 - (O] x|
File Edit Bookmark Options Help

Qunlentsl ﬁeavchl Back I Frint I £« I > Iglossavyl

Selecting or Adding a Conference in Contract Records =

The Select Construction Conference Data panel lets the User select a Conference from a list of Conference
Titles and Dates, or add a new conference. The User can find, sort, and filter the Conference list

To access the Select Construction Conference Data panel:
1. Onthe Contractor Management panel, double-click the Construction
Conference icon.

When the Select Construction Conference Data panel opens, it displays a list of Contracts. After the User
selects a Contract ID, the panel displays a list of conferences for the selected Contract. The fields are defined
in the following list

Field Name and Description
Conference Date - Construction Conference - Selecting or Adding a Conference

Conference Title - Canstruction Conference - Selecting or Adding a Conference

To view a Construction Conference recard

1. Onthe Contractor Management panel, double-click the Construction
Conference icon. The Construction Conference panel opens.

2. Click the Open buttan. The Select Construction Conference Data panel
opens

3. Inthe Contract ID list hox, scroll to and click the desired choice.

4. Click Ok. If the selected Contract has conference records, the select panel
displays a list of conference titles and dates.

5. Inthe Construction Conference list box, scroll to and click the desired
chaice.

6. Click Ok. The Construction Conference panel displays data for the selected
conference.

Figure 3-25. The F1 Key Invokes Help

To access Help using the F1 key:
1. In a SiteManager window, press the F1 key.

2. When finished, click the File menu and click the Exit choice.

Accessing Help by Contents

The Content choice or the Help toolbar button display an alphabetized list of Help Topics that can be
browsed for the subject on which you need help.

To access Help by Contents from the menu:
1. Click the Help menu and click the Contents choice.
2. In the topics list box, scroll to and click the desired topic.

3. When finished, click the File menu and click the Exit choice.
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£
Figure 3-26. The Help Button
To access SiteManager Help with the toolbar:
1. Click the Help button.

2 AASHTO SiteManager Help _ O] x|
File Edit Bookmark DOptions Help
Eontentsl Search I Back I Print I ELs I 3 |§Ic|ssar_l,l|

Contents ﬂ

The following Help Topics are available:

General Concepts

Edit Menu - Cutting, Copying, and Pasting

Edit Menu - Undo

Edit Menu Choices

File kenu - Dizplaving the Sitebd anager Panel

File kenu - Exiting SiteM anager Using the Menu

File Menu - Exporting & 'Windows Print Besults - Print Previews Save s Button
General Procedures - Documentation Support

Help Menu - Acceszing Help by Contents Using the Menu
Help Menu - Accessing Help Using the F1 Key

Help Menu - On-Line Help Development

Help kenu - Using Help by Searching

Help kenu - Using the Current *Window Help

Help kenu Choices

Menus - Edit Menu

kenus - File Menu

tenus - Frame Menus

tenus - General Guidelines

tenus - Help Meny

tenus - Menu Layout

tenus - Object Menu Choices

tenus - Object Menu

tenus - Services Menu

tenus - Using Sitebd anager Menus

tenus - Window kenu

tenus - Window kenus LI

Figure 3-27. The Help Contents

Using Help by Searching

The Search for Help on choice displays a lengthy, alphabetized list of Help Topics that can be
browsed or searched for the subject on which you need help.

To access Help by searching:

1. Click the Help menu and click the Search for Help on choice.

N

Type the topic on which you need help.
3. Click the topic.
4. Click the Display button.

5. When finished, click the File menu and click the Exit choice.
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Index |Find |

1 Tuvpe the first few letters of the word you're looking for.
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2 Click the index entry you want, and then click Dizplay.

Acceszing SOMS in DWA

Accessones

Adminigtrative Offices Panel

Agagregate Blend

Agagregate Mix Designs

Agaregate Mix Designs Compression Strength Folder Tab
Agagregate Mix Designs Description Folder Tab
Aggregate Mix Designs Gradations Folder Tab
Aggreqate Mix Desighs Maternialz Folder Tab
Annual EEQ Repart

Approval Groups Window

Approval Rules Window

Approval Window

Approved Lists [con

Approved Lists Beports

Approved Materials

Autopay [tem Window

| Dizplay I Print...

Cancel |

Figure 3-28. The Help Search

Using the Current Window Help

With any SiteManager window active, the Help menu’s Current Window choice accesses context

sensitive help that includes Help on fields.

To access Help on the current window:

1. Display the SiteManager window for which you need help.
2. Click the Help menu and click the Current Window choice.

3. When finished, click the File menu and click the Exit choice.

To access Help on a field:

A w0 e

Click the Help menu and click the Current Window choice.
In the field list, scroll to and click the desired field.

When finished, click the File menu and click the Exit choice.

Display the SiteManager window that has the field for which you need help.
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<% SiteM anager
File Edit Bookmark Option: Help

3. General Concepts
= E3

Qontentsl §earch| Back I Print I << I > Iﬁlossaryl

Agagregate Mix Designs Compression Strength Folder Tab

To add a new Aggregate Mix Design compression strength:

1. Add or open the Mix Design description.

2. Clickthe Compression Strength folder tab.

3. Inthe Age field, type the desired value.

4. Inthe Age Type drop-down list, click the expand
arrow to the right of the current selection and click
the desired choice.

5. Pressthe Tab key.

6. Inthe Cement Percent field, type the desired
walue.

7. Pressthe Tab key.

8. Inthe Compression Strength field, type the
desired value.

9. Inthe Compression Strength Units Type
drop-dawn list, click the expand arraw to the right of
the current selection and click the desired choice.

10. ‘“When complete, click the Save button.

Figure 3-29. The Help on a SiteManager Window

3.5 Object Menu

The Object menu can be opened by right clicking a column. When the standard Windows selection
pointer is positioned on a column that can be searched, it is replaced by the Search Lens. The Search
Lens indicates that an Object menu can be invoked to perform a search by clicking the right mouse

button.

Figure 3-30. The Search Lens

As with other Windows applications, the available choices in the Object menu are context sensitive,
depending on what column the selection pointer is positioned on and whether it is selected. When
choices in the object menu are unavailable, their inactive status usually indicates the column is not
selected. The Object menu includes five choices described in the following.
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Sort
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Figure 3-31. The Object Menu
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Object Menu Choices Description
Search Searches for the specified field value.
Filter EI_imi_nates all records other than the Filter
criteria.
Find Finds the specified field value.
Sort Sort the records in ASCII order in either
ascending or descending order.
Show Filter/Sort Displays the applied Filter/Sort criteria.

Table 3-9. he Object Menu Choices Table

The Object menu is a context sensitive capability. To make data entry and retrieval easier, the
choices that appear in the Object menu are determined by where you right click. For instance, when
you position the pointer above a searchable field, the Search Lens appears. Right clicking the
searchable field produces an Object menu with the Search choice as the only available choice.

The Filter and Find functions also provide users with the ability to limit the data retrieved from the
SiteManager database by specifying criteria using relational operators. The Clear function clears the
current data retrieval choice in effect. The Show Filter/Sort choice shows the current criteria in
effect for these choices.

Cut
Paste

Copy
Clear

Search

Filter
Find
Sort

Shaw Filters Sart

Figure 3-32. The Object Menu

3.5.1 Search

When a data entry field requires selecting a value from a list of possible values, the Search choice
allows the user to limit the list and quickly select the desired value.
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ﬂPorlland Cement Concrete Mix Design Description

Description Properties

Materials

Gradations

3. General Concepts

Material Code:

Producer Supplier Code:
Designer Name:
Concrete Class Type:
Effective Date:

Approved Date:

MixID: [

|D1 /31797
IEID.-’EID.-’EID

Termination Date: II]DJEIDJEID
Approved By User ID: I

To search on a field:

Figure 3-33. The Search Lens Appears

1. Position the selection pointer (changes to the Search Lens) over a search field.

2. Click the field using the right mouse button.

3. From the object menu click the Search choice.

4. Select the correct record from the list.

5. Click OK.

Search Window E3 |

Item Code | Spec Year Short Description =
001-0000 1933 MISC ITEMS
001-0000 1933 MISC ITERMS
001-0000 1933 MISC ITERS
001-0000 1933 MISC ITERMS
01-0000 1932 MISC ITEMS
001-0000 1932 MISC ITERS
001-0000 1932 MISC ITERMS
001-0000 1932 MISC ITERS =
4 | 2
0K Cancel

3.5.2 Filter

Figure 3-34. The Search Window

The Filter choice allows the user to specify filtering criteria for SiteManager fields and limiting their
values using relational operators. Each time a window displays, the filtering criteria, marked as
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default, is automatically applied, thereby limiting the amount of data retrieved. Only one default
filter criterion can be in effect for a window at any given time.

Note: When creating multiple conditions, remember that AND joins are executed before
OR joins.

To filter out other records:
1. Position the selection pointer over a record
2. Click the record using the right mouse button.
3. From the object menu click the Filter choice.
4. Click the Add button.

5. In the Field drop-down list, click the expand arrow to the right of the current selection and
click the desired field.

6. Inthe Condition drop-down list, click the expand arrow to the right of the current selection
and click the desired choice.

7. Inthe Value field, select the current entry and type the desired value.
8. To add additional conditions, click the Add button.

9. Inthe Join drop-down list, click the expand arrow to the right of the current selection and
click the desired choice.

10. Repeat steps 5-9 until you have selected all conditions.

11. Click OK.
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Field Condition Value Join Insert
| [={= [=1| and Add
= I Bemove
Clear

Test

Load. .

Save..

Cancel

Help

Figure 3-35. The Filter Criteria Window

3.5.3 Find

When a window displays as a scrollable list, the Find choice allows the user to get to a specific row
by selecting the appropriate value to find.

Note: When creating multiple conditions, remember that AND joins will be executed
before OR joins.

To find specific records:
1. Position the selection pointer over a record
2. Using the right mouse button, click the record.

From the object menu click the Find choice.

W

Click the Add button.

5. Inthe Field drop-down list, click the expand arrow to the right of the current selection and
click the desired field.

6. Inthe Condition drop-down list, click the expand arrow to the right of the current selection
and click the desired choice.

7. Inthe Value field, select the current entry and type the desired value.
8. To add additional conditions, click the Add button.

9. Inthe Join drop-down list, click the expand arrow to the right of the current selection and
click the desired choice.
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10. Repeat steps 5-9 until you have selected all conditions.

11. Click OKk.

3.5.4 Sort

When the window displays as a list, the Sort feature allows the user to sort the list based on specified
criteria. Each time the window displays, the default sort criterion is automatically applied. As with
the Filter function, only one default sort criterion can be in effect for a window at any given time.

To sort the records:

1.

N

W

Position the selection pointer over a record
Using the right mouse button, click the record.
From the object menu click the Sort choice.
Click the Add button.

In the Field drop-down list, click the expand arrow to the right of the current selection and
click the desired field.

In the Order drop-down list, click the expand arrow to the right of the current selection and
click the desired choice.

To add additional sorts, click the Add button.
Repeat steps 4-7 until you have selected all sorts.

Click Ok.
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Sort Criteria - New Sort Eq

Field | Order
| A |~ | -.cending =

I |z Descending (=l Add

Inzert

Bemove

Clear

Load...

Save. .

1].4

Cancel

Help

Figure 3-36. The Sort Window

3.5.5 Show Filter/Sort
The Display Filter/Sort choice displays the current criteria in effect.
To display the current criteria:

1. Position the selection pointer over a record

2. Using the right mouse button, click the record.

3. From the object menu click the Show Filter/Sort choice.

4. Click Ok.

3.6 Documentation Support

Online versions of the User Reference Manual and the Sampling and Testing Procedures for your
agency are accessible as a PDF file. The Sampling and Testing Procedures are a resource provided
by AASHTO.

To access online documentation:
1. On the Main Panel, double-click the Documentation icon.

2. Double-click the documentation icon you wish to reference.
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Previous Page Button Next Page Button

First Page Button ast Page Button
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Figure 3-37. The Documentation in Adobe Acrobat

To navigate in Adobe Acrobat:

1. Click the Next Page button.
Or

2. Click the Previous Page button.
Or

3. Click the First Page button.
Or

4. Click the Last Page button.
Or
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5. Click the Go To button.

6. Type page number you want to which you wish to go.

7. Press Enter.

3.7 Reports

The following procedures are a general description of how to generate PowerBuilder-based
SiteManager reports. Each chapter of the manual describes report specific to each component of
SiteManager.

Reduce the zoom to 80 to view the entire page of the report.
To generate a report:
1. Select the Reports icon for the desired report.
2. If applicable, select the criteria.
3. Select the option for the desired format
= By Summary (selects all items)
= By Criteria (field name) selects an individual field.
If you select By Criteria, click the field using the right mouse button.
Perform a Search using the object menu (referenced in the Getting Started section).
Click OK.

4. To generate a PowerBuilder-based report, double-click the desired report icon and select the
criteria.

5. To generate the report online, click OK.

6. To generate the report to a file, select the Generate Off-line File check box (ON) and
click OK.

7. To generate and print the report, select the Generate Off-line Print check box (ON)
and click OK.

The Summary by Project Report is unique in that multiple reports may be generated in a batch print
process.

To select multiple reports to be printed:

1. On the Report Criteria window, select the Generate Off-line Print check box (ON).
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2. Highlight the desired criteria by holding down the Shift or Ctrl keys and clicking the desired
report criteria. The Shift key allows an entire block of criteria to be selected, while the Ctrl
key allows individual rows of criteria to be selected.

3. Click OK.

3.7.1 Report Options

The report options are available as toolbar buttons or menu options for reports that have been
generated online.

Components Description
Close button Closes the report preview.
Save button In a simple report (see Save Reports section) invokes

the Save dialog allowing the report to be saved in a
PSR file format.

Print button Prints the report.

Prior button Displays the prior page of a multi-page selection.
Next button Displays the next page of a multi-page selection.
Zoom spin button Magnifies or reduces the display of the report preview.

Copies spin button Allows more than one copy of the report to be printed.

Table 3-10. The Report Components Table

3.7.2 Saving, Opening, and Exporting Simple Reports

There are two types of reports in SiteManager: simple and complex. Simple report can be saved
and exported, but complex reports cannot. The File menu’s Save choice (or the Save button) and the
Service menu’s Export choice are active for a simple report. They are not active for a complex
report.

Saving and Opening Simple Reports

A simple report can be saved for later retrieval. SiteManager saves the report using a .PSR
extension. The View Saved Report icon on your reporting panel can be used to open a saved report.

To save a report:

1. Click the File menu and click the Save choice.
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Or

2.
3.
4.
5.

Click the Save button.
Type the name for the file.
Change the drive and directory as desired.

Click OK twice.

To open a saved report:

1.
2.
3.
4.

Double-click the View Saved Reports (PSR) icon on the reports panel.
Change the drive and directory as needed.

Select the PSR file.

Click OK.

Exporting Simple Reports

A simple report can be exported into file formats other than PSR. To access an exported simple
report file, you must have an applications software package that can access one of the file formats.

File Extension File Format Description
TIXT ASCII Tab Separated (Delimited) format
XLS Microsoft Excel Spreadsheet format
WKS Lotus 123 early format
\WMF Windows Metafile graphical format

Table 3-11. The Export File Formats Table

To export a report:
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1.
2.
3.

Click the Services menu and click the Export choice.
Type the name of the file.

Click the expand arrow to the right of the Save File As Type drop-down list and click the
desired file format.

Change the drive and directory as desired.

Click OK twice.
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3.8 Plug-In, URL, and OLE Attachments

The URL/Plug-In/OLE functionality of SiteManager allows URL links, Plug-In applications, and
OLE documents to be attached to certain SiteManager functions or specific records within that
function. The stand-alone feature also allows URL links, Plug-In applications and OLE documents
to be accessible to the User through a separate Attachments window accessed through the
Accessories panel.

Attachments may be associated with a specific record. Attachments may also be configured to either
activate when a window is opened or when selected through the Attachment window. System-based
attachments are URL links, Plug-In applications, and OLE documents that do not need to be
associated with a specific SiteManager function or record. System Attachments are accessed
through the Accessories panel.

URL links, Plug-In applications, and OLE documents may be associated to:
= Material Test Templates
= DWR Templates
= Contracts
= Contract Estimate History
= Correspondence Log
= Construction Conference
= Change Order Header
= DWR - Record Work Item
= Maintain Sample - Additional Sample Data
= SUPERPAVE Mix Design
= Portland Cement Concrete Mix Design
= Force Accounts
= Contract Adjustments
= Contract Time Adjustments
= Line Item Adjustments
= Contractor Evaluation

= Milestone Time Adjustment
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Attachments are activated by a User click or configured to trigger automatically when a window to
which an attachment is associated is initialized. Each Plug-In application, URL, or OLE document
may be associated to a specific record.

The Plug-In functionality also allows a limited amount of data to be automatically passed to a Plug-
In application upon execution.

3.8.1 URL, Plug-In and OLE Attachment Icons

= Activates the Attachments window.

Appears on the Accessories panel, and activates the stand-alone
Attachment window.

Appears on the toolbar of any window that may have an attachment
associated with it. An Attachment icon without a paperclip signifies
there are currently no attachments associated with the current record.

[ﬂ? Activates the Attachments window.

Appears on the Accessories panel, and activates the stand-alone
Attachments | Attachment window.

Appears on the toolbar of any window that may have an attachment
associated with it. An Attachment icon with a paperclip signifies
there is an attachment associated with the current record.

:_@_' Allows User to activate Plug-In applications or URLS associated
with the window.

Run

Attachments

jU Opens a dialog box allowing the properties of a URL attachment to
be modified or entered.

New URL

PBI Opens a dialog box allowing the properties of a Plug-In attachment
to be modified or entered.

New Plug-In

HLE Opens a dialog box allowing the properties of an OLE attachment to
be modified or entered.

New OLE

Document

g Deletes the current OLE document.
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Delete OLE
Document

Table 3-12. The Attachment Icon Table

3.8.2 Attachment Usage

Hame Type Descrnption Autorun
wordpad for contract C10786

Figure 3-38. The Attachment Window

To display Plug-In, URL, and OLE attachments:

1.
2.

Navigate to the SiteManager function associated with the attachment you wish to use.

Click the Attachment icon to access the Attachment window.

Note: As the attachment is associated to a specific record, that record must be opened
before accessing the Attachment Window. The Autorun feature indicates that the
attachment will be run as soon as the Attachment Window is opened without the user
having to click the Run button.

The previously-created URL, Plug-In, and OLE attachments appear as a table grid on the
Attachments window. Sort and Filter features may be used on this window by right-clicking
and choosing a feature from the Object menu.

Double-click the desired attachment to activate, or highlight the desired attachment and click
the Run Attachments icon.

Activating a Plug-In opens the specified application in a separate window. Activating a URL
or HTML File item launches the system’s default browser. Activating an OLE opens the
specified document.

Once you have completed work with the URL, Plug-In application, or OLE document, the
browser or application may be closed as normal.

Once the appropriate area of SiteManager has been reached, the creation steps are identical.
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Figure 3-39. The Attachment Window

Field Description
Name Name of the attachment
Type OLE, URL or Plug (executable)
Description Short textual description of the attachment.
Autorun Indicates that the attachment will be run as soon as the user
opens the attachment window.

Table 3-13. The Attachment Window Field Description Table

To access the Attachments window, click the Attachments button, or click the Services menu and
click Attachments.
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Plug-In Attachment Definition

¥4Plug-in Attachment x|
Enter command line:
Build Command. .. I
D escription:
Attachment Security:
GrouplD  Description ] Description Access
ACCTPG  [Accounting - Projects and Grants Add -» !
[EDMASET [adrinistrative Sasistart i
ICOSTEST [Cost Estimates - M
IFINLENG  [Firalz Enaginzer
NG Irquiiry Tirily - D3R
lINSP lrspectar Standalons “Re ;
IMSPTST  [Field Inspectar/Taster ‘i“m‘}
INSPTSTS [Field Inspectar/Tester - Standalone _{ << Rem All
J W
[ Bun Automatically
Add |  Cancel |
Figure 3-40. The Plug-In Attachment Window
Field Description
Name Required field. The user-entered name of the attachment
entered in freeform text.
Enter Command The executable application’s command line. Either entered
Line by the user or returned through the Build Command
function.
Description Not a required field. A short, user-entered description of
the executable application in freeform text.
Attachment Security | Allows the user to restrict access to the attachment at the
Group level.
Run Automatically If checked, the Plug-In is executed upon activation of the
window it is attached to.

Table 3-14. The Plug-In Attachment Window Fields Table

To create a new Plug-In Attachment:
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Click the New Plug-In button to access the Plug-In Attachment window.

On the Plug-In Attachment window, click the Name field and add a name for the new plug-
in.

Click the Enter Command Line field. The command line may be entered directly into this
field or returned from the Build Command button.

Note: The Build Command function is discussed in the next section.
Click the Description field and enter a description.

In the Attachment Security box, choose the Group(s) to which this Attachment will be
visible and click Add to add each one to the Access box.

To make the Plug-In executable upon window initialization, click the Run Automatically
box on.

After all fields defining the Plug-In are entered, click the Save button.

Note: The Run Automatically check box does not appear in the stand-alone function.

The Build Command Function

The purpose of the Build Command function is to assist you in the set up of a plug-in attachment’s
executable command line and any additional data that needs to be passed to the application at
execution.
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Command Line:

Executable File:

Select File... |

—Parameters

Field Variables: [ ser id
user password

Other:

Add

A |
OK | Clear | Qancell

Figure 3-41. The Plug-In Attachment Build Command Window

Field Description

Command Line This protected field displays the command being built from
the Executable File, Parameters: Field Variables, and
Parameters: Other fields. This line may not be longer than
255 characters.
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Executable File Required field. This may be entered by the user or populated
by selecting a file from the Select File function.

Parameters: Field Field variables are selected from the list provided. This list
Variables will differ depending upon which function is being accessed.
Variables are retrieved from the SiteManager database and
passed to the executable application.

Parameters: Other | Variables entered in this field are passed as entered to the
plug-in application when it is activated by a user.

Table 3-15. The Plug-In Attachment Window Fields Table
To build a command using the Build Command function:

1. On the Plug-In Attachment window, click the Build Command button. The Build
Command window opens.

2. Enter the executable command path or click the Select File button.

a. The Select File window opens, allowing browsing of the system’s directories to locate
and select an executable file and its path directory.

b. Click Open. The file name and path are passed to both the Executable File and the
Command Line fields.

3. If desired, select an item from the Parameter Field Variable list by clicking on the desired
item. Click the Add button to add the field variable to the Command Line. These variables
for the selected record will be passed to the plug-in attachment when it is activated.

a. If the attachment is for Contracts, the Contract ID is a variable that may be passed to the
attachment automatically by the system.

b. Since a space is the defined parameter delimiter for plug-in command lines, there should
be no spaces in the path defining where the plug-in attachment can be found by the
system. For example, if a user wishes to have a plug-in attachment that initializes a Word
document called form.docx, the command line might be:

c:\program files\msoffice\winword\winword.exe c:\templates\form.docx

If the command line were written as follows, the command would not work because of
the space in the My Documents directory name:

c:\program files\msoffice\winword\winword.exe c:\my documents\templates\form.docx

4. To add additional data to be passed to the application at execution, click the Parameter:
Other field and enter the desired data.

5. Click Add. The additional data appears on the Command Line.
45



Trnseport SiteManager®

3.8 Plug-In, URL, and OLE Attachments
6. When the Command Line has been completed, click the OK button. The Build Command

Line window closes, and the Command Line is passed to the Plug-In Attachment window’s

Enter Command Line field.

Plug-In Fields Available

3. General Concepts

The following table, organized by SiteManager functionality, lists the fields available to the Plug-In

function.

46

Functional Field ID Field Description
Area

All Areas
USER User ID
PSWD User Password

Daily Work Reports
CONT DWR Contract ID
DATE Daily Work Report Date
INSP DWR Inspector User ID
PROJ DWR Project Number
ITEM DWR Line Item Number
LOCA DWR Location Sequence Number

Materials Management

SMPL Sample ID

METH Test Method

TST# Sample Test Number
RGHT User Rights

MTR# Material Code

SPBY Sampled By

PSC# Producer/Supplier Number
ATHZ Authorized By user ID
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Functional Field ID Field Description
Area

RVS# Revision Number
SPFR Sampled From
GEOA Geographic Area
STAT Sample Status
MIX# Sample Mix ID
MIXT Sample Mix Design
LAB# Lab ID
SPDT Date Sampled
AZDT Date Authorized
CMDT Date Completed

Contract Administration

CONT

Contract ID

EST#

Estimate Number

Table 3-16. The Fields Available for Plug-Ins Table
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URL Attachment Definition
=2 Plug-in Attachment i
IS
Enter command line:
Build Command. .. ]

Description:

Attachment Security:

Group 1D Description - Description e
Accounting - Projects and Grants Add -» i

DMASST [Edmiristrative Assistant

COSTEST [Cost Estimates

Add All ->> i

FINLENG  [Finals Engineer

MO [IFquiiny Tkl - DR

IMSF. [[Fspector Standalone P I
IMSPTST [Field Inspecton/ T ester

+]

IMSPTSTE [Fisld Inspecton/Tester - Standalc'.njl’ <¢-Hem All
>

[ Run Automatically

Add |  Cancel

Figure 3-42. The Select File or URL Window

Field Name

Description

Name

Required field. The user-entered name of the
attachment, entered in freeform text.

Enter the URL or
Specify a Local File

Required field. The location of a local html document
or web page address.

Description

Not required. A short, user-entered description of the
html document or web page address.

Table 3-17.

The Select File or URL Attachment Window Fields Table

To create a new URL or HTML File attachment:

1. Click the New URL button to access the Select File or URL window.

2. Click the Name field and add a name for the new URL.

3. Click the Enter Command Line field. The command line may be entered directly into this
field or returned from the Choose File function.
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4. Click the Description field and enter a description.

5. In the Attachment Security box, choose the Group(s) to which this Attachment will be

visible and click the Add button to add each one to the Access box.

6. After all fields defining the URL or HTML file are entered, click the Save button.

OLE Attachment Definition

Insert Object K|

Create New | Create From File I Inzert Control |

Object Type:
ActionBwr Clazs ﬂ [ Display &2 lcon

ActorByr Clazs

Adboak Diocument

Adbook. Dacument D
Adaobe Acrobat Document

Bitmap Image ColorBwr Class
iColorByr Class
Cr Behavior Factary

DataCH Clasz
DHTHL Edit Cantral for IES

DHTHL Edit Cantral S afe far Scripting f
EffectBywr Clags LI Browse... |

— Result

Inzerts a new ColorBywr Clazs object into pour

s
F document.

Ok I Cancel |

Figure 3-43. OLE Insert Object Dialog Box (Create New Tab)

Field Name

Description

Object Type

List of OLE-compliant applications that are installed on the
client machine that may be used to create an OLE document.

Table 3-18. The OLE Insert Object Dialog Box Fields Table

3. General Concepts
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B 0LE Attocheont | |____L_LLIL LI |

Name:

OLE contents:

ordPad D ocument

D escription:

Attachment Security:

Group ID Description s Description Access

Add ->

ADMASST [Administrative Assistant
COSTEST |Cost Estimates

Add All ->>

FINLEMG [Finals Engineer

INSPTST |Field Inspector/T ester

INSPTSTS [Field Inspector/T ester - Standalone
rANAGER [Manager - Inguiry Only

P Project anager <1 << Hem All |
L« | _’lJ

[~ Run Automatically

| B

<- Hemove

Add r LCancel |

Figure 3-44. The OLE Attachment Definition Window

Field Name Description

Name Required field. The User-entered name of the attachment,
entered in freeform text.

OLE Contents A non-editable field which indicates the application in which
the OLE attachment is generated.

Description A freeform text explanation of the OLE attachment and its
purpose.

Attachment Security: The Group ID to which the attachment is to be accessible.

Group 1D

Attachment Security: The full, descriptive name of the Group ID.

Description

Run Automatically When checked, this box indicates that the OLE will be run

automatically when the Attachments icon is clicked.

Table 3-19. The OLE Attachment Definition Window Fields Table

To create a new OLE attachment:
1. Click the OLE button to access the Insert Object dialog box.

2. Select the type of OLE object to be created by clicking the application name in the Object
Type box.
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3. Click OK. The OLE Attachment definition window appears
4. Click the Name field and enter a name for the OLE attachment.
5. Click the Description field and enter a description.

6. Inthe Attachment Security box, choose the Group(s) to which this Attachment will be
visible and click the Add button to add each one to the Access box.

7. Ifitis desirable to have the OLE attachment appear upon entering the Attachments window,
select the Run Automatically check box.

8. After all fields defining the OLE are entered, click the Add button.

9. On the Attachments window, double click the OLE definition just created to begin creating
the OLE document.

10. When finished, click File then Update, and close the window normally.

51






4. Contract Administration - Reference Tables




Trnseport SiteManager®
4. Contract Administration - Reference Tables4.1 Reference Tables (Contract Administration)

Contract Administration includes the reference data and program functions that are used to view,
add, modify, and delete contract records. These are grouped on the following panels:

Panel Name Description
Reference Tables The Reference Tables (CA) panel contains the
(CA) Panel contract defaults and standard data. This includes the

vendors, funding sources, and items that you can add
to contracts. The Interface Load Messages window
displays the results of processes that load data from
other systems.

Contract Records The Contract Records panel contains the functions
Panel that maintain contract records. This includes the
contract description, milestones, projects, categories,
items, funding, stockpiled materials, key dates,
scheduled events, permits, user authority, and design
evaluations.

Contractor The Contractor Management panel contains
Management Panel functions for recording contract-specific data on
prime contractors and subcontractors. This includes
conference and document tracking, subcontract
descriptions, contractor payrolls, progress schedules,
and contractor evaluations.

Reports Panel The Reports panel contains contract-specific reports.
These include reports on contract status, contractor
status, subcontract value, disputes and claims, item
quantity, item work, and contract history.

Table 4-1. Contract Administration Panels Table
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i j ontract Admini :
il @ G
Contractor e ocess Lis

eeeeee

Figure 0-1. Contract Administration Panel
To access the Contract Administration panel:

1. On the SiteManager main panel, double-click the Contract Administration icon.

4.1 Reference Tables (Contract Administration)

The Contract Administration reference tables store the defaults and the agency-defined standards
that are added to contracts. Typically, the reference table data is loaded into SiteManager from
another system using an interface load process. This section of the manual describes how to view
and maintain the reference table data in SiteManager.

Through the Reference Tables (CA) panel, you can add the following standards and defaults to the
reference tables if you are an authorized user: administrative offices, funding sources, vendor
information, default key date types, default checklist event types, and default liquidated damage
rates. The Reference Tables (CA) panel cannot be used to add the default critical date types or items.
The default critical date types were defined during system development. Items are added to the Item
Master via the pre-construction system load program.

The defaults include the critical date types, key date types, checklist event types, and the liquidated
damage rates. After defaults are entered in the reference tables, SiteManager adds the defaults to
new contracts automatically. For other contract defaults, see the topic System Operational
Parameters for Contracts.

The standards include the administrative offices, items, funding sources, and vendor information.
The standards are defined by the transportation agency. After standards are entered in the reference
tables, you can add standard data to a contract by selecting it on the appropriate SiteManager
window. For example, the funding sources can be selected on the Contract Funding window.

! Important! SiteManager will not let users overwrite the Reference Table data loaded
from the pre-construction system by the interface load process.

The Reference Tables (CA) icons represent the following windows:
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= Interface Load Messages
= Administrative Offices

= |tem Master

= Funding Sources

=  Vendors

= Default Critical Dates

= Default Key Dates

= Default Checklist Events

= Default Liquidated Damages

5 SiteManager Panel [ x|
tain Panel T Contract Administration(+) T Reference Tables[CA+)
Mhage 5 = T Schedule
o = &
QEIECARELR Administrative  ter Master  Funding Sources  Yendors Default Critical ~ Default Key
Offices Dates Dates
Default Checklist Default
Ewvents Liquidated

Damages

Figure 0-2. Reference Tables (CA) Panel
To access the Reference Tables (CA) panel:

1. On the Contract Administration panel, double-click the Reference Tables (CA) icon.

4.1.1 Interface Load Messages

This Interface Load Messages window lists the messages generated during the interface load
processes. You can view and delete the messages on this window, and you can find, filter, and sort
the message list.
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Reference data load process | Reference Table data is loaded into SiteManager

(REFLOAD) from another system by the REFLOAD process.
Pre-construction Contract New contracts are loaded into SiteManager from
data load process the pre-construction system by the PRELOAD
(PRELOAD) process.

Construction Contract data | Contracts to be converted are loaded into
load process (CONLOAD) | SiteManager from the pre-construction system by
the CONLOAD process.

Table 0-2. Interface Load Process Table

Elnlellace Load Messages H=1 3
Load
Date Process | Contract ID Table ID Message

13930408 | REFLOAD T_INTRFC_MSG MNULL during insertl
13930408 | REFLOAD T_INTRFC_MSG Record 8; SALSTATE = 23000M[INTERSOLY]ODEC Orac
19930408 | REFLOAD T_INTRFC_MSG Oracle]0RA-01400: mandatory (MOT MULL) column is miss
19930408 | REFLDAD T_INTRFC_MSG Record 3; SALSTATE = 230000[INTERSOLY][ODEC Orac
19930408 | REFLOAD T_INTRFC_MSG Oracle]0RA-01400: mandatory (MOT NULL) column is miss
13930408 | REFLOAD T_INTRFC_MSG MNULL during insertl
19930416 | REFLOAD T_INTRFC_MSG Oracle]0RA-01400: mandatory (MOT MULL) column is miss
19930416 | REFLDAD T_INTRFC_MSG MULL during insert]
19930416 | REFLOAD Fecord 10 invalid
19930416 | REFLOAD T_INTRFC_MSG Oracle]0RA-01400: mandatory (MOT NULL) column is miss
13930416 | REFLOAD T_INTRFC_MSG Record 8; SALSTATE = 23000MINTERSOLY]ODEC Orac
19930416 | REFLDAD T_INTRFC_MSG MULL during insert]
19930416 | REFLDAD T_INTRFC_MSG Record 3; SALSTATE = 23000M[INTERSOLY]ODEC Orac
A1

Ready [Server [FROD [SMADMIN  [S'YS1

Figure 0-3. Interface Load Messages Window

Field Name Description

Date Date the interface load message was generated.

Load Process Name of the interface load process that generated the
message (REFLOAD, PRELOAD, or CONLOAD).

Contract ID Transportation agency-defined ID for the contract
associated with the interface load message.
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Field Name Description

Table ID Name of the database table associated with the
interface load message.

Message Interface load message text.

Table 0-3. Interface Load Messages Window Fields Table
To delete an interface load message:
1. On the Reference Tables (CA) panel, double-click the Interface Load Messages icon.

2. To select one message to delete, click the row. To select multiple messages, hold the Ctrl
button and click the left mouse button on each row.

3. Click the Delete button. The selected message is deleted from the list.
4. Click the Save button.

You can use the find, filter, or sort functions to find specific information.

4.1.2 Default Liquidated Damage Rates

The Default Liquidated Damages window lets you view and modify the default liquidated damage
rates. SiteManager adds a default rate to new contracts based on the bid amount of the contract. On
the Default Liquidated Damages window, you can enter the rate per day for each contract bid
amount range. The system only displays the highest value for each range. The lowest possible value
for the Contract Amount Range is $0.00, while the highest possible value is always
$9,999,999,999.99.

If you do not enter a contract’s liquidated damages rate manually, the system adds the default rate to
the contract automatically when the contract status is changed to active.
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EDEfault Liquidated Damages

Contract Range Max Amt Hate Amount -
m 430,00

55,555.00 500.00
100,000.00 530.00
260,000.00 E10.00
500,000.00 73000

1.000,000.00 300.00
2.000,000.00 1.150.00
4,000,000.00 1.510.00
8.000,000.00 2.030.00
12.000,000.00 2.550.00
16.000,000.00 3.150.00
18.000,000.00 3,330.00
20.000,000.00 3.510.00
22.000,000.00 3.690.00
24.000,000.00 3,E?D.EIEI;|

Figure 4-4. Default Liquidated Damages Window

Field Name Description
Contract Range The maximum amount for which the liquidated damages
Max Amount rate can be used. The total contract bid amount must be

equal to or less than this amount and more than the
previous ending amount. This value must be unique. For
states with one standard amount for all contracts, this
value defaults to 99,999,999,999.00 and cannot be
modified.

Liquidated Damages | The default liquidated damages rate per day. This amount
Rate Amount is associated with the Contract Range Maximum Amount.

Table 0-4. Default Liquidated Damages Window Fields Table
To add a default liquidated damages rate:
1. On the Reference Tables (CA) panel, double-click the Default Liquidated Damages icon.
2. Click the New button. An empty row is inserted before the selected row.
3. Type the ending range for the Contract Range Max Amt.
4. Press the Tab key.
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5. Type the Rate Amount.
6. Click the Save button.
7. Click the Yes button.
The list is sorted in ascending order of ending range amounts.

The large value in the last row cannot be modified or deleted.

4.1.3 Default Critical Dates

The Default Critical Dates window lets you view and modify the default critical dates. The default
critical date types were defined during system development. The transportation agency cannot add,
modify, or delete the critical date types. However, if you are an authorized user, you can modify the
default critical date settings. SiteManager adds the default critical dates automatically to each new
contract. The critical date types are listed here in alphabetical order:

= Accepted Date

= Adjusted Completion Date

= Award Date

= Checked Out to Field Date

= Contract Archived Date

= Contractor Bankruptcy Date

= Contractor Default Date

= Contractor Final Release Date
= Execution Date

= Letting Date

= Notice to Proceed Date

= Open to Traffic Date

= Original Completion Date

= Physical Work Complete Date
= Price Adjustments Base Date

= Signed Date
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= Substantial Work Complete Date
=  Work Begin Date

These dates are considered critical because SiteManager includes them in the standard contract
record reports.

ﬂ Default Critical Dates [_[O] x]

Critical Date Type Required to Activate | Required to Finalize

Accepted Date

= b=

Adjusted Completion D ate
Contract Archived Date
Award Date

Contractor Bankruptcy Date
Checked Out to Field D ate
Contractor Default Date

Execution Date

Contractor Final Release Date

Letting Date

ZZZ|ZZZZ| = Zpg=

<|l=z[=|XL|= (=== |=

Motice to Proceed Date -
4 3|
Critical Date Type: [Accepted Date [T Required to Activate
Distribution List: | [ Required to Finalize
Recipient |D:|

Message Text: |

Figure 4-5. Default Critical Dates Window

Field Name Description

Critical Date System-defined default critical date type. The default critical
Type date types were defined during system development. The
transportation agency cannot add, modify, or delete the
critical date types.

Required to Indicates that a critical date event must occur before the
Activate contract status can be changed from Pending to Active (e.g.,
the Execution Date). A critical date cannot be both Required
to Activate and Required to Finalize.

Required to Indicates that a critical date event must occur before the

Finalize contract status can be changed to Complete. A critical date
cannot be both Required to Activate and Required to
Finalize.

Distribution Group to be notified when the actual date of the critical date

List event is entered. You can search this field. After valid entry

of a distribution list, the Recipient ID field is protected.
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Field Name Description

Recipient ID Person to be notified when the actual date of the critical date
event is entered. You can search this field. After valid entry
of a recipient ID, the Distribution List field is protected.

Message Text Standard message to be sent to the recipient(s).

Table 4-5. Critical Dates Window Fields Table
To make a critical date Required to Activate:
1. On the Reference Tables (CA) panel, double-click the Default Critical Dates icon.
2. Click the critical date.

3. If the date is currently not required for either status change, click the Required to Activate
radio button.

4. Click the Save button.
To select one or more recipients for notification that a date has occurred:
1. On the Reference Tables (CA) panel, double-click the Default Critical Dates icon.

2. Inthe Distribution List field or the Recipient ID field, type the entry or click the right
mouse button and perform a Search.

3. Click the Save button.

4.1.4 Default Key Dates

The Default Key Dates window lets you add, modify, and delete the default key dates. The key date
types are defined by the transportation agency in the system code tables. On the Default Key Dates

window, you can add pre-defined key date types to the default list. You can find, filter, and sort the
list, and modify the key date settings. SiteManager adds the default key dates automatically to each

new contract.

The main purpose of a key date is to monitor a key contract activity and notify personnel when the
activity actually occurs.

10
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5 Default Key Dates _ O] x|

Fed/State/
Prov Ind

Key Date Type Required

to Activate

Required
to Finalize

Closed to Traffic D ate

N o

Key Date Type: |l:|osed to Traffic Date

Fed/State/Prov Ind: | " Federal
" State/Province
{* Both [ Required to Finalize

[~ BRequired to Activate

Distribution List: |

Recipient User ID:

Message Text: |

Figure 4-6. Default Key Dates Window

Field Name Description

Key Date The key date types are the names given by the

Type transportation agency to the key dates (e.g., Closed to
Traffic Date, State Final Inspection Date, Open to Traffic
Date). The key date type is a required field and must be
unique. This field is protected unless you select the New
menu option.

Required to Indicates that a key date must occur before the contract

Activate status can be changed from Pending to Active (e.g.,
Letting Date, Award Date, Execution Date). A key date
cannot be both Required to Activate and Required to
Finalize.

Distribution Group to be notified when the actual date of the key date

List event is entered. You can search this field. After valid
entry of a distribution list, the Recipient User ID field is
protected.

Required to Indicates that a key date is part of the contract

Finalize finalization process. A key date cannot be both Required
to Activate and Required to Finalize.

Recipient Person to be notified when the actual date of the key date

User ID event is entered. You can search this field. After valid
entry of a recipient, the Distribution List field is
protected.

11
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Field Name Description
Fed/State/ Indicates that this date is for federal contracts,
Prov Ind state/province contracts, or for both types of contracts.

This is a required field.

Message Text | Standard message to be sent to the recipient(s).

Table 0-6 The Default Key Date Window Fields Table
To add a default Key Date type to the window:
1. Onthe Reference Tables (CA) panel, double-click the Default Key Dates icon.
2. Click the New button. An empty row is added to the list.

3. Inthe Key Date Type drop-down list, click the expand arrow and click a Key Date Type on
the list of available Key Date Types.

4. In the Fed/State Prov Ind field, select one of the radio buttons.

5. Click the Save button.

4.1.5 Default Checklist Events

The Default Checklist Events window lets you add, modify, or delete the default checklist events.
The checklist event types are defined by the transportation agency in the system code tables. On the
Default Checklist Events window, you can add pre-defined Checklist Event types to the default list.
You can find, filter, and sort the list, and modify the checklist event settings. SiteManager adds the
default checklist events automatically to each new contract.

The main purpose of a checklist event is to schedule an event that occurs more than once or at
regular intervals, and to notify personnel when a date arrives and an action (e.g., approval) has not
occurred.

12
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5 Default Checklist Events [=

Event Group Type | Fed/State/ | Required Doc Type Discrepancy Required =
Prov Ind Indicator | to Activate

Event Type

Bonding Verified User Defined

Final Inspection Completed  |User Defined State/Province M N

DBE Commitment Yerified User Defined N N

o o

Event Type: |Bonding Werified Fed/State/Proy Ind: | * Federal
Event Group Type: [User Defined =1 ; g:]at:leIvaince
Required Doc Type: [Spaces =1 [ External Indicator
F Type: [Monthly (=1 [ Required to Activate
Event Day:lT [~ Discrepancy Indicator
Distribution List: | Recipient User ID: Endusert |

Message Text: |

Figure 4-7. Default Checklist Events Window

Field Name Description

Event Type The event types are the names given by the transportation agency
to the checklist events that occur throughout the life of the
contract (e.g., Bonding Verified, DBE Commitment Verified,
Final Inspection Completed). The Event Type is a required field
and must be unique. This field is protected unless you select the
New menu option.

Event Group | Grouping of associated event types (e.g., EEO, Training, and

Type Certification). This is a required field.
Frequency For repetitive events, the frequency with which they occur (i.e.,
Type Daily, Weekly, Biweekly, Monthly, Quarterly, Semi-Annually,

Annually, and One Time Only). This is a required field. If you
select One Time Only, you can also select Required to Activate.

Event Day The day of the week or month that the event is to occur. For
weekly and bi-weekly events, enter the day of the week (01-07).
For monthly events, enter the day of the month (01-30). This field
is protected for all other frequency types.

Required Doc | Transportation agency-defined codes identifying each type of
Type document (e.g., Trainee report, EEO report, and Material
Certification). This field is required when the External Indicator
is checked (ON).

13
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Field Name Description
Required to Indicates that an event must occur before the contract status can
Activate be changed from Pending to Active (e.g., ‘DBE commitment

verified').

Discrepancy
Ind

Indicates that if an event has not occurred before estimate
generation, it will be reported as a discrepancy.

Distribution Group to be notified when the event’s projected date expires

List before the actual date is entered. You can search this field. After
valid entry of a distribution list, the Recipient User ID field is
protected.

External Indicates that a document is due to be received from an external

Indicator source.

Recipient Person to be notified when the event’s projected date expires

User ID before the actual date is entered. You can search this field. After
valid entry of a recipient, the Distribution List field is protected.

Fed/State/Pro | Indicates that the checklist event is for a Federal Contract,

v Ind State/Province Contract, or Both. This is a required field.

Message Text

Standard message to be sent to the recipient(s).

Table 4-7. Default Checklist Event Window Fields Table

To add a checklist event to this window:

On the Reference Tables (CA) panel, double-click the Default Checklist Events icon.

Click the New button. An empty row is added to the list.

In the Event Type drop-down list, click the expand arrow and click an event type on the list

of available Event Types.

In the Fed/State Prov Ind field, click a radio button.

5. Press the Tab key.

6. Inthe Event Group Type drop-down list, click the expand arrow and click an Event Group
Type on the list of available types.

7. Press the Tab key.

8. To require the receipt of an external document, in the Required Doc Type drop-down list,
click the expand arrow and click the document type.

14
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9.

10.

11.
12.

13.

14.

15.
16.
17.

18.

4.1.6

Press the Tab key.

To require the receipt of an external document, click the External Indicator check box
(ON).

Press the Tab key.

In the Frequency Type drop-down list, click the expand arrow and click the frequency of the
event.

If the Frequency Type is Weekly, Bi-weekly, or Monthly, tab to the Event Day field and
type a number representing the day of the time period on which the event is to occur (e.g.,
type 3 to represent the third day of each month).

If the Frequency Type is One Time Only, tab to the Required to Activate check box. If
desired, click the check box (ON).

Press the Tab key.
To require a discrepancy notification, click the Discrepancy Ind check box (ON).

To select a recipient or recipients, tab to either the Distribution List field or the Recipient 1D
field and type the entry, or click the right mouse button and perform a Search.

Click the Save button.

Funding Sources

The Funding Sources window lets you add, modify, and delete standard funding sources. You can
view but not modify funding sources loaded from the pre-construction system. After a funding
source is entered on the Funding Sources window, you can add the funding source to a contract by
selecting it on the appropriate SiteManager panels (e.g., Contract Funding).
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E Funding Sources !Ii[ | |

Funding Source List

Funding Src Cd Description Participation Pct ﬂ
#503 CONVERSION STATE FUNDING 0
F030 EMERGEMNCY RELIEF FUNDS 100.00
w000 ENGLIS[STANDARD] TEST 0
F090 FHw&, (010] FUNDS 76.87 _I
F14E FHwi&, (075] FUNDS 76.87
F100 FH'w, (081) FUNDS 50.00
F144 FHw&, (085] FUNDS 80.00
F148 FHw&, (138] FUNDS 90.00

M|

Funding Source Detail

Funding Source Code: |[FO03

Funding Source Desc: [ADVANCE CONSTRUCTION INTERSTATE FUM

[¥ Fed Aid Funding Indicator Accounting Fund Code: 009 ¥ Preconstruction Indicator
Participation Percent: |SE|.DD Fund Prefix: |[AC][I] Funding Group: |FHWA

Figure 4-8. Funding Source Window

Field Name

Description

Funding Source
Code

Identifies a source of funding (e.g., Federal grant, Federal
fuel tax, State general fund). This is a required field. This
field cannot be modified after the funding source is
saved.

Description

Name or description of a funding source.

Fed Aid Funding
Indicator

Indicates whether or not this fund contains federal aid
dollars.

Accounting Fund
Code

A code assigned to a fund by the transportation agency’s
accounting department. This field cannot be modified
after the funding source is saved.

Pre-Construction
Ind

Indicator to show that the data is from the pre-
construction system and cannot be modified.

Source The percentage of this fund paid by federal aid. This field
Participation is required if the Federal Aid Funding Indicator is
Percent checked (ON).

Fund Prefix An alternate identification code for a fund.

Funding Group

Allows several funds to be associated with the same
group code.

Table 0-8. Funding Source Window Fields Table
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To add a funding source to the reference table:

1.
2.

N o g &

o

10.
11.

12.
13.
14.
15.
16.
17.

On the Reference Tables (CA) panel, double-click the Funding Source icon.
Click the New button.

In the Funding Source Code field, enter the source of funding (e.g., Federal grant, Federal
fuel tax, State general fund).

Press the Tab key.
In the Description field, enter a name or description of the funding source.
Press the Tab key.

If the funding includes federal aid money, click the Fed Aid Funding Indicator check box
(ON).

Press the Tab key.
Click the Accounting Fund Code field and type the code assigned to the fund.
Press the Tab key.

If the funding includes federal aid money, in the Participation Percent field, type the
percentage of this fund paid by federal aid.

Press the Tab key.
In the Fund Prefix field, type the fund prefix.
Press the Tab key.
In the Funding Group field, type the funding group.
Click the Save button.
To delete a funding source from the reference table:
a. On the Reference Tables (CA) panel, double-click the Funding Source icon.
b. Inthe Funding Source list box, scroll to and click the funding source.
c. Click the Delete button.
d. Click OK.

If the funding source is loaded from the pre-construction system, the data cannot be modified or
deleted in SiteManager.
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4.1.7 Item Master

The Item Master window lets you view the standard Item list. An interface load process adds the
items from the pre-construction system to this list. You cannot add, modify, or delete Item Master
data. The default sorting order of the list is by Item Code first, then Spec Year, and then Unit. You
can find, filter, and sort any column on the list. The selected item’s Historical Price is displayed only
if you have the authority to view this data. You can add a standard item to a contract by selecting the

item on the appropriate SiteManager window (e.g., the Items window).

18

Eitem Master || ][ LD N =T
Item Code Short Description
00010 33 TOTAL ESTIME
00015 1934 EQUIPMENT TOTAL ESTIME
00020 1934 MATERIALS TOTAL ESTIME
0003711570 1934 |\ DEMOBILIZATION & REMOEILIZATION EACH E
00038-16568 1934  |DEMOBILIZE-REMOEBILIZE (STOP WORK REG.) LUMP SUM  |E
00033-15564 1934 |ADDITIONAL MOBILIZATON LUMP SUM  |E
00100 1934 MOBILIZATION LUMP SUM  |E

Indi

Alternate ID: |00010 Spec Book Reference:

Description: |LABD R

r Material Item r Obsolete Item F Major Item r Suppl Desc Req'd

Item Historical Price: [$.00000

Fuel Adjust Type:

Figure 4-9. The Item Master Window

Field Name Description

Item Code Transportation agency-defined code that identifies an
Item.

Spec Year The year of the specification book in which the item
appears.

Unit The unit of measure for this item.

Unit Type Indicates that the measurement system used is English
(E) or Metric (M).

Short Short text description of the item.

Description

Alternate ID

Alternate ID of an item.

Spec Book
Reference

Identifies an item-specific section or paragraph from
the transportation agency’s spec book.

Description

Text description of an item. Two lines are provided.
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Field Name Description

Material Item | Indicates that materials are associated with the item.
Indicator

Obsolete Item | Indicates that this item is obsolete and no longer used.

Indicator

Major Item Indicates that an item is important enough to be

Indicator printed on the notice to iontractors, regardless of the
dollar amount allocated to it.

Require When checked, indicates that a supplemental

Supplemental | description must be entered for an item being added to
Description a project
Indicator

Fuel Adjust Fuel price adjustment type to use for this item.
Type

Item Historical price of an item.
Historical
Price

Table 4-9. ltem Master Window Fields Table
To view reference table item data:
1. On the Reference Tables (CA) panel, double-click the Item Master icon.

2. Inthe Item list box, scroll to and click the item or perform a Find. The window displays data
for the selected item.

4.1.8 Vendors

The Vendors window lets you add, modify, and delete vendors and related data in the reference
table. The vendors are the material suppliers, contractors, financial institutions, insurance companies,
consultants, and others who provide goods and services to the transportation agency. Typically, an
interface load process adds the vendors from the pre-construction system to SiteManager. You
cannot modify or delete Vendor data loaded from the pre-construction system. You can add Vendor
data to a contract by selecting it on the appropriate window (e.g., the Contract Prime Contractor
folder tab). The Vendors window contains the following folder tabs:

Tab Name Description

Description The Description folder tab displays the vendor description.
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Tab Name Description

The vendor addresses and remarks can be accessed from this
folder tab.

Work Classes | The Work Classes folder tab displays the vendor’s work
classes and the qualification amount for each type.

Affiliates The Affiliates folder tab displays the vendor’s affiliates (i.e.,
the other vendors affiliated with this vendor) and their
relationship. The affiliate addresses can also be accessed from
this folder tab.

Personnel The Personnel folder tab displays the vendor’s personnel. The
vendor personnel addresses can also be accessed from this
folder tab. If the vendor is a prime contractor, the personnel
entered here can be selected as prime contacts for specific
contracts on the Contract Prime Contractor folder tab.

Prime The Prime Contacts folder tab displays the vendor’s personnel

Contacts who have been selected as the prime contacts for specific
contracts.

Associates The Associates folder tab displays the vendor’s associates (i.e.,

the other vendors associated with this vendor) and the role of
the associate. If the vendor is a prime contractor, the vendor’s
insurance company and surety company must be entered here
before they can be selected for specific contracts on the prime
contractor folder tab.

Security The Security Accounts folder tab has a security accounts
Accounts section and a security transaction section. The security
accounts section displays the vendor’s security accounts; the
security transaction section displays a history of transactions
made against the selected account at the financial institution.

Securities On the Securities Usage folder tab, you can associate the
Usage vendor’s security accounts to specific contracts for use in lieu
of retainage. After a contract is selected, the current retainage
percentage and other contract amounts are calculated by the
system and displayed on this folder tab.

Table 4-10. Vendor Window Folder Tabs Table
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Vendor Description

The Vendor Description folder tab lets you add and modify the vendor descriptions and addresses.
You can view but not modify vendor data loaded from the pre-construction system. The vendor
remarks can also be accessed from this folder tab. The Ethnic Group and Gender fields are displayed
only if you are authorized to see this data. The ethnic group and gender data is required for federal

reports when the vendor is a DBE.

ﬂVenduls

e
Description ‘Work Classes Affiliates Personnel

Prime Associates Security Securities

Contacts Accounts Usa

=] B3

ge

Yendor ID: me

IRS Tax Nbl:l

Short Name: |

Full Name: |

Yendor Type: |

[x] Al Vendor ID: |

Uncompleted Work Amount: | 0.00

DBE Type: [Spaces =] Cert Type: [Spaces =l

Cert Date: [00/00/00 | Cert End Date: [00/00/00

Corp Type: [Spaces =] Corp State: [ =l
Prequal Date: lm Prequal End Date: Im

I~ Preconstruction Indicator

Ethnic Group: [Spaces

Gender: I—

Figure 4-10. Vendor Description Folder Tab

Field Name Description

Vendor ID Transportation agency-defined ID for the vendor.
Usually the company's Federal Tax ID.

IRS Tax Nbr Federal Employer tax ID number.

Short Name Short name for the vendor.

Full Name Full name of the vendor.

Vendor Type Identifies which type of company the vendor is (e.g.,
Prime, Subcontractor, Sub-Subcontractor). This is a
required field.

DBE Type Transportation-agency defined code to indicate that
the vendor has certification as a Disadvantaged
Business Enterprise (DBE). Examples are DBE,
MBE, and WBE. ‘Not a DBE’ is also a valid DBE
Type.
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Field Name Description

Corp Type Identifies the vendor’s company type (e.g., private
corporation, public corporation, partnership).

Corp State Identifies the vendor’s state or province of
incorporation.

Cert Type Code indicating whether the DBE is certified by the
federal government, state/provincial government, or
both. If the vendor is a DBE, this field is required.

Cert Date For DBEs, the DBE certification date. If the vendor

is a DBE, this field is required.

Cert End Date

The date on which the vendor’s DBE certification
expires.

Prequal Date

For transportation agencies that pre-qualify
contractors, the date on which the vendor was pre-
qualified.

Prequal End Date

The date on which the vendor‘s pre-qualification
expires.

Uncompleted Work
Amount

Displays the uncompleted work amount for this
vendor. The uncompleted work amount is the sum of
the vendor’s current prime contractor and
subcontract amounts minus the vendor’s installed-to-
date amounts.

Preconstruction Ind

Indicates whether or not the data is from a pre-
construction system.

Ethnic Group

Transportation agency-defined code identifying the
vendor’s certified ethnic background (e.g., Black
American, Hispanic American, Native American).
The Ethnic Group field is only displayed if you is
authorized to see this data.

Gender

Indicates the vendor’s certified gender (i.e., Male or
Female). The Gender field is only displayed if the
user is authorized to see this data.

Table 4-11. Vendor Description Folder Tab Fields Table
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To view a vendor description:

1.

o o ~ w

~

10.
11.
12.
13.
14.
15.
16.
17.
18.

19.

20.
21.
22.
23.

On the Reference Tables (CA) panel, double-click the Vendors icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected vendor.
To access the vendor’s address, click the Services menu and click the Address choice.

In the Address Type list box, scroll to and click the address type. If the address type has
multiple addresses, use the Prior and Next toolbar buttons to access all addresses.

To add a new vendor:

On the Reference Tables (CA) panel, double-click the VVendor icon.
Click the New button.

In the Vendor ID field, type the vendor’s ID.

Press the Tab key.

In the IRS Tax Nbr field, type the IRS tax number.

Press the Tab key.

In the Short Name field, type the short name of the vendor.

Press the Tab key.

In the Full Name field, type the full name of the vendor.

In the Vendor Type drop-down list, click the expand arrow and click the vendor type.

If the vendor is a DBE, in the DBE Type drop-down list, click the expand arrow and click
the DBE type.

If the vendor is a DBE, in the Cert Type drop-down list, click the expand arrow and click the
certification type.

Press the Tab key.
If the vendor is a DBE, in the Cert Date field, type the DBE certification date.
Press the Tab key.

If the vendor is a DBE, in the Cert End Date field, type the DBE certification expiration
date.
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24. In the Corp Type drop-down list, click the expand arrow and click the vendor’s corporation
type.

25. In the Corp State drop-down list, click the expand arrow and click the vendor’s state or
province of incorporation.

26. Press the Tab key.
27. In the Prequal Date field, type the date on which the vendor was pre-qualified.
28. Press the Tab key.

29. In the Prequal End Date field, type the date on which the vendor’s pre-qualified status
expires.

30. In the Ethnic Group drop-down list, click the expand arrow and click the vendor’s ethnic
group.

31. In the Gender drop-down list, click the expand arrow and click the vendor’s gender.
32. To enter the vendor’s address, click the Services menu and click the Address choice.
33. In the Address Type list box, scroll to and click the address type.

34. Type the Line 1 address information. If necessary, tab to and type Line 2 and Line 3 address
information.

35. Press the Tab key.
36. In the City field, type the vendor’s city location.

37. In the State/Prov drop-down list, click the expand arrow and click the vendor’s state or
province.

38. Press the Tab key.
39. In the Zip/Postal field, type the vendor’s zip code or other postal code.

40. In the Country drop-down list, click the expand arrow and click the vendor’s country
location.

41. Press the Tab key.

42. Type the vendor’s primary phone number. If necessary, tab to the ext field and type the
phone number extension.

43. Press the Tab key.
44. In the FAX field, type the Vendor’s FAX number.
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45. To add another address of the same type, click the New button and repeat steps 27 through
37.

Or
46. To add another address type, repeat steps 26 through 37.
47. To close the Address box, click the Description folder tab.
48. To save the new vendor description, click the Save button.

To be selected as a prime contractor, a vendor must have a payment address.

Address Function

In SiteManager, you can enter many types of addresses depending on the functional area. For
example, a vendor can have shipping address, billing address, a field address, etc. A common
interface has been developed to provide the same address functionality across the system.

The Address functionality has been implemented in two ways:

1. Access to the address through Address option under Services menu or an Address button on
the main toolbar. Clicking the Address button or selecting Services/Address causes a pop-up
address window to appear.

2. The address information appears directly on the currently-selected window. This occurs
when the window has enough space to accommodate the address. The Address window in
Administrative Offices is an example of this type.

If a window does not allow address entry through the pop-up window, the Services/Address menu
option and the Address button will not be available. In some cases, the Address button may appear
in the toolbar, but it does not function. It beeps. The Services/Address menu option will appear
dimmed and will not function when address entry is not allowed.

When the address pops up, initially it displays the address for the first address type if the address
already exists. Payment Address is the default address type. If the vendor, trainee, etc. has
multiple address types, a list of available address types and an icon adjacent to each type indicating
an address exists for that type is displayed. If a new address is to be entered, the address entry area
is empty and you must click the new button.

The Address Pop-up

The Address pop-up window is divided in two parts. The first part, Types, displays a list of
available address types. If a check mark " appears next to the address type, an address for that type
has been entered. Whenever you select a type by clicking it, the corresponding address appears in
the Address part of the window and the cursor is placed there. Each address type can have multiple
addresses. For example, a vendor could have many Field Trailer type addresses. You can see that
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multiple addresses are listed because the Address part of the window shows how many pages
(addresses) are listed (i.e., 1 of 4). When the address pop-up appears, up and down arrows are
present on the toolbar. The arrows are used to move through the list of addresses for a type.

Create an Address one time - Associate it thereafter

A new address is created one time only. Thereafter, the address is associated with the window by
selecting it from the appropriate picklist. For example, a new vendor is created in the Contract
Admin. Reference tables, Vendor window. In the contracts, Prime Contractor tab, the Current
Prime, Prime Contracts, and Prime Associates fields are completed by searching, selecting and
associating the address to the field. The addresses for these fields are created in the Vendor window
tabs, not in the contracts window tabs.

An address is maintained, modified, or deleted in the window where the address was created. An
address may not be deleted if it is associated to any contract. Clicking the Delete button deletes the
address for the selected address type. The association of the address takes place in any window
where the address capability exists. As in the preceding example, the address is created, maintained
or deleted in the Vendor tabs, but is associated in the Contracts, Prime Contractor tab.

If an address pop-up window appears with the address fields dimmed, the address originated in a
pre-construction contract and cannot be modified or deleted.

An address may be maintained without ever being associated. For example, the address and
telephone numbers for an EEO officer may never be associated.

A new, modified or deleted address is saved on window where the address was opened. The address
is automatically saved when the origination window is saved. Save is performed on the window, not
on the address object.

The Address function is available or displayed in the following components of SiteManager:
= Contract Administration, Reference Tables, VVendors icon folder tabs:
= Description - Create, modify or delete
= Personnel -  Create, modify or delete
= Affiliates-  Display only
= Associates - Display only

o Affiliates and associates are vendors. Select the Vendors ID to add, modify or delete
an address for them.

= Prime Contact - Display only - associated in the Prime Contact tab

= Civil Rights, Contract Compliance, Trainees icon
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Materials Management, Approved Lists icon
= Inspectors

= Welders

= Producer/Supplier

= Qualified Labs

= Testing Personnel

The address function works consistently across the system. Although the following figures and
procedures relate specifically to Vendors, the methodology applies across the system.

El:onllaclx M =] B3
o e e e e e
Description Location Payment Data  Critical Dates Primary Prime DBE Commit — Training Plan
o, L Conteant

[|[Payment Address [ | | Address For: [GREENBANK SERVICES COMPANY, INC
BILLING ADDRESS E/i ~BILLING ADDRESS 1 -of-1
FIELD TRAILER ADDR Line 1: |45EI1 OAKLAWN BLVD.
PREQUALIFICATION A Line 2: | rs Paid
STREET ADDRESS DR ;I Line 3 I
City: |HDF'EWELL
State/Prov: I‘\IA ;|
Zip/Postal: IW
Pr Country: |United States of America e
~—Contact Numbers
Phone: IW Ext: I—

Figure 4-11. Address Pop-Up Window

Field Name Description

Types This is a list of available address types. You can select
only one type at a time.

Address This is the actual address for the selected type.
One field of Line 1, 2, or 3 is a required field.

City, State or Province and Zip/Postal are required fields.
Messages will appear to complete required fields on the
Address pop-up when you save the window.

Table 4-12. Vendor Description Folder Tab Fields Table
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To create an address for a new vendor:
1. On the main panel, double-click the Contract Administration icon.
On the Contract Administration icon, double-click the Reference Tables icon.
On the Reference Tables panel, double-click the VVendors icon.
Select the Description folder tab.
Click the New button.

In the Address Type list box, scroll to and click the address type.

N o oA woN

Type the Line 1 address information. If necessary, tab to and type Line 2 and Line 3 address
information.

®

Press the Tab key.
9. Inthe City field, type the vendor’s city location.

10. In the State/Prov drop-down list, click the expand arrow and click the vendor’s state or
province.

11. Press the Tab key.
12. In the Zip/Postal field, type the vendor’s zip code or other postal code.

13. In the Country drop-down list, click the expand arrow and click the vendor’s country
location.

14. Press the Tab key.

15. Type the vendor’s primary phone number. If necessary, tab to the ext field and type the
phone number extension.

16. Press the Tab key.

17. In the FAX field, type the vendor’s FAX number.

18. To add another address of the same type, click the New button and repeat Steps 6 through 17.
Or,

19. To add another address type, repeat Steps 6 through 17.

20. To close the Address box, click the Address button or just outside the Address pop-up.

21. To save the new vendor description and address, click the Save button.
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E\Fendms !E[ [ |
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Description “Work Classes Affiliates Personnel Prime Agsociates Security Securities
Contacts Accounts Usage

Vendor ID: IRS Tax Nbl:l—
Short Name: |
Full Name: |
Yendor Type: | |;| Alt Yendor ID: I—
DBE Type: [Spaces =l Cert Type: [Spaces =1
Cert Date: W Cert End Date: W
Corp Type: [Spaces =1 Corp State: | =]
Prequal Date: W Prequal End Date: W
u pleted Work A b I—UUD [T Preconstruction Indicator
Ethnic Group: |Spaces Gender: I—

Figure 0-12. Vendor Window and Folder Tabs

Addresses for vendors and personnel are created using the procedures for creating a new address in
the Description tab. Affiliates, Prime Contacts, and Associates folder tabs are display only.

The same procedures apply in Trainees and Materials Approved Lists.

To modify an address:

© © N o a ~ w R

i e e =
w N Pk O

Navigate to the window where the address was created.

Click the Open button and select a vendor from the picklist.
Click OK.

Click the Address button or the Services/Address choice.
Select the desired Address type.

Type the new information.

Click the Address button or click outside the pop-up to close it.
Save the window.

The same procedures apply in Trainees and Materials Approved Lists.

. To delete an address not associated to a contract
. Navigate to the window where the address was created.
. Click the Open button and select a vendor.

. Click OK.
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14. Click the Address button or the Services/Address choice.

15. Select the desired address type (use the up and down arrows on the toolbar to move through
multiple addresses for a type.)

16. Click the Delete button.

17. Click the Address button or click just outside the pop-up to close it.

18. Save the window.

19. The same procedures apply in Trainees and Materials Approved Lists.

20. To associate an address with a contract:

21. On the main panel, double-click the Contract Administration icon.

22. On the Contract Administration icon, double-click the Contract Records icon.
23. On the Contract Records panel, double-click the Contract icon.

24. On the Contracts window, select the Description folder tab.

25. On the Description folder tab, click the Open button and select the desired contract.
26. Double-click the highlighted contract or click OK.

27. Select the Prime Contractor folder tab.

28. Click on the Prime Contractor field to focus.

29. Associate a new vendor’s address by clicking the New button and selecting a vendor from
the picklist,

30. Or

31. Change the existing vendor by clicking the Open button and selecting a different vendor
from the picklist.

32. Click OK on the Vendor picklist.

33. On the Prime Contractor folder tab, click the Services menu and choose the Select Address
choice.

34. Click the Address button or click just outside the pop-up to close it.

35. Save the window.

The same procedures apply in Trainees and Materials Approved Lists.
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If an incorrect address is associated to a contract, the address is replaced with the correct address.
The incorrect address is not deleted, but is replaced using the procedures for associating an address
with a contract. SiteManager recognizes the most current association.

Vendor Work Classes

The Vendor Work Classes folder tab lets you add, modify, and delete the work class type and
qualification amount for the selected vendor. If the vendor was loaded from the pre-construction
system, you can view but not modify the data on this folder tab.

E\Fendors [_ (O] x|

Description Work Affiliates Personnel Frime Agsociates Security Securities
Classes Contacts Accounts Usage

Vendor 1D: IGD22 Short Name: [GREENBANEK SERVICES COMPANY, INCORPORATE

Workclass Type Qualification Amount
GENERAL HIGHwAY CONSTRUCTION [

oL .01

Figure 0-13 Vendor Work Classes Folder Tab

Field Name Description
Workclass Type Code that identifies the major type of work class for a
vendor (e.g., Roadway Construction, Bridge Construction,
Utilities).

Qualification Amt Amount specified for the major type of work for which
the vendor is qualified.

Table 0-13. Vendor Work Class Folder Tab Fields Table
To add a vendor work class to the reference table:
1. On the Reference Tables (CA) panel, double-click the VVendor icon.
2. Click the Open button.

3. On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
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Click the OK button. The Description folder tab displays data for the selected vendor.
On the Vendors window, click the Work Class folder tab.
Click the New button.

N o o &

In the Work Class Type drop-down list, click the expand arrow and click the vendor’s work
class type.

8. Press the Tab key.
9. Inthe Qualification Amt field, type the vendor’s qualification amount.

10. Click the Save button.

If the vendor is from a pre-construction system, both the Work Class Type and the Qualification
Amount fields are protected, and no work classes can be added.

Vendor Affiliates

The Vendor Affiliates folder tab lets you add, modify, and delete the affiliates for a selected vendor.
The affiliates are also vendors and must be entered in SiteManager as vendors before they can be
selected as affiliates. On the Vendor Affiliates folder tab, you specify the affiliate’s relationship to
the vendor. For example, a ‘joint venture’ contract must have a prime contractor with a ‘joint’
affiliate. If the vendor was loaded from the pre-construction system, you can view but not modify the
data on this folder tab.

E\Fendols | _[O] x|

e — —_—_—_——
Description  “Work Classes  Affiliates Personnel Prime: Associates Security Securities
Contacts Accounts Usage

¥endor ID: |DL333 Short Name: |LBX General Contractors

Affiliate Short Name Relationship Type Ownership % ﬂ
| = .00

Figure 0-14. Vendor Affiliates Folder Tab

32



Trnseport SiteManager®

4.1 Reference Tables (Contract Administration) 4. Contract Administration - Reference Tables

Field Name Description

Affiliate Short Name | Abbreviated name of the vendor. You can search
this field. This field is required.

Relationship Type Type of affiliate (e.g., parent, joint, partner). This
field is required.

Ownership % The vendor's percentage of ownership of the
affiliate. This field is required.

Table 0-14. Vendor Affiliates Folder Tab Fields Table

To add a new vendor affiliate to the reference table:

9.

N o oA wN

On the Reference Tables (CA) panel, double-click the Vendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected vendor.
On the Vendors window, click the Affiliates folder tab.

Click the New button.

In the Affiliate Short Name field, type the short name of the vendor’s affiliate or perform a
Search.

In the Relationship Type drop-down list, click the expand arrow and click the relationship of
the affiliate to the vendor.

Press the Tab key.

10. In the Ownership % field, type the vendor’s percentage of ownership of the affiliate.

11. Click the Save button.

If the vendor is from a pre-construction system, all the fields are protected and no affiliates can be

added.

Vendor Personnel

The Vendor Personnel folder tab lets you add and modify personnel records for the selected vendor.
You can also add and modify vendor addresses. This folder tab is primarily used to enter the contact
person and DBE-related personnel for the vendor, especially vendors who are prime contractors. The
folder tab displays the vendor personnel list and data for the person selected on the list. The Social
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Security Number (SSN) or Social Insurance Number (SIN), Ethnic Group, and Gender fields are
displayed only if you are authorized to see this data.

EVenduls [_ O] ]

Description Work Clazses Affiliates Personnel Prime Associates Security Securities
Contacts Accounts Usage

Vendor ID: |DL999 Short Name:  [LBX General Contractors

Person Name Dfficer Title

Chiristina Muorris PRESIDENT 000-00-0000

ot o

Person Name: |Ehristina Marris User |D:|
Officer Title: [FRESIDENT [=] SSN: po0-00-0000
Ethnic Group: ICaucasian |L| Gender: " +F

Figure 0-15. Vendor Personnel Folder Tab

Field Name Description

User ID Transportation agency-defined 1D for the user. You can
search this field.

Personnel Name The name of a person employed by the vendor. When a
valid User ID is entered, this field defaults to the name
associated with the User ID and cannot be modified. The
name must be unique for the vendor. This is a required
field.

Officer Title Transportation agency-defined code that identifies the title
of the vendor’s employee (e.g., Owner).

SSN/SIN Social Security Number or Social Insurance Number of the
vendor’s employee. This field is displayed only if you are
authorized to see this data.

Ethnic Group Transportation agency-defined code identifying an ethnic
background (e.g., Black American, Hispanic American,
Native American). This field is required when the vendor is
a DBE (i.e., a DBE Type is entered on the Vendor
Description folder tab). The Ethnic Group field is displayed
only if the user is authorized to see this data.

Gender Indicates the gender of the person employed by the vendor
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Field Name Description

(i.e., Male or Female). This field is required when the
vendor is a DBE (i.e., a DBE Type is entered on the
Vendor Description folder tab). The Gender field is
displayed only if the user is authorized to see this data.

Table 0-15. Vendor Personnel Folder Tab Fields Table

To add vendor personnel to the reference table:

1.
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14.

15.
16.
17.

18.
19.

On the Reference Tables (CA) panel, double-click the VVendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected vendor.
On the Vendors window, click the Personnel folder tab.

Click the Person Name field and type the person’s name.

In the Officer Title drop-down list, click the expand arrow and click the title.

Press the Tab key.

In the SSN field, type the person’s social security number.

. In the Ethnic Group drop-down list, click the expand arrow and click the ethnic group.
. To select a Gender, click the ‘M’ or ‘F’ radio button.
. To enter the vendor’s address, click the Services menu and click the Address choice.

. In the Address Type list box, scroll to and click the address type. If an address is displayed,

click the New button to add another address of the same type.

Type the Line 1 address information. If necessary, tab to and type Line 2 and Line 3 address
information.

Press the Tab key.
In the City field, type the person’s city location.

In the State/Prov drop-down list, click the expand arrow and click the person’s state or
province

Press the Tab key.

In the Zip/Postal field, type the person’s zip code or other postal code.
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20. In the Country drop-down list, click the expand arrow and click the person’s country
location.

21. Press the Tab key.

22. In the Phone field, type the person’s primary phone number. If necessary, tab to the ext field
and type the phone number extension.

23. Press the Tab key.

24. In the FAX field, type the person’s FAX number.

25. To close the Address box, click the Personnel folder tab.
26. To save the new personnel description, click the Save button.

To be selected as a contact person for a vendor who is a prime contractor, the person must have a
title and an address entered.

To delete vendor personnel from the reference table:
1. Onthe Reference Tables (CA) panel, double-click the VVendor icon.
Click the Open button.
On the Vendor Pick List window, scroll to and click the Vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected vendor.
On the Vendors window, click the Personnel folder tab.
In the Personnel list box, scroll to and click the person.
Click the Delete button.
Click OK.

© N o o &~ w DN

Vendor Prime Contacts

The Vendor Prime Contacts folder tab lets the user view the vendor’s personnel who have been
selected as prime contacts. A prime contact is a prime contractor’s contact person for a specific
contract. The Prime Contacts folder tab displays the name and contact type of the person and the
Contract ID for which the person is a contact. The user cannot add, modify, or delete a prime contact
on this folder tab. To add a prime contact, the user must first enter the name as personnel on the
Vendor Personnel folder tab. Then the user can select the name as a prime contact for a specific
contract. This is done on the Contract Prime Contractor folder tab.
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ﬂ Yendors !El [ x|

e e e e e
Description  “Work Classes Alffiliates Personnel Prime Associates Security Securities
Contacts Accounts Uszage

Vendor ID: [S018 Short Name:  [SHIRLEY CONTRACTING CORP.

User ID

Contact Name

Kirk. Clark.

Figure 0-16. Vendor Prime Contacts Folder Tab

Field Name Description
Contact Name Name of the person who is a contact for this vendor.
Contact Type Title of the person who is a contact for this vendor
(e.g., EEO).
Contract ID Transportation agency-defined 1D of the contract for

which this person is a contact.

User ID Transportation agency-defined ID of the user who is a
contact for this vendor.

Table 0-16. Vendor Prime Contact Folder Tab Fields Table
To view a vendor’s prime contacts:
1. On the Reference Tables (CA) panel, double-click the VVendor icon.
Click the Open button.
On the Vendor Pick List window, scroll to and click the vendor or perform a Find.

Click the OK button. The Description folder tab displays data for the selected vendor.

o & DN

On the Vendors window, click the Prime Contacts folder tab.

If prime contacts have been recorded for the selected vendor, the window displays the prime contact
data.
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The user cannot add, modify, or delete a prime contact on this folder tab.

Vendor Associates

The Vendor Associates folder tab lets the user add, modify, and delete the associates in the reference
table. The associates are also vendors and must be entered in SiteManager as vendors before they
can be selected as associates. On the Vendor Associates folder tab, select the type of association the
associate has with the vendor.

To be selected as a prime contractor, a vendor must have at least two associates—an insurance
company and a surety company.

E\Fendors !E[ [ x|

Description Work Clazses Affiliates Personnel Prime Associates Security Securities
Contacts Accounts Usage

Vendor ID: p125 Short Name: [I & K. CONSTRUCTION

Associate Short Name Associate Type AI

o .0

Figure 0-17. Vendor Associates Folder Tab

Field Name Description
Associate Short Short name for an associate of the vendor. The user
Name can search this field. This field is required.
Associate Type Type of Vendor Associate (e.g., Surety, Escrow).
This field is required.

Table 0-17. Vendor Associates Folder Tab Fields Table
To add a vendor associate to the reference table:
1. On the Reference Tables (CA) panel, double-click the VVendor icon.
2. Click the Open button.

3. On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
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10.
11.
12.
13.
14.
15.
16.
17.
18.

Click the OK button. The Description folder tab displays data for the selected vendor.
On the Vendors window, click the Associates folder tab.
Click the New button.

Click the Associate Short Name field and type the name of the associate or perform a
Search.

In the Associate Type drop-down list, click the expand arrow and click the type of associate.
To save the new associate description, click the Save button.

To delete a vendor associate from the reference table:

On the Reference Tables (CA) panel, double-click the VVendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected vendor.
On the Vendors window, click the Associates folder tab.

In the Associate Short Name list box, scroll to and click the vendor.

Click the Delete button.

Click OK.

Vendor Security Accounts

The Vendor Security Accounts folder tab lets the user add, modify, and delete the vendor’s security
accounts and account transactions. The folder tab has a security account list at the top and a
transaction section at the bottom. The transaction section lists the transactions made against the
selected account at the financial institution. The transactions are the amounts deposited and
withdrawn, which are recorded as credits and debits to the account.

The usage of the securities on contracts is shown on the Securities Usage folder tab.
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ﬂ\l’enduls (O] x|
Description  Work Classes Affiliates Personnel Prime Associates Security Securities
Contacts Accounts Usage
Vendor ID: p125 Short Name: [I & K CONSTRUCTION

Account ID Description Current Retainage Amount =~
Balance Required Available
SUNTRUST

Transaction

Type Sec Type Certificate ID Amount Post Date  |Maturity Dt Comments ﬂ
Credit Bl Bond Sl F9432-RT-4290 $10,000.001993/04/27 1209  04/27119

Figure 0-18. Vendor Security Accounts Folder Tab

Field Name Description
Account ID Transportation agency-defined 1D for a security account
for the vendor.
Description Description of a security account for the vendor.
Current Balance Current value of a security account for the vendor. The

current balance is the sum of all credits to the account
minus the sum of all debits to the account. This value is
calculated by the system. The system will not accept
account transactions that make the current balance
negative.

Retainage Required | The amount required to be encumbered for all the
contracts associated to this account. The required amount
is the sum of all estimate retainage amounts and
securities used amounts for all contracts associated with
this account. This value is calculated by the system.

Amount Available Amount of the current balance that can be encumbered.
The amount available is the difference between the
current balance of the account and the total amount
encumbered for all contracts associated to the account.
This value is calculated by the system. The system will
not accept account transactions that make the amount
available negative.
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Field Name Description

Transaction Type Type of transaction (D = Debit or C = Credit).

Transaction Sec Type of security (e.g., Bond, Certificate of Deposit).
Type
Transaction Certificate of Deposit ID number.

Certificate ID

Transaction Amount | Amount of the transaction. Only positive values are
accepted in this field. (If the amount is a withdrawal,
enter ‘D’ for debit as the Transaction Type.) A value that
makes the account negative cannot be entered.

Transaction Post System-generated date when the transaction is entered
Date into the system.
Transaction Date on which the security matures.

Maturity Date

Transaction Description of the transaction.
Comments

Table 0-18. Security Account Folder Tab Fields Table

To add a security account:

1. Onthe Reference Tables (CA) panel, double-click the Vendor icon.
Click the Open button.
On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected vendor.
On the Vendors window, click the Security Account folder tab.
In the Account ID field, type the security account ID.
Press the Tab key.

In the Description field, type the name of the account.

© o N o g ~ w N

Click the Save button.

The system updates the current balance of the account when the user records transactions. The
system calculates the retainage required and the amount available when the user associates contracts
with the account and securities are encumbered in lieu of retainage.
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To delete a security account:

1.
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On the Reference Tables (CA) panel, double-click the VVendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected vendor.
On the Vendors window, click the Security Account folder tab.

In the Account ID list box, scroll to and click the account.

Click the Delete button.

Click OK.

If a security account is associated with a contract, the account cannot be deleted. When an account is
deleted, the account transactions are also deleted.

To add a security transaction:

42

1.
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11.
12.
13.
14.

On the Reference Tables (CA) panel, double-click the Vendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected vendor.
On the Vendors window, click the Security Account folder tab.

In the Account ID list box, scroll to and click the account description.

Click the Transaction datawindow.

Click the New button.

In the Type drop-down list, click the expand arrow and click the transaction type (‘D’ for
debit or ‘C’ for credit).

. In the Sec Type list box, click the expand arrow and click the security type.

Press the Tab key.
In the Certificate 1D field, type the ID number.
Press the Tab key.

In the Amount field, type the amount of the transaction.
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15. Press the Tab key. The current date is displayed in the Post Date field.
16. In the Maturity Date field, type the date on which the security matures.
17. Press the Tab key.

18. In the Comments field, type additional information about the transaction.

19. Click the Save button. The current balance is updated.

The user cannot add or delete an account transaction that would cause the current balance or the
amount available to become negative.

Vendor Securities Usage

The Vendor Securities Usage folder tab lets the user associate security accounts with contracts, and
displays the securities used in lieu of retainage. A security account can be associated to one or more
contracts, or not associated with any contract. The folder tab lists the accounts at the top and displays

contract data at the bottom. In the Contracts section, the user can select contracts to associate with an
account.

The security accounts are entered on the Security Accounts folder tab.

E\I’endors [_ [T}
Description  “Work Classes Affiliates Personnel Frime Associates Security Securities
Contacts Accounts Usage
VYendor ID: p125 Short Name: p &K CONSTRUCTION

Account ID

Description

Current Hetainage Amount
Balance Required Available
4005-23-41 SUNTRUST 10000 0 10000

K1 ;I_I
Contract ID - RETAIN PCT: [250
Sl ~ | Contract A t Securities/Retainage Amounts

Original: I 41,717.8316.40 Required: I
Installed: | Covered: |
Paid: | Difference: | .00

Figure 0-19. Vendor Securities Usage Folder Tab

Field Name Description

Account ID Transportation agency-defined ID for a security account
for a vendor.

Description Description of the security account.
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Field Name Description

Current Balance Current value of the account. The current balance is the
sum of all the credits to the account minus the sum of all
debits to the account.

Retainage Required | The amount required to be encumbered for all the
contracts associated to this account. The required amount
is the sum of all estimates’ retainage amounts and
securities used amounts for all contracts associated with
this account.

Amount Available | Amount available that can be encumbered. The amount
available is the difference between the current balance of
the account and the total amount encumbered from the
amount for all the contracts associated to the account.

Contract ID Transportation agency-defined 1D for the contract.

Retain Pct Percentage retainage for the contract.

Contract Original Displays the bid amount of the contract. The contract bid
Amount amount is the sum of the contract item amounts (item
quantity * item price).

Contract Installed | Displays the total installed amount for the contract. The

Amount installed amount is the sum of the installed-to-date
amounts from the Daily Work Reports (quantity * item
price).

Contract Paid Displays the total paid amount for the contract. The

Amount contract paid amount is the sum of the estimate net pay
totals.

Covered Amount Displays the total amount covered by the securities for
this contract. The covered amount is the sum of all
estimates’ securities used amounts.

Required Amount Displays the required retainage withholding from this
account for this contract. The required amount is the sum
of all estimates’ retainage amounts and securities used
amounts.

Difference Amount | Displays the difference between the covered amount and
the required amount.

Table 0-19. Vendor Securities Usage Folder Tab Fields Table
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To associate a contract to a security account:

1.
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On the Reference Tables (CA) panel, double-click the VVendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected VVendor.
On the Vendors window, click the Securities Usage folder tab.

In the Account ID list box, scroll to and click the account description.

Click the New button.

In the Contract ID drop-down list, click the expand arrow and click the contract.

Click the Save button.

The drop-down list displays the contract IDs for which the vendor is the prime contractor. After a
contract ID is selected, the window displays data for the selected contract.

To disassociate a contract from a security account:

1.
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On the Reference Tables (CA) panel, double-click the VVendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected vendor.
On the Vendors window, click the Securities Usage folder tab.

In the Account ID list box, scroll to and click the account description.

In the Contract ID drop-down list, click the expand arrow and click the contract ID.
Click the Delete button.

Click OK.

4.1.9 Administrative Offices

The Administrative Office window lets the user add, modify, and delete the offices in the reference
table. Every state or province must have at least three levels of administrative offices—the
transportation agency headquarters and two lower levels. No state or province can have fewer than
three or more than four levels. States or provinces with three levels will display three office
datawindows. States or provinces with four levels will display four office datawindows. The office
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level field labels are stored in a system operational parameter table. Since the transportation agency
defines the labels, this manual does not specify the actual labels that appear on the window.

The office datawindows display top to bottom on the left side of the window. The selected
(highlighted or focused) office’s address will display on the window’s right side. Upon entry into
this window, the first row in the level two office datawindow will be highlighted, and the address
information pertaining to that office will appear on the datawindow on the right side.

To view the information for a different Level 2 office or a specific Level 3 or 4 office, the user must
select the desired row in the proper office datawindow. Third-level offices are subordinate to the
highlighted second-level office. Fourth-level offices are subordinate to the third-level offices.

The current selected office is listed at the top of the datawindow on the right side (above the address
information).

EAdministrative Dffices

I Central: |
Division | Engineer | Division: 01
~Address -1 —of -1
02 DCE2 Line1: 78 LonaDiive
L DCET Line 2: |
2 1o LI Line 3: |
District | Engineer | « City: [Calumbia
State/Prov: |South Carolina =
2 DCE] ZipfPostal: 3170 |
03 DTE1 - :
04 DTE1 Ll Country: ‘| United States of America B
A Enai —Contact Numbers
rea ngineer - _
Phone: l— Ext: l_
2 ToMz A [
3 [DTET
4 I COM1 ﬂ

Figure 0-20. Administrative Offices Window

Field Name Description
Level 1 Office The name of the Level 1 office. The Level 1 office is the
_ transportation agency headquarters (i.e., the Central Office
(user-defined or Department of Transportation).
label)
Level 2 Office The office number or transportation agency-defined ID of
) the Level 2 office. The Level 2 office can have any user-
I(u;elr)-deflned defined label, such as District, Division, Region, or Section.
abe
Level 2 Office User ID of the Level 2 office’s chief engineer. You can
Engineer search this field. The title of engineer is unrelated to the
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Field Name Description

transportation agency’s actual title used.

Level 3 Office The office number or transportation agency-defined ID of
_ the Level 3 office. The Level 3 office can have any user-
I(u;elr)-deflned defined label, such as District, Division, Region, or Section.
abe
Level 3 Office User ID of the Level 3 office’s chief engineer. You can
Engineer search this field. The title of engineer is unrelated to the
transportation agency’s actual title used.
Level 4 Office The office number or transportation agency-defined ID of
_ the Level 4 office. The Level 4 office can have any user-
(user-defined defined label, such as District, Division, Region, or Section.
label) If a state a province has only three office levels this list and
its columns will not display.
Level 4 Office User ID of the Level 4 office’s chief engineer. You can
Engineer search this field. The title of engineer is unrelated to the

transportation agency’s actual title used.

Address Line 1 First address line that identifies the office location.

Address Line 2 Second address line that identifies the office location.

Address Line 3 Third address line that identifies the office location.

City City location of the office.

Zip/Postal Postal code for the office.

State/Prov Two-character abbreviation for the state/province.

Country Four-character code identifying the country.

Phone Primary telephone number for the office.

Ext Extension number of the primary telephone number for the
office.

FAX Primary fax number for the office.

Table 0-20. Administrative Office Window Fields Table
To add the Level 1 office:

1. On the Reference Tables (CA) panel, double-click the Administrative Offices icon.
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2. Click the Level 1 office field. (The Level 1 office is displayed in the top left corner. The
window will not have a label that says ‘Level 1. The office level labels are user-defined.)

Click the New button.

Type the ID of the Level 1 office.

Press the Tab key.

In the Line 1 field, type the first line of the office address.

If necessary, tab to Line 2 and Line 3 and type additional address lines.

Press the Tab key.

© © N o g &~ W

In the City field, type the city name.

10. In the State/Prov drop-down list, click the expand arrow to the right of the current selection
and click the state or province.

11. Press the Tab key.
12. In the Zip/Postal field, type the ZIP code or other postal number.

13. In the Country drop-down list, click the expand arrow to the right of the current selection
and click the country.

14. Press the Tab key.

15. In the Phone field, type the office’s primary phone number.

16. Press the Tab key.

17. In the Ext field, type the phone number extension.

18. In the FAX field, type the office’s primary fax number.

19. To save the office description, click the Save button.

20. To add a new Level 2 office:

21. On the Reference Tables (CA) panel, double-click the Administrative Offices icon.

22. Click the Level 2 office datawindow. (The Level 2 office IDs are displayed directly under the
Level 1 office ID. The window will not have a label that says ‘Level 2.” The office level
names are user-defined.)

23. Click the New button. A new row is added to the end of the list.
24. Type the office ID of the new office.
25. Press the Tab key.
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26.

27.
28.
29.
30.
31.
32.

33.
34.
35.

36.
37.
38.
39.
40.
41.
42.
43.
44,

45.

In the Engineer User ID field, type the User ID of the office’s Chief Engineer or perform a
Search.

Press the Tab key.

In the Line 1 field, type the first line of the office address.

If necessary, tab to Line 2 and Line 3 and type additional address lines.
Press the Tab key.

In the City field, type the city name.

In the State/Prov drop-down list, click the expand arrow to the right of the current selection
and click the state or province.

Press the Tab key.
In the Zip/Postal field, type the ZIP code or other postal number.

In the Country drop-down list, click the expand arrow to the right of the current selection
and click the country.

Press the Tab key.

In the Phone field, type the office’s primary phone number.

Press the Tab key.

In the Ext field, type the phone number extension.

In the FAX field, type the office’s primary fax number.

To save the office description, click the Save button.

To delete a Level 2 office:

On the Reference Tables (CA) panel, double-click the Administrative Offices icon.

In the Level 2 office datawindow, scroll to and click the office ID. (The Level 2 offices are
displayed directly under the Level 1 office ID. The window will not have a label that says
‘Level 2.” The office level names are user-defined.)

Click the Delete button.

For more information on making individual users available as engineers for administrative offices,
please refer to the section on User Security.
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4.2 System Operational Parameters for Contracts

The following are the default settings of the system operational parameters related to contract
administration. The system operational parameters are defined by the transportation agency. For
information on how your SiteManager installation varies from these defaults, contact your local
support personnel.

Default Description

Number of Office The number of administrative office levels, including the
Levels central office, for the state/province. The state must have
a label identifying each level as division, section, region,
district, area, etc. Every state/province must have at least
two levels below central office. No state/province can
have more than three levels below central office. The
range is 3 to 4. The default is 3.

Level 1 Office Long | Label to identify the first level office. Examples are
Division, Section, Region, District, Area. The default is
Central.

Level 2 Office Long | Label to identify the second level office. Examples are
Division, Section, Region, District, Area. The default is
District.

Level 3 Office Long | Label to identify the third level office. Examples are
Division, Section, Region, District, Area. The default is
Residency.

Level 4 Office Long | Label to identify the fourth-level office. Examples are
Division, Section, Region, District, Area. The default is

Area.
Level 1 Office Label to identify the first-level office. Examples are
Short Division, Section, Region, District, Area. The default is
Cent.
Level 2 Office Label to identify the second-level office. Examples are
Short Division, Section, Region, District, Area. Default is Dist.
Level 3 Office Label to identify the third-level office. Examples are
Short Division, Section, Region, District, Area. The default is
Resi.
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Default Description
Level 4 Office Label to identify the fourth-level office. Examples are
Short Division, Section, Region, District, Area. The default is
Area.

Level 2 Office Left | The beginning (leftmost) position of the state's/province's
second level of administrative office in the five-character
Trnseport™ office number format. The first level is
central or department. The second level could be division,
region, district, etc. The third level could be district, area,
residency, etc. Valid values are 1 through 5. The default is

0.
Level 2 Office The ending (rightmost) position of the state's/province’s
Right second level of administrative office in the five-character

Trnseport office number format. The first level is central
or department. The second level could be division, region,
district, etc. The third level could be district, area,
residency, etc. Valid values are 1 through 5. This position
must be equal to or greater than the beginning (left-most)
position. The default is 0.

Level 3 Office Left | The beginning (leftmost) position of the state's/province's
third level of administrative office in the five-character
Trnseport office number format. The first level is central
or department. The second level could be division, region,
district, etc. The third level could be district, area,
residency, etc. Valid values are 1 through 5. The default is

0.
Level 3 Office The ending (rightmost) position of the state's/province's
Right third level of administrative office in the five-character

Trnseport office number format. The first level is central
or department. The second level could be division, region,
district, etc. The third level could be district, area,
residency, etc. Valid values are 1 through 5. This position
must be equal to or greater than the beginning (left-most)
position. The default is 0.
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Default Description

Level 4 Office Left | The beginning (leftmost) position of the state's/province’s
fourth level of administrative office in the five-character
Trnseport office number format. The first level is central
or department. The second level could be division, region,
district, etc. The third level could be district, area,
residency, etc. Valid values are 1 through 5. The default is

0.
Level 4 Office The ending (rightmost) position of the state's/province’s
Right fourth level of administrative office in the five-character

Trnseport office number format. The first level is central
or department. The second level could be division, region,
district, etc. The third level could be district, area,
residency, etc. Valid values are 1 through 5. This position
must be equal to or greater than the beginning (leftmost)
position. The default is 0.

Maximum Allowed | The default value for the maximum percentage of the total
Subcontractor % contract amount the prime contractor is allowed to
subcontract (excluding specialty items).

Progress Schedule | The default percentage difference between a contract’s
Variance scheduled completion date and the actual completion date,
which will generate a warning message when exceeded.
The default percentage is 0. The user can override the
default while setting up a contract.

Default Funding The user-designated code that identifies the default
Source Code contract funding source. The code appears in the Funding
Source Code field on the Contract Funding window. The
user can override the default while setting up a contract.

Table 0-21. System Operational Parameters Fields Table

4.3 Tab-Level Security for Contracts

SiteManager provides the system administrator with the ability to establish security level access for
each Contract tab for each SiteManager user group.

For example, a user group that monitors on-the-job training commitments may require Update access
to the Training Plan tab, whereas a different user group might be assigned No Rights to this
information.
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These security levels are set on the Group Security window. Each tab name will appear on the
window, and access for each tab may be set to Update, Inquiry, or No Rights.
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5.1 Adding New Contracts

SiteManager gives the user the option of adding new contracts either by loading the data from a
preconstruction system or by entering the data into SiteManager one field at a time. The agency
specifies which method to use and should provide the user with instructions for any preconstruction
system used in conjunction with SiteManager.

The procedures given here describe how to add contract data to the SiteManager database through
SiteManager’s windows and data entry fields. An authorized user can add a new contract using
these data entry procedures. New contract from the preconstruction system may also need some data
added or modified by an authorized user.

New contract are given pending status by default. While a contract is in pending status, an
authorized user can modify the contract data and even delete the contract, if necessary. To begin
tracking the construction work in SiteManager, an authorized user must change the contract’s status
to active. Whenever a contract’s status is changed, the system notifies selected personnel.

To add a new contract, the user must have a Level 1 or Level 2 office assignment, Contract Record
window update rights, and belong to a group with office-wide access. For more information, refer to
the Security Administration topic.

5.1.1 From Preconstruction Systems

Trnseport® is one of the preconstruction systems that can be used to add a new contract to the
SiteManager system. In addition to Trnseport, there are several other preconstruction systems that
can be used to add a new contract to the SiteManager system. For information on the
preconstruction system that your agency uses, refer to the documentation provided by your local
support personnel.

Contract data can be loaded into SiteManager using the Preconstruction Contract data load process
(PRELOAD) or the Construction Contract data load process (CONLOAD). When contract data is
loaded into SiteManager from a preconstruction system, the SiteManager system verifies that
required data is present and acceptable. If a contract fails the verification process, SiteManager
generates error messages and displays them on the Interface Load Messages window. Some
SiteManager windows have a check box that indicates whether a preconstruction system was used to
add the selected contract. After the contract status is changed to active, the data loaded from the
preconstruction system cannot be modified.

5.1.2 Entry Directly Into SiteManager

An authorized user can add contract data to the SiteManager database through SiteManager’s
windows and data entry fields. For field definitions and detailed data entry procedures, the user can
refer to the appropriate topic. The field definitions include information about data that is subject to
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limitations or validation by the system. The agency should provide the user with any agency-defined
procedures for entering new contract data.

5.1.3 General Procedure for Adding New Contracts

To add a new contract to the SiteManager system, without using a preconstruction system, an
authorized user can follow the general procedure below. For field definitions and detailed data entry
procedures, refer to the appropriate topic.

Step 1: Saving a New Contract

Enter the data required to save the contract as follows:

1.

On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens and displays the Description folder tab.

Enter contract description data on this folder tab.

Click the Location folder tab. Enter location data on this folder tab.

Click the Primary Personnel folder tab. Enter the Project Manager and Project Engineer on
this folder tab.

Click the Prime Contractor folder tab. Enter the Prime Contractor and associated data on
this folder tab.

The following data must be entered before the contract can be saved:

Contract 1D

Level 2 Office (the field label is user-defined)
Federal/State/Province Project Number

Funding Indicator

Time Charges

Bid Days (if time is charged as Calendar Days or Work Days)
Description

Contract Type

Work Type

Spec Year

Unit System (English or metric)
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Location

Project Manager

Project Engineer
=  Prime Contractor

At this point, if data is entered in all required fields, click the Save button. After the contract
is saved, proceed to Step 2.

Step 2: Adding Contract Data

To finish defining the contract:

1.

Click the Payment Data folder tab. Enter contract payment data on this folder tab and save
the data.

Click the Critical Dates folder tab. Enter contract critical date data on this folder tab and
save the data.

Note: Contract activation is no longer tied to the Notice to Proceed date. The user can
now activate a contract using the Contract Status field on the Description tab. All
functions, except for the Estimate functions, are available to the user after the contract
status is changed to Active. Estimate functions are not available to the user until the
Notice To Proceed date is entered.

Click the DBE Commit folder tab. Enter DBE commitment data on this folder tab and save
the data.

Click the Training Plan folder tab. Enter training plan data on this folder tab and save the
data.

Close the Contracts window.

To add milestones, double-click the Milestones icon on the Contract Records panel. The
Milestones window opens. Enter contract milestone data and save the data. Close the
Milestones window.

To add project data, double-click the Projects icon on the Contract Records panel. The
Projects window opens. Enter Contract Project data and save the data. Close the Projects
window.

To group items under a funding category, double-click the Categories icon on the Contract
Records panel. The Categories window opens. Enter category data and save the data. Close
the Categories window.

On the Contract Records panel, double-click the Items icon. The Items window opens.
Enter items data and save the data. Close the Items window.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

On the Contract Records panel, double-click the Contract Funding icon. The Contract
Funding window opens. Enter funding source data and save the data. Close the Contract
Funding window.

On the Contract Records panel, double-click the Contract Authority icon. The Contract
Authority window opens. Enter contract authority data and save the data. Close the Contract
Authority window.

On the Contract Records panel, double-click the Key Dates icon. The Key Dates window
opens. Enter key date data and save the data. Close the Key Dates window.

On the Contract Records panel, double-click the Checklist Scheduled Events icon. The
Checklist Scheduled Events window opens. Enter checklist event data and save the data.
Close the Checklist Scheduled Events window.

On the Contract Records panel, double-click the Permits icon. The Permits window opens.
Enter permit data and save the data. Close the Permits window.

To enter invoice data for stockpiled materials, double-click the Stockpiled Materials icon on
the Contract Records panel. The Stockpiled Materials window opens. Enter stockpiled
materials data and save the data. Close the Stockpiled Materials window.

To record construction conferences, double-click the Construction Conference icon on the
Contractor Management panel. The Construction Conference window opens. Enter
construction conference data and save the data. Close the Construction Conference window.

To enter progress schedule data, on the Contractor Management panel, double-click the
Progress Schedule icon. The Progress Schedule window opens. Enter progress schedule
data and save the data. Close the Progress Schedule window.

To enter Subcontract data, on the Contractor Management panel, double-click the
Subcontracts icon. The Subcontracts window opens. Enter subcontract data and save the
data. Close the Subcontracts window.

Step 3: Activating a Contract

Contract work cannot be recorded in SiteManager until the contract status is changed from pending
to active. After all required contract data is entered, an authorized user can change the status to

active.

The following data is required for activation:
A wage decision selected on the Description folder tab.
A primary county selected on the Location folder tab.

A surety company and an insurance company entered as associates on the Prime Contractor
folder tab. If the selected contractor has no associates, enter these companies first as
associates of the contractor in the Vendor reference tables.
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Actual dates for all dates marked Required to Activate on the Key Dates and Checklist Event
Dates windows.

At least one project defined on the Projects window.
At least one item defined on the Items window.
Funding sources selected on the Contract Funding window to fully fund the contract.

Actual dates for all dates marked Required to Activate on the Critical Dates folder tab.

The user must change the contract status to Active using the Contract Status field on the Description
tab. All functions, except for the Estimate functions, are available to the user after the contract status
is changed to Active. Estimate functions are not available to the user until the Notice To Proceed
date is entered.

5.2 Contract Status Validation

SiteManager looks at the data entered for a contract to determine the contract’s status. When the
user saves a contract, the save process determines if the contract status has been changed. If it has,
the system validates the status and performs related tasks as described below. The following
contract states are possible:

Pending
Active
Complete

Archived

To change the contract’s status from pending to active, the following criteria must be met:

There must be an Execution Contract Critical Date with the Actual Date filled in.

If the contract’s price adjustment allowed indicator is Yes, the Price Adjustment Base
Contract Critical Date must have an Actual Date.

The Prime Contractor must have a surety and an insurance company.
The contract must have entries in all of the following fields:

Wage Decision

Primary County

Project Manager
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Project Engineer

Prime Contractor

Liquidated Damages Rate Amount

The contract must have at least one record for each of the following:
Project

Item

Retainage

Contract Funding (all parts fully funded)

Contract Authority for the Project Manager and Project Engineer

Note: For agencies that do not include Contract Funding in their construction
management system, a dummy Contract Funding record is added with 100 percent non-
participating no-limit funding. Funding source validation is bypassed.

When the contract’s status changes to active, the system performs the following tasks:

Personnel identified in the Primary Personnel folder are notified by an In-Box message.
All contract item status are modified from pending to active.

If a Contract Liguidated Damages Amount does not exist, this amount is obtained and
displayed from the default Liquidated Damages table.

If no project is indicated as the primary project, the Primary Project is defaulted as:
The only project, if the contract has only one project.
The project with greatest total dollar amount, if the contract has multiple projects.

All Checklist Scheduled Events that do not have Next Projected Date displayed are
automatically updated with the first logical date after the Notice To Proceed date.

To delete a contract, its status must be pending.

To change a contract’s status back to pending, the following criteria must be met.

1. Contract items cannot have:

= An associated change order

= An associated dispute
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5.2 Contract Status Validation

An associated stockpiled material

The contract cannot have:

An associated force account

An associated estimate

An associated dispute

An associated sample

An associated change order

An associated plan discrepancy

Been downloaded (checked out) to the field
Milestones cannot have an associated change order

The contract cannot have daily work reports associated with it

If a contract status change cannot be saved because the data fails validation:

Change the contract’s status to pending.

Delete the contract.

If the contract has been active, delete the contract’s associated record(s) or upload the contract back
to the Server (check it in).

Entering the Physical Work Complete Date does not change the contract status. However, it marks
the beginning of the contract completion procedure. To save the Physical Work Complete Date, all
draft and pending change orders must be either approved or not approved. When the Physical Work
Complete Date is entered, the Project Manager and Project Engineer are notified by In-Box message,
any active items are assigned final quantities and the items’ status is changed to from Active to Final
(i.e., no longer able to log work to these items).

To change a contract’s status from active to complete, the following criteria must be met.

The Physical Work Complete Date must have an actual date.

All critical dates and key dates marked Required to Finalize must have actual dates.

All checklist scheduled events must have actual dates.

All items must have approved final quantity.

No change order can have a status of pending.
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= All progress and final estimates must be paid.
= All disputes and claims must be resolved.
= All stockpiled materials must be zero.

When the contract status changes to complete, contract authority is end-dated for all contract
personnel except the Project Manager and Project Engineer. After a contract is complete, only the
Project Manager, Project Engineer, and personnel with office-wide and update access can make
changes to a contract. When the contract status changes to complete, the system marks the contract
To Be Sent to DSS. The archived status is used to store the archived file.

5.3 Contract Records

The Contract Records panel lets the user access other windows to view, add, modify, and delete
contract records. The Contract Records panel has icons that represent the following windows:

= Contracts

= Milestones

= Projects

= Categories

= [tems

= Contract Funding

= Contract Authority

= Key Dates

= Checklist Scheduled Events
= Checklist Event Dates
= Correspondence Log
= Plan Discrepancies

= Stockpiled Materials
= Force Accounts

= Design Evaluation

= Disputes/Claims
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ESuthntracts

Figure 5-1. The Contract Records Panel
To access the Contract Records panel:

1. On the Contract Administration panel, double-click the Contract Records icon.

5.4 Contracts

The Contracts window lets the user add new contracts, and view, add, modify, or delete basic
contract data. The following table describes the nine folder tabs on the Contracts window:

Folder Tab Name Description

Description The Description folder tab displays the contract
description data. This includes the contract’s status,
project number(s), administrative offices, funding
sources, and other descriptive information that
determines how the system processes data for this
contract.

Location The Location folder tab displays the contract location
data that can be added, modified, or deleted. This
includes the list of available counties for each state or
province and those associated with the selected
contract. Authorized users may add and remove
counties to and from the contract. A primary county
must be selected.

10
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Folder Tab Name Description
Payment Data The Payment Data folder tab displays the contract

payment data that can be added, modified, or deleted.
This data includes liquidated damages rate amount,
retainage, estimate generation indicators, and limit
amount.

Critical Dates The Critical Dates folder tab displays the critical dates
(letting date, notice to proceed date, etc.). These dates
are required by the system for the standard contract
status reports. The default date types cannot be deleted
or modified.

Primary Personnel | The Primary Personnel folder tab lets the user maintain
data on the contract creator, designer, Project Manager,
and Project Engineer. This folder tab also identifies the
personnel who will receive messages when the contract
becomes active or falls behind schedule.

Prime Contractor | The Prime Contractor folder tab displays the Prime
Contractor data that can be added, modified, or deleted.
This data includes the Prime Contractor, contractor
defaulted data, maximum subcontract amount, payroll
requirements, prime contacts, and prime associates.
The Prime Contractor’s surety and insurance
companies must be entered as prime associates.

DBE Commitment | The DBE Commitment folder tab lets the user add and
modify contract or DBE commitments. This folder tab
also displays system-calculated DBE amounts.

Training Plan The Training folder tab lets the user identify the Prime
Contractor’s on-the-job training commitments for a
contract (i.e., the training plan), which is then used
during estimate generation to perform automated
reimbursement. This folder tab also displays system-
calculated training hour usage.

Table 5-1. The Contracts Window Folder Tabs Table

11
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5 Contracts !E[ E
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Personnel Contractor

ContractID:[ Fed St/Pr Prj Nbr: |
Status: W Primary PCN: |:B
Division::lﬂ District: EE Area: :B = F:d'-'ef:::ng_
Progress Sched: | [~] variance Pet: I—DD  State/Province

Desc: | " Both
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Spec Yr: Unit System: :B Suppl Spec Bk Yl:l Alt 1D:

Wage Wage Decision ID Wage Decision Description Genrl Wg Dcsn ID
Decision: [

Figure 5-2. The Contracts Window
To access the Contracts window:
1. On the Contract Administration panel, double-click the Contract Records icon.

2. On the Contract Records panel, double-click the Contracts icon.

5.4.1 Contract Description

The Description folder tab displays the contract description data that can be added, modified, or
deleted. This includes the contract’s status, project number(s), administrative offices, funding type,
and other descriptive information that determines how the system processes data for this contract.

Field Name Description

Contract ID Agency-defined ID for the contract. Corresponds to the
Contract ID assigned by Trnseport or another preconstruction
system. This is a required field.

Status Indicates the current status of a contract (e.g., Pending,
Active, Complete, Archived).

Primary PCN The contract’s primary project control number. This field
lists the projects defined for this contract. If multiple
contracts are defined, the user selects the primary project in
this field.

Fed St/Pr Prj Nbr | The federal, state, or province project number for the contract,
project, or category. This is a required field.

12
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Field Name

Description

Level 2 Office

(user-defined
label)

The office number for the Level 2 office responsible for
administering the contract. The Level 2 office can have any
user-defined label, such as District, Division, or Region. This
is a required field. (The Level 1 office is the agency
headquarters, e.g., the Central Office or the Department of
Transportation.)

Level 3 Office

(user-defined
label)

The office number for the Level 3 office responsible for
administering the contract. The Level 3 office can have any
user-defined label. If there are only two administration levels,
this field does not display.

Level 4 Office

(user-defined
label)

The office number for the Level 4 office responsible for
administering the contract. The Level 4 office can have any
user-defined label. If there are only two or three
administration levels, this field does not display.

Progress Sched

The type of progress schedule used for the contract (i.e.,
percent complete for a time period, percent of critical items
complete for a time period, or critical path method). If Critical
Path Method is selected, no schedule is processed for this
contract in SiteManager. If the user selects a different
schedule type on the Progress Schedule window, the system
changes this field.

Variance Pct

The percentage difference between a schedule's anticipated
and actual completion percent. A message is generated when
the difference is greater than this percentage. For example, if
the Variance Pct is 10 percent, and 30 percent of the work is
anticipated to be complete by a certain date and the actual
percentage complete is 19 percent, a message notifies the
recipient(s) of the variance.

Time Charges

How time charges are assessed for the contract (i.e., work
days, calendar days, or fixed completion date). Thisisa
required field.

Bid Days The original number of days for the contract. This field is
required when the Time Charges entry is work days or
calendar days.

Bid Amt The original bid amount of the contract. This field is display

only.

13
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Field Name Description

Desc Text description of the contract. This is a required field.

Alt ID An alternate transportation agency-defined ID for the
contract. This field cannot be modified if an estimate has
been generated.

Contract Type Agency-defined classification of the contract type (e.g.,
biddable, safety, A + B, prime contract). This is a required
field.

Work Type Agency-defined classification of the major type of work being
done on the contract (e.g., bridge work, beautification). This
is a required field.

Spec Yr The Item Master specification year of the items used for the
contract. This is a required field.

Unit System Indicates that the measurement system used for the contract is

either English or metric. This is a required field.

Fed Oversight

Indicates that federal authorities must receive and approve
any change orders for this contract.

Funding

Indicates that the contract is funded by federal funds only,
non-federal funds only (state, province, etc.), or both. This is
a required field. If the user selects funding sources on the
Contract Funding window that do not match this field, the
system changes this field. If funding is subsequently
changed, the indicator changes with the funding assignment.

Suppl Spec BK Yr

A supplemental Item Master specification year of the items
used for the contract.

Local Oversight

Indicates that local authorities must be copied on and approve
change orders.

Wage Decision ID

Agency-defined ID for a wage decision applicable to the
contract. The user can search this field. Wage decision data
is required during the loading of contractor payrolls and is
used to determine potential wage rate variances. The wage
decision records are maintained in the Civil Rights reference
tables.

Genrl Wg Dcsn
ID

General wage decision ID.

5.4 Contracts
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Field Name Description
Wage Decision Description of the wage decision (first 40 characters).
Description
Proposal Fund Type of funds used for the contract (e.g., ST1 = State Fund 1,
Type FED1 = Federal Fund 1, MUNI = Municipal Fund)

Table 5-2. The Description Folder Tab Fields Table

To add a new contract:

1.

10.

11.

12.

13.
14.

On the Contract Records panel, double-click the Contracts icon. If the user is authorized
to add contract s, the Description folder tab fields are empty and the user can add new
contract data.

To add a new contract ID, click the Contract ID field and type the new ID.
Press the Tab key.

In the Fed St/Pr Prj Nbr field, type the federal, state, or province project number for the
contract.

In the Primary PCN drop-down list, click the expand arrow and click the project’s primary
control number.

In the Level 2 Office drop-down list, click the expand arrow and click the office ID.

If a Level 3 or 4 office administers the contract, click the expand arrow and click the office
ID in the Level 3 Office drop-down list.

If a Level 4 office administers the contract, click the expand arrow and click the office ID in
the Level 4 Office drop-down list.

In the Progress Schedule drop-down list, click the expand arrow and click the schedule type.

To change the default variance percentage, tab to the VVariance Pct field and type the
percentage.

In the Time Charges drop-down list, click the expand arrow to the right of the current
selection and click the time charges type.

If the Time Charges entry is Work Days or Calendar Days, tab to the Bid Days field and type
the original number of days for the contract.

Press the Tab key.

In the Desc field, type a description of the contract.

15



Trnseport SiteManager®
5. Contract Administration - New Contracts 5.4 Contracts

15.
16.
17.
18.
19.
20.
21.
22.
23.
24,
25.
26.
27.
28.

In the Contract Type drop-down list, click the expand arrow and click the contract type.
If federal oversight is required, select the Fed Oversight check box (ON).

In the Work Type drop-down list, click the expand arrow and click the work type.

If Local Oversight is required, select the Local Oversight check box (ON).

Press the Tab key.

In the Spec Yr field, type the Item Master specification year.

Press the Tab key.

In the Unit System drop-down list, click the expand arrow and click either English or metric.
Press the Tab key.

If required, in the Suppl Spec Bk YT field, type a supplemental Item Master spec year.
Press the Tab key.

In the Alt ID field, type an alternate ID for the contract.

To select a Funding type, click the radio button for Federal, State/Province, or Both.

A new contract ID cannot be saved until the following data is entered: the Location, the
Primary Personnel, and the Prime Contractor. Click the Location folder tab and continue
adding data (refer to the Location topic).

To modify a pending contract’s description:

16

1.

On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

Click the Open button. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

In the Fed St/Pr Prj Nbr field, type the federal, state, or province project number for the
contract.

In the Primary PCN drop-down list, click the expand arrow and click the project’s primary
control number.

In the Level 2 Office drop-down list, click the expand arrow and click the office ID.

If a Level 3 or 4 office administers the contract, in the Level 3 Office drop-down list, click
the expand arrow and click the office ID.
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8. If a Level 4 office administers the contract, in the Level 4 Office drop-down list, click the
expand arrow and click the office ID.

9. To change the default variance percentage, tab to the VVariance Pct field and type the
percentage.

10. In the Time Charges drop-down list, click the expand arrow to the right of the current
selection and click the time charges type.

11. If the Time Charges entry is work days or calendar days, tab to the Bid Days field and type
the original number of days for the contract.

12. Press the Tab key.

13. In the Desc field, type a description of the contract.

14. In the Contract Type drop-down list, click the expand arrow and click the contract type.

15. If Federal Oversight is required, select the Fed Oversight check box (ON).

16. In the Work Type drop-down list, click the expand arrow and click the work type.

17. If Local Oversight is required, select the Local Oversight check box (ON).

18. Press the Tab key.

19. In the Spec YT field, type the Item Master specification year.

20. Press the Tab key.

21. In the Unit System drop-down list, click the expand arrow and click either English or metric.

22. Press the Tab key.

23. If required, in the Suppl Spec Bk YT field, type a supplemental Item Master spec year.

24. Press the Tab key.

25. In the Alt ID field, type an alternate ID for the contract.

26. To select a Funding type, click the radio button for Federal, State/Province, or Both.

27. Click the Save button.

The wage decision records are maintained in the Civil Rights reference tables. To add a Wage
Decision to a contract:

1.

On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.
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2. Click the Open button. The Select Contract list displays.

3. Inthe Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

4. Click the Wage Decision ID list box and click the New button. An empty row is added to
the list.

5. In the Wage Decision ID field, type a wage decision ID or click the right mouse button and
perform a Search.

6. Click the Save button.

When the user saves a contract status change, the system runs a validation process. If the contract
data passes validation, the status change is saved in the database. To change a contract’s status:

1. On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

2. Click the Open button. The Select Contract list displays.

3. Inthe Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

4. In the Status drop-down list, click the expand arrow to the right of the current selection and
click the status.

5. Click the Save button.
To delete a pending contract:

1. On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

2. Click the Open button. The Select Contract list displays.

3. Inthe Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

4. Click the Delete button.
5. Click the Yes button (to confirm the deletion).
6. Click the Yes button (to confirm deletion of associated records).

7. Click the Save button.
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5.4.2 Contract Location

The Location folder tab lets the user add, modify, and delete Contract location data, and add or
remove counties. Each contract must have one county selected as the primary county. The user

cannot remove a county that is currently associated with one of the contract’s projects.

Etonllacls M=l E3
Description Location Payment Data ~ Critical Dates Primary Prime DBE Commit — Training Plan
Personnel Contractar
Contract ID: I ﬂ

Location: |

|
Beg Sta Nbr: Beg Termini: Route Nbr: I
End Sta Nbr: End Termini: Highway Nbr: |

Road System: Highway Type:
LI_I Town- [ _pl_l
Contract County Primary County
| : [
Figure 5-3. The Location Folder Tab
Field Name Description
Location Description of the contract location. This is a required field.
Two lines are provided.
Beg Sta Nbr Precisely defines the station number where the work begins.
Beg Termini Precisely defines the termini where the work begins.
Route Nbr Route number where the primary work is done.
End Sta Nbr Precisely defines the station number where the work ends.
End Termini Precisely defines the termini where the work ends.
Highway Nbr | Highway number where the primary work is done.
Road System Type of road system where the primary work is done (e.qg.,
interstate, state highway, county road).
Highway Type | Type of highway where the primary work is done (e.g.,
asphalt, concrete, gravel).

19



Trnseport SiteManager®
5. Contract Administration - New Contracts

5.4 Contracts

Field Name Description
Contract Name of a county in which the work is done. The user can
County search this field.
Primary Indicates the primary county in which the work is done. At
County least one and only one county must be indicated as the
primary county.

Table 5-3. The Location Folder Tab Fields Table

To modify the contract location:

20

1.

10.
11.
12.
13.
14.
15.
16.
17.

On the Contract Records panel, double-click the Contracts icon. The Contracts window

opens.
Click the Open button. The Select Contract list displays.

In the Select Contract list box, scroll to and double-click the Contr
Find. The Select Contract list closes and the Description folder tab

Click the Location folder tab.

In the Location field, type a description of the construction location
second line and enter more text.

Press the Tab key.

act ID or perform a
displays.

. If necessary, tab to the

In the Beg Sta field, type the Station number where the work begins.

Press the Tab key.

In the Beg Termini field, type the Termini where the work begins.
Press the Tab key.

In the Route Nbr field, type affected route number.

Press the Tab key.

In the End Sta field, type the Station number where the work ends.
In the End Termini field, type the Termini where the work ends.

In the Highway Nbr, type the primary work roadway number.

In the Road System drop-down list, click the expand arrow and click the road system.

In the Highway Type drop-down list, click the expand arrow and click the highway type.
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18. Press the Tab key.

19. In the Town field, type the name of the town.

20. Click the Contract County datawindow and click the New button. An empty row is added

to the datawindow.

21. In the Contract County field, type the name of the county or perform a Search.

22. To add another county, click the New button and repeat Step 21.

23. In the Contract County list box, scroll to the primary county and select the Primary

County indicator (ON).

24. Click the Save button.

The user cannot remove a county that is currently associated with one of the contract’s projects. To
delete a county from a contract:

1.

On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

Click the Open button. The Select Contract list displays.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

Click the Location folder tab.

In the Contract County list box, scroll to and click the county (select the Primary County
indicator).

Click the Delete button.

In the Contract County list box, scroll to the primary county and select the Primary
County indicator (ON).

Click the Save button.

5.4.3 Contract Payment Data

The Payment Data folder tab lets the user add, modify, or delete contract payment data such as the
liquidated damages rate amount, the day of the month to generate estimates, contract payment
amount limits, and retainage data. The retainage data includes the type of retainage allowed and the
values that determine how retainage is to be applied to the contract.
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5 Contracts !E[ E
Description Location Payment Critical Dates Primary Prime DBE Commit — Training Plan
Data Personnel Contractor

Contract |D: I Current Contract Amt: $0.00
Generate Estl Day: I_l Contract Limit Aml:l $.00 Liquidated Dam Rate Amt: I $.00

Generate Est2 Day: l_ Contract Limit Pcl:l 0o ¥ Auto Liquidated Dam

[~ Price Adjmnt Ind
RETAINAGE

[~ Securities Allowed [ Retain Stkpiled Ind [ Unlimited Escrow  Max Escrow Aml:l $.00 I

—
Retainage Changes:

Work Compl Basis |Effect Date, Pct Pct Base Max Pct Max Amt Lump Amt |Trgr Pct, Trgr Base
[=] 00/00/00 .00) = .00 $.00 $.00 00| [

Figure 5-4. The Payment Data Folder Tab

Field Name Description

Current Contract | The current amount of the contract (original bid amount
Amt plus approved change orders). This field is display
only.

Generate Estl Day | The day of the month, 1 - 30, that the contract’s first
monthly estimate should be generated. Three days
before this day, the system notifies the Project Manager
that estimate generation is approaching.

Contract Limit The amount over the original bid amount that is allowed
Amt for the contract. The limit amount is added to the bid
amount to calculate the maximum amount that can be
paid for the contract. If a value is entered in this field,
the Contract Limit Pct field is protected.

Liquidated Dam The liquidated damages rate amount for the contract.
Rate Amt

Generate Est2 Day | The day of the month, 2 - 30, that the contract’s second
monthly estimate should be generated. Three days
before this day, the system notifies the Project Manager
that estimate generation is approaching. The value in
this field must be greater than the Generate Estl Day.

22



5.4 Contracts

Trnseport SiteManager®

5. Contract Administration - New Contracts

Field Name

Description

Contract Limit Pct

The percent over the original bid amount that is allowed
for the contract. The total of the limit percent multiplied
by the bid amount is added to the bid amount to
calculate the maximum amount that can be paid for this
contract. If a value is entered in this field, the Contract
Limit Amt field is protected.

Auto Liquidated
Dam

Indicates that liquidated damage values are generated
automatically.

Price Adjmnt Ind

Indicates that price adjustments are allowed for the
contract’s items.

Retainage

Retainage
Securities Allowed

Indicates whether securities are allowed in lieu of
retainage for the contract.

Retainage Stkpiled
Ind

Indicates that retainage includes stockpiled materials in
the earnings calculation.

Retainage Max
Escrow Amt

Maximum amount that can be encumbered in an escrow
account used in lieu of retainage.

Retainage
Unlimited Escrow
Ind

Indicates that there is no limit to how much retainage
can be covered by the escrow account.

Retainage Changes

Retainage Changes
Work Compl Basis

Method for calculating retainage (i.e., Work Reported
Per Period, Work Remaining, or Work In Place).

Retainage Changes
Effect Date

Effective date of retainage. The effective date cannot be
duplicated on different retainage records.

Retainage Changes
Pct

The retainage percentage to be applied to the contract.
Must be less than or equal to the maximum retainage
percentage. This field is required if a lump sum amount
IS not entered.

Retainage Changes
Pct Base

Indicates that retainage should be calculated as a
percentage of the bid amount or the current amount.
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Field Name Description

Retainage Changes | The maximum retainage percentage allowed for the
Max Pct contract.

Retainage Changes | The maximum retainage amount allowed for the
Max Amt contract.

Retainage Changes | The lump sum amount of retainage. If a retainage
Lump Amt percentage is not entered, a value must be entered here.

Retainage Changes | The percentage of contract completion at which the
Trgr Pct retainage change is to occur.

Retainage Changes | Indicates that the trigger percentage should be a
Trgr Base percentage of the bid amount or current amount.

Table 5-4. The Payment Data Folder Tab Fields Table
To modify a pending contract’s payment data:

1. On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

2. Click the Open button. The Select Contract list displays.

3. Inthe Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

4. Click the Payment Data folder tab.

5. Inthe Generate Est 1 field, select the current entry and type the day of the month the
contract’s first monthly estimate should be generated.

6. Press the Tab key.
7. Inthe Contract Limit Amt field, type the payment limit amount.
8. Press the Tab key.

9. To enter a Liquidated Damages Rate Amount or overwrite the default value in the
Liguidated Dam Rate Amt field, select the current entry and type the rate.

10. Press the Tab key.

11. In the Generate Est 1 field, select the current entry and type the day of the month the
contract’s second monthly estimate should be generated.

12. Press the Tab key.
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13.

14.

15.
16.

17.

18.

19.

20.

In the Contract Limit Pct field, select the current entry and type the contract’s limit
percentage.

To turn off automated liquidated damage generation, select the Auto Liquidated Dam check
box (OFF).

To allow item price adjustments, select the Price Adjmnt Ind check box (ON).

To allow securities to be used in lieu of retainage, select the Securities Allowed check box
(ON).

To include stockpiled materials in earnings calculations, select the Retain Stkpiled Ind
check box (ON).

To allow unlimited retainage coverage by the escrow account, select the Unlimited Escrow
check box (ON).

In the Max Escrow Amt field, select the current entry and type the maximum amount to be
encumbered in an escrow account.

Click the Save button.

If a retainage record is effective when an estimate is generated, the record cannot be deleted.
Therefore, the user cannot delete a retainage record when:

The Retainage Effective Date is less than or equal to the current date, and an estimate has
been generated.

The Estimate Generate date is greater than or equal to the Retainage Effective Date.

To add data that determines how retainage is to be applied to the contract:

1.

On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

Click the Open button. The Select Contract list displays.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

Click the Payment Data folder tab.

In the Retainage Changes area, click the Work Compl Basis field and click the New
button. An empty row is added.

In the Work Compl Basis drop-down list, click the expand arrow to the right of the current
selection and click the method for calculating retainage.

Press the Tab key.
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8. Inthe Effect Date field, select the current entry and type the effective date of retainage.
9. Press the Tab key.
10. In the Pct field, select the current entry and type the retainage percent to be applied.

11. In the Pct Base drop-down list, click the expand arrow to the right of the current selection
and click either Bid Amount or Current Amount.

12. Press the Tab key.

13. In the Max Pct field, select the current entry and type the maximum retainage percentage
allowed.

14. Press the Tab key.

15. In the Max Amt field, select the current entry and type the maximum retainage amount
allowed.

16. Press the Tab key.
17. In the Lump Amt field, select the current entry and type the lump sum amount of retainage.
18. Press the Tab key.

19. In the Trgr Pct field, select the current entry and type the trigger percentage (percentage of
contract completion at which the retainage change is to occur).

20. Press the Tab key.

21. In the Trgr Base drop-down list, click the expand arrow to the right of the current selection
and click either Bid Amount or Current Amount.

22. Click the Save button.

5.4.4 Contract Critical Dates

The Critical Dates folder tab lets the user view and record the occurrence of Critical Dates. The user
can also add or modify related data. The actual occurrence of a Critical Date event is recorded as the
Actual Date of the event. Some Actual Dates are entered by the system and some are entered by an
authorized user. The Critical Date types are defined during system development and cannot be
added or deleted. These dates are considered critical because SiteManager includes them in the
standard contract record reports. When a new contract is added, either manually or from a
preconstruction system, SiteManager includes the Critical Date types defined in the Default Critical
Date reference table. Therefore, every contract has the same Critical Date types.
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Critical Date Type

Requirements for Entering the Actual Date

Accepted Date

This date cannot be required to activate the contract.

Adjusted Completion
Date

The system enters this date and the user cannot modify
it. This date is entered by the Change Order process.

Award Date

This date cannot be modified when the contract is from
the preconstruction system.

Checked Out to Field
Date

The system enters this date and the user cannot modify
it. This date is entered by Pipeline when the contract is
checked out. This date cannot be required to activate
the contract.

Contract Archived Date

The system enters this date and the user cannot modify

it. This date is entered by the contract archival process.

This date cannot be required to finalize or activate the
contract.

Contractor Bankruptcy
Date

This date cannot be required to finalize or activate the
contract.

Contractor Default Date

This date cannot be required to finalize or activate the
contract.

Contractor Final
Release Date

This date cannot be required to activate the contract.

Execution Date

This date can be modified only when the contract is
pending.

Letting Date

The user cannot modify this date if the contract was
transferred from a preconstruction system.

Notice to Proceed Date

The user cannot modify this date until the contract’s
status is changed to Active.

Open to Traffic Date

This date cannot be required to activate the contract.

Original Completion
Date

If time is charged as Calendar Days, the system enters
this date and the user cannot modify it. If time is
charged as a Fixed Completion Date, this date can be
modified while the contract is pending. If time is
charged as Available Work Days, this date should not
be entered.

27



Trnseport SiteManager®

5. Contract Administration - New Contracts

28

Critical Date Type

Requirements for Entering the Actual Date

Physical Work
Complete Date

This date cannot be required to activate the contract.
This date can be modified only when the contract is
active. Before entering this date, all change orders must
be approved or denied. When this date is entered, the
system notifies personnel and enters final quantities for
active items and moves all active items to final status.

When this date is entered, the user is notified that all
items will be moved to Final status upon entering and
saving this date, and is prompted to continue the
operation. Once this date has been entered and saved,
the user will no longer be able to post DWRs on items
moved to the Final status.

Price Adjustments Base
Date

This date can be modified only when the contract is
pending.

Signed Date

This date cannot be modified when the contract is from
a preconstruction system.

Substantial Work
Complete Date

This date cannot be required to activate the contract.
This date can be modified only when the contract is
active.

Work Begin Date

This date cannot be required to activate the contract.

Table 5-5. The Critical Date Type Requirements Table

5.4 Contracts
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¥4 Contracts M= E
Description Location Payment D ata Critical Frimary Prime DBE Commit — Training Plan
Dates Perzonnel Contractor

Contract 1D: I

Critical Date Description | Actual Date |Required to Activate | Required to Finalize ﬂ
Accepted Date 00/00/00 M M
Adjusted Completion Date 00/00/00 M M
Contract &rchived D ate 00400400 N N
Award Date 00/00/00 N N
Contractor Bankruptcy Date 0040000 N M
Checked Dut to Field Date 0000400 N N
Contractor Default Date 00400400 N M

Eil o

Critical Date Description: IAccepled Date

Actual Occurrence Date: [~ Required to Activate [~ Required to Finalize

Distribution List: I Recipient 1D: I

Message Text: |

Figure 5-5. The Critical Dates Folder Tab

Field Name Description
Critical Date System-defined critical date type. All contracts have the default
Description critical date types. The critical date types cannot be added,

modified, or deleted.

Actual Date The date the event actually occurred. In most cases, the date
must be current or in the past. If time is charged as Fixed
Completion Date, the Original Completion Date can be in the
future. When an Actual Date is entered, the system notifies the
selected recipient(s). When an Actual Date is entered for the
Physical Work Complete Date, the system notifies Level 1
office personnel and enters final quantities for any active items
and changes their status to final (i.e., no longer able to log work
to these items).

Rqrd to Activate | Indicates that the event must occur before the contract status can
be changed from pending to active (e.g., Letting Date, Award
Date, Execution Date).

Rqrd to Finalize | Indicates that the event must occur before the contract status can
be changed to complete.

Distribution List | Group of users to be notified that the event has occurred. Either
a Distribution List or Recipient must be entered. After valid
entry of either, the other is unavailable. The user can search this
field.

29



Trnseport SiteManager®

5. Contract Administration - New Contracts 5.4 Contracts
Field Name Description
Recipient ID User ID of the person to be notified that the event has occurred.

Either a Distribution list or recipient must be entered. After
valid entry of either, the other is unavailable. The user can
search this field.,

Message Text Standard message to be sent to the recipient(s).

Table 5-6. The Critical Dates Folder Tab Fields Table

The Notice to Proceed Date can only be entered when the contract status is Active. Before the
Physical Work Complete Date is entered, item final quantities should be approved and all change
orders must be approved or denied.

If an Original Completion Date is entered for an Available Work Days contract, the date will be
removed when the contract is activated.

To enter the Actual Date of a Contract Critical Date:

1. On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

2. Click the Open button. The Select Contract list displays.

3. Inthe Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

4. Click the Critical Dates folder tab.

5. In the Critical Date Description list box, scroll to and click the date. The data for the
selected date displays below the list.

6. Inthe Actual Date field, click in front of the current entry and type the date when the
Critical Date event occurred.

7. To make this date Required to Activate, select the Rqrd to Activate check box (ON).
8. To make this date Required to Finalize, select the Rqrd to Finalize check box (ON).

9. To select a recipient for notification, perform a Search in either the Distribution List field
or the Recipient ID field.

10. In the Message Text field, type a message to include with the notification.

11. Click the Save button.
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5.4.5 Contract Primary Personnel

The Primary Personnel folder tab lets the user add, modify, and delete the contract’s primary
personnel. Every contract must have a Project Manager and a Project Engineer. When an
authorized user adds the Project Manager and Project Engineer to the contract, SiteManager

automatically adds them to Contract Authority. If primary personnel are later replaced, SiteManager
starts authority for the new personnel and ends authority for the previous personnel.

The user can also select an individual or a group to be notified of certain conditions. Personnel can

be notified when the contract status is changed to active, when the contract work falls behind

schedule, or when civil rights data fails validation.

5 Contracts [_ (O] x|
Description Location Payment Data  Critical Dates Primary Prime DEE Commit  Training Plan
Personnel Contractar

Contract ID: I

Project Manager: E o |
Project Engineer: | |
Contract Designer: |
Contract Created By: |Systern Administrator 1
— Motification Recipients

— Contract Status Changed to A

User ID: I Distribution List: |

—Work Progress Behind Schedul

User ID: I Distribution List: |

r— Civil Rights Exception Report G

User ID: I Distribution List: |

Figure 5-6. The Primary Personnel Folder Tab

Field Name

Description

Project Manager

Name of the Project Manager for the contract.
Specific messages and reports are sent to this person.

The user can search this field. This is a required field.

Project Engineer

Name of the Project Engineer for the contract.
Specific messages and reports are sent to this person.

The user can search this field. This is a required field.

Contract Designer

Name of the person or firm that designed the contract.

Contract Created
By

Name of the user who added the contract, or a system
indicator for contracts built by the system.
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Field Name Description

Recipient Notified when Contract Status Changed to Active

User ID User ID of the person to be notified when the
contract’s status changes from pending to active. The
value is protected if a Distribution List is entered.
Either a User ID or Distribution List must be entered.
The user can search this field.

Distribution List Name of the Distribution List to be notified when the
contract’s status changes from pending to active. The
value is protected if a User ID is entered. Either a
User ID or Distribution List must be entered. The user
can search this field.

Recipient Notified when Work Progress Behind Schedule

User ID User ID of person to be notified when the contract’s
progress falls behind schedule equal to or greater than
the variance percentage. This message is generated
only if the Variance Pct is entered and the contract
work is tracked by a Progress Schedule. The value is
protected if a Distribution List is entered. Either a
User ID or Distribution List must be entered. The user
can search this field.

Distribution List Name of the Distribution List to be notified when the
contract’s progress falls behind schedule equal to or
greater than the variance percentage. This message is
generated only if the Variance Pct is entered and the
contract work is tracked by a Progress Schedule. The
value is protected if a User ID is entered. Either a
User ID or Distribution List must be entered. The user
can search this field.

Recipient Notified when Civil Rights Exception Report Generated

User ID User ID of the person to be notified when the
contract’s civil rights monitoring generates an
exception report. This field is protected if a
Distribution List is entered. Either a User ID or
Distribution List must be entered. The user can search
this field.

32



Trnseport SiteManager®

5.4 Contracts 5. Contract Administration - New Contracts

Field Name Description

Distribution List Name of the Distribution List to be notified when the
contract’s civil rights monitoring generates an
exception report. This field is protected if a User ID is
entered. Either a User ID or Distribution List must be
entered. The user can search this field.

Table 5-7. The Primary Personnel Folder Tab Fields Table

To add Primary Personnel to a pending contract:

1.

10.

11.

12.

13.

On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

Click the Open button. The Select Contract list displays.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

Click the Primary Personnel folder tab.

In the Project Manager field, type the User ID of the contract’s Project Manager or perform
a Search.

Press the Tab key.

In the Project Engineer field, type the User ID of the contract’s Project Engineer or perform
a Search.

Press the Tab key.
In the Contract Designer field, type the name of the contract’s Designer.

To select a recipient to be notified when a contract’s status changes from pending to active,
tab to the appropriate field and type the User ID or Distribution List name or perform a
Search.

To select a recipient to be notified when a contract’s progress falls behind schedule, tab to
the appropriate field and type the User ID or Distribution List name or perform a Search.

To select a recipient to be notified when a contract’s civil rights monitoring generates an
exception report, tab to the appropriate field and type the User ID or Distribution List name
or perform a Search.

Click the Save button.
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5.4.6 Prime Contractor, Contacts, and Associates

The Prime Contractors folder

entities are defined as follows

tab lets the user add and delete the Prime Contractor, the Prime
Contacts, and the Prime Associates. The user can also specify the Prime Contractor’s payroll
frequency and the maximum percentage of the contract work that can be subcontracted. If the Prime
Contractor is in default, the user can record the defaulted date and reason. The Prime Contractor

Prime Contractor

The Prime Contractor is the contractor who is awarded the
contract.

Prime Contacts

The Prime Contacts are the Prime Contractor’s personnel
who are contact persons for the contract. This includes
safety officers, contractor supervisors, and EEO
compliance officers.

Prime
Associates

The Prime Associates are vendors who have a contract-
specific relationship with the Prime Contractor. This
includes the surety and insurance companies that are
supplying business services to the Prime Contractor for the
contract.

(Bicontzcts | | | [ LT L LT et = )

Description ~ Location  PaymentData  Critical Dates ~ Primary Prime  DBE Commit - Training Plan

Personnel Contractor

Contract 1D
Current Prime
Payroll

|

il [~ Joint Venture

’TV' Required

Freq in Weeks: [[ vl

Max Subcontract Pct: 0o ¥ Subcontractors Paid

Bankruptcy Date: |EIDJEIDJEID Bankruptcy Type Desc: [Spaces

Defaulted
[ Indicator Reason: |Spaces Date: |EID.-’EIU.-’EIU
Original Prime Contractor: | |

Prime Contacts:

Prime Associates:

Contact Name Contact Type ‘ User Id

Assoc Yendor ID Associate Short Name Associate Type ‘
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Field Name

Description

Current Prime

Agency-defined Vendor 1D and short name for the
current Prime Contractor. The user can search this
field. This is arequired field. If the user changes the
current Prime Contractor, the data in the other fields
is deleted.

Defaulted Original
Prime Contractor

Agency-defined Vendor ID and short name for the
original Prime Contractor who was awarded the
contract and then defaulted.

Joint Venture

Indicates that the contract was awarded to a joint
venture.

Subcontractors Paid

Indicates whether the Prime Contractor has paid all of
the subcontractors. This indicator is selected (ON) by
default.

Payroll Required

Indicates that certified payrolls are required for the
contract. Must be selected (ON) for federal contract.
Must be selected (ON) to process payrolls in
SiteManager. If this indicator is selected, a Payroll
Frequency in Weeks must be entered.

Payroll Freq in
Weeks

Weekly frequency that certified payrolls are required
to be received for the contract. This field is required
if the Payroll Required indicator is selected. This
value must be entered before the contract status is
changed to active.

Max Subcontract
Pct

Maximum percentage of the total contract amount
that the Prime Contractor is allowed to subcontract
(excluding specialty items).

Bankruptcy Date

Date the Prime Contractor filed for bankruptcy.

Bankruptcy Type
Desc

Type of bankruptcy filed (e.g., Chapter 11 or Chapter
13).

Defaulted Indicator

When selected (ON), the Defaulted Indicator
indicates that the Prime Contractor is in default and
another contractor or surety has taken over
responsibility for the contract.

Defaulted Date

The date the Prime Contractor defaulted. This field is
required if the Defaulted Indicator is selected (ON).
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Field Name Description

Defaulted Reason Reason the Original Prime Contractor defaulted (e.g.,
performance or bankruptcy). This field is required if
the Defaulted Indicator is selected (ON).

Defaulted Reason Reason the Original Prime Contractor defaulted (e.g.,
performance or bankruptcy). This field is required if
the Defaulted Indicator is selected (ON).

Prime Contact The name of the contact person for the Prime
Name Contractor. The user can search this field.

Prime Contact Type | Title of the contact person for the Prime Contractor

(e.g., EEO).
Prime Contact User | The agency-defined user ID for the Prime Contact, if
ID one has been assigned.
Prime Assoc Agency-defined ID for the Prime Contractor’s
Vendor ID Associate. Usually the Federal Tax ID. The user can

search this field.

Associate Short Short name for the Prime Contractor’s Associate.
Name
Associate Type Type of Prime Contractor Associate (i.e., Surety,

Insurance, Escrow, Banking, Surety Agent, Escrow
Agent, Other Payee, Other).

Table 5-8. The Prime Contractor Folder Tab Fields Table

To be selected as a Current Prime, a contractor must first be entered as a vendor in the Vendor
reference tables. To save a contract, the Prime Contractor must have a Payment Address selected via
the Services menu.

To add a Prime Contractor to a pending contract:

1. On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

2. Click the Open button. The Select Contract list displays.

3. Inthe Select Contract list box, scroll to and double-click the Contract ID or perform a
Find.

4. Click the Prime Contractor folder tab.
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10.

11.
12.
13.

14.

In the Current Prime field, type the name of the contract’s Current Prime Contractor or
perform a Search.

If a joint venture won the award, select the Joint Venture check box (ON). The Prime
Contractor must have affiliates defined in the VVendor reference table.

If the payrolls will be processed in SiteManager, select the frequency of receipt in weeks in
the Freq in Weeks drop-down field.

Or

If the payrolls will not be processed in SiteManager, select the Payroll Required check box
(OFF).

Press the Tab key.

In the Max Subcontract Pct field, type the maximum percentage of the total contract
amount that the Prime Contractor is allowed to subcontract.

Click the Services menu and select Address.
Choose the Address that will be used as the Prime Contractor’s Payment Address.

Click the Services menu (or click the Address button on the Toolbar)and choose Select
Address.

Click the Save button.

To be selected as a Prime Contact, a contact person must first be entered as personnel of the Prime
Contractor on the Vendor Personnel folder tab.

To add a Prime Contractor to a contract:

1.

On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

Click the Open button. The Select Contract list displays.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a
Find.

Click the Prime Contractor folder tab.

To add a contact, click the Prime Contact Name field and click the New button. An empty
row is added to the list.

In the Prime Contact Name field, perform a Search and select a name. The system enters
the User ID.
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7. Inthe Contact Type drop-down list, click the contact type.
8. Click the Save button.

To be selected as a Prime Associate, a vendor must first be selected as an associate of the Prime
Contractor on the Vendor Associates folder tab. Every contract requires two Associates: a surety
company and an insurance company.

To add a Prime Associate to a contract:

1. On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

2. Click the Open button. The Select Contract list displays.

3. Inthe Select Contract list box, scroll to and double-click the Contract ID or perform a
Find.

4. Click the Prime Contractor folder tab.

5. To add an associate, click the Prime Assoc Vendor ID field and click the New button. An
empty row is added.

6. Inthe Prime Assoc Vendor ID field, perform a Search and select n ID. The system enters
the Associate Short Name and the Associate Type.

7. Click the Save button.

When the user places the Current Prime in defaulted status, the user must also select a new Current
Prime and Prime Associates. For example, the Original Prime Contractor’s surety company can be
selected as the Current Prime.

To record a Prime Contractor’s defaulted status:

1. On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

2. Click the Open button. The Select Contract list is displayed.

3. In the Select Contract list box, scroll to and double-click the Contract ID or perform a
Find.

4. Click the Prime Contractor folder tab.

5. If the Prime Contractor has filed for bankruptcy, type the date the bankruptcy was filed in the
Bankruptcy Date field.

6. If the Prime Contractor has filed for bankruptcy, click the bankruptcy type in the
Bankruptcy Type Desc drop-down list.
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10.
11.

12.

13.

14.

5.4.7

Click the Defaulted indicator. A popup message appears saying that defaulting the Current
Prime also removes the Prime Contacts and Associates.

Click Yes to continue. The system removes the Prime Contacts and Associates and enters
the defaulted Prime Contractor in the Original Prime Contractor field.

In the Reason drop-down list, click the reason for defaulting.
In the Date field, type the date the Prime Contractor defaulted.

In the Current Prime field, type the name of the contract’s new Current Prime Contractor or
perform a Search.

To add an Associate, click the Prime Assoc Vendor ID field and click the New button. An
empty row is added.

In the Prime Assoc Vendor ID field, perform a Search. After the user selects an ID, the
system enters the Associate Short Name and the Associate Type.

Click the Save button.

DBE Commitments

The DBE Commit folder tab lets the user add and modify the DBE goal percentage and view the
DBE commitments for a contract. If the Prime Contractor is a DBE, the user can also enter the DBE
Work Class on this folder tab. The system calculates the DBE commitment amounts displayed on
this folder tab using values entered on the Subcontracts window.

El:unllacts [ [O] x|
Description Location Payment Data  Critical Dates Primary Prime DBE Commit Training Plan
Personnel Caontractar

Contract 1D: I DBE Work Class: ISpaces
DBE Goal Percent: I IUD DBE Goal Value: I$.DU

— DBE Commitment
Oniginal Amount: I $.00
Total Current Pct: I .o
Total Current Amount: | $.00

—Total DBE Subcontracts

Installed to Date: | $.00

Towards Goal: $.00
Mot Towards Goal: $.00
Amount: I $.00

Figure 5-8. The DBE Commit Folder Tab
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Field Name Description

DBE Work Class The Prime Contractor’s DBE Work Class for the contract.
This value can only be entered if the Prime Contractor is a
DBE.

DBE Goal Percent | DBE goal percentage for the contract. This value can be
modified.

DBE Goal Value DBE goal amount for the contract. The system calculates
this field by multiplying the contract bid amount by the
DBE goal percentage.

DBE Commitment

DBE Commitment | DBE commitment amount at award of the contract.
Original Amount

DBE Commitment | Percentage of the current DBE commitment on the

Total Current Pct | contract. The system calculates this value by dividing the
total current amount of the DBE commitment by the
contract bid amount.

DBE Commitment | Sum of the current DBE commitments for all subcontracts
Total Current to date. Calculated by the system.
Amount

Total DBE Subcontracts

Installed to Date Installed to Date amount for all DBE subcontracts in the
contract. The sum of all DBE subcontract-reported item
quantities multiplied by the item prices.

Towards Goal Subcontract amount counted towards the DBE
commitment goal. The sum of the DBE subcontract
amounts multiplied by the DBE goal percentage.

Not towards Goal Subcontract amount not counted towards the DBE
commitment goal. The sum of the DBE subcontract
amounts minus the amount counted towards the DBE
commitment goal.

Amount Sum of all the DBE subcontract amounts for the contract.

Table 5-9. The DBE Commitments Folder Tab Fields Table
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To modify the DBE goal percentage for a contract:

1. On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

2. Click the Open button. The Select Contract list displays.

3. Inthe Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

4. Click the DBE Commitments folder tab.

5. If the Prime Contractor is a DBE, in the DBE Work Class drop-down list, click the expand
arrow to the right of the current selection and click the DBE Work Class.

6. Inthe DBE Goal Percent field, type the DBE goal percentage for the contract. The
remaining fields are calculated by the system.

7. Click the Save button.

5.4.8 Training Plan

The Training Plan folder tab lets the user view, add, and modify the Prime Contractor’s on-the-job-
training commitments for a contract. If the contract includes the training plan as a line item, the
system enters the training plan and the user cannot modify it. If training is not a line item, the user
can enter the plan. The plan consists of the total training hours for the contract, the hourly (unit)
price to be used for reimbursement, and the approximate number of trainees. This data is used by
the estimate process to reimburse the Prime Contractor.

If a training plan is specified, the trainees must be entered on the Trainees window in Civil Rights.
The training plan hour usage is typically entered through certified payrolls. To accrue training plan
hours, the trainee data (names, SSN/SIN numbers, and training program) must match the payroll
employee data. The Total Hours Used to Date field is updated automatically via the Accrue
Training Experience batch process. The hours are accrued from certified payrolls that include
trainee data. The Total Hours Paid to Date field is calculated during the estimate generation process.
For more information, refer to the Civil Rights, Contractor Payroll, and Contract Adjustment topics.

If the training plan is a line item, it must be a single line item. The Training Plan folder tab retrieves
only the first item code of the type (metric or English) specified in the system operational parameter
table.
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5 Contracts [_ (O] x|
Description Location Payment Data  Critical Dates Prirmary Prime DEE Commit Training
Personnel Contractor Plan

Contract 1D: |

Planned Training Hours:© |00 Total Hours Used To Date: I 0

Training Unit Plice:l $.00 Total Hours Paid To Date: | 0

Planned Number of Trainees: | Actual Number of Trainees: | 0

Figure 5-9. The Training Plan Folder Tab

Field Name Description
Planned Training Specifies the planned number of training hours
Hours committed by the Prime Contractor. If specified by a

training item code, this field defaults to the item’s bid
quantity and cannot be modified.

Planned Number of | Specifies the planned number of trainees committed by
Trainees the Prime Contractor. If specified by a training item
code, this field defaults to the item’s bid quantity divided
by the system operational parameter‘s average training
program hours and cannot be modified.

Training Unit Price | Specifies the hourly (unit) price to reimburse a Prime
Contractor for training hours logged via Contractor
Payrolls. If specified by a training item code, this field
defaults to the item’s bid unit price and cannot be
modified.

Total Hours Used To | Total number of hours used by the trainees on the

Date contract to date. This value is calculated by a batch
process using data from Contractor Payrolls and Civil
Rights. The user can modify this value by entering DOT
Hours on the Trainee window.

Actual Number of Actual number of trainees allocated to the contract. This
Trainees value is calculated by a batch process using Trainee data
from Civil Rights.
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Field Name Description

Total Hours Paid To | Total number of hours used by the trainees on the
Date contract after the last paid date. This value is calculated
during estimate generation.

Table 5-10. The Training Plan Folder Tab Fields Table

To add a Training Plan to a contract:

1.

8.
9.

On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

Click the Open button. The Select Contract list displays.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

Click the Training Plan folder tab.
In the Planned Training Hours field, type the number of planned training hours.
Press the Tab key.

In the Training Unit Price field, type the unit price (hourly) that the contractor will be
reimbursed for training.

Press the Tab key.

In the Planned Number of Trainees field, type the number of trainees.

10. Click the Save button.

5.4.9 Custom Records

The Custom Template (List & Record) window lets the user create custom templates to collect
contract records and PCC and SUPERPAVE Mix Design records and custom templates to list
records not related to specific contracts. Custom templates are sometimes needed to collect data that
cannot be entered on the standard windows provided with SiteManager. The user creates the
template by defining the required window elements. The user can then preview the template design
before making the template accessible to end users. Multiple detail records can be associated with
each Custom Contract Record, Custom List, Custom PCC and SUPERPAVE Mix Design custom
template that has been defined.
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These four types of templates are defined as follows.

= Custom Contract Record template
Collects contract data not currently associated to any SiteManager window.

= Custom List template
Maintains lists not currently associated to any SiteManager window. For example, phone
and address lists for welders, carpenters, and other non-contract personnel.

= Custom PCC Mix Design Record template
Collects PCC Mix Design data not currently associated to any SiteManager window.

= Custom SUPERPAVE Mix Design Record template
Collects SUPERPAVE Mix Design data not currently associated to any SiteManager

window.
Contract: | T late Id: | CCRMultiDt
Template Hame:
| |
Row 1 of 1
Fiow 10f 2 —
Field 1 : f19033
Field 2 : aaab
Figure 5-10. The Custom Contract Record Usage Window
Field Name Description
Contract Agency-defined ID for the selected contract.
Template ID Templates available for selection. The user can
search this field.
Template Name Name of the template selected on the window.

Table 5-11. The Custom Contract Record Usage Window Fields Table
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To modify custom contract records:

1.

5. Contract Administration - New Contracts

On the Contract Records panel, double-click the Contracts icon. The Contract Description

folder tab displays.
Click the Open button. The Select Contract window opens.

In the Contract list box, scroll to and double-click the Contract ID.

Click the Services menu and click the Custom Record choice. The Custom Contract

Record Usage window opens.

In the Template ID field, type the template ID or perform a Search. The window displays

the template.
Add or modify the data.

Click the Save button.

Mix ID: | Template Id: | C5AMuDE
Template Mame:

Row 1 of 1

¥ Custom SUPERPAVE Mix Design Usage Record

Row 1 of 2 a

Field 1 734

Field 2 : Andrew's Consulting

Figure 5-11. The Custom SUPERPAVE Mix Design Record Usage Window

Field Name Description

Mix ID The Mix ID for the current Mix Design.

Template ID This column is editable and standard search lens feature is
provided to select from the list of available Custom
SUPERPAVE Mix Design Record templates. The list
displays Template ID and Template Description in the
datawindow.

This column is editable and the user can enter the partial
Template ID and use the search or filter search facility.
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Field Name

Description

Template Name

The description of the template chosen by the user. This field
is protected.

Template Content

This area contains the fields that are included in the Template.
This field is editable unless the Mix Design is Approved.

Table 5-12. The Custom SUPERPAVE Mix Design Record Usage Window Fields Table

To modify custom SUPERPAVE Mix Design records:

1. On the Contract Records panel, double-click the Contracts icon. The Contract Description

folder tab is displayed.

2. Click the Open button. The Select Contract window opens.

3. Inthe Contract list box, scroll to and double-click the Contract ID.

4. Click the Services menu and click the Custom SUPERPAVE Mix Design Record choice.
The Custom Contract Record Usage window opens.

5. Inthe Template ID field, type the template ID or perform a Search. The window displays

the template.

6. Add or modify the data.

7. Click the Save button.

5.5 Contract Milestones

The Milestone window lets the user add, modify, and delete contract milestones. The user can enter
an incentive or disincentive rate for each milestone and specify either days or hours to be used in
calculating the amount to be paid or withheld. The user also enters the dates the milestone work was

started and completed.
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¥ Milestones [_ O] x|
Contract ID: ISITEMGF!_BD
Mlistn Description Time Cur Mistn -~
Mbr Used(%) | Cmpl Date
004004001
-
4 I »
Milestone Nbr: Description: |

Time Charges: |:|3 Bid Days: Charged: 0 Adjusted: | 0
Rate Time Period: ’I:E Bid Hours: Remaining: 0 Credit Days:l 0

Date — Time ™ Aut Disi tind [ Preconstruction Ind

Work Start:| 00/00/00 [ 00:00 [~ Autogen Incentive Ind [~ Milestone Compl Ind
Original Milestone Compl:l 00/00/00 | 00:00 Incentive Rate Amt: $.00
Current Milestone Compl: Im |W Disi tive Rate Amt: $.00

Actual Completion: | 00/00/00 | 00:00 Incentive Cap Amt:| 4.0

Figure 5-12. The Milestones Window

Field Name

Description

Milestone Nbr

System-generated sequential number of the milestone.
This value cannot be modified.

Description

Text description of the milestone.

Time Charges

How time charges are assessed for the contract. Can be
Available Work Days, Calendar Days, or Fixed
Completion Date.

Bid Days

The original number of days bid for the milestone. This
field is required if the Time Charges value is Available
Work Days or Calendar Days and the Rate Time Period
value is Days. A value cannot be entered if the Time
Charges value is Fixed Completion Date.

Charged

The total number of days charged to the milestone to
date. Calculated by the system. Can be Available Work
Days or Calendar Days, depending on the Time Charges
entry. This field is empty if the Time Charges value is
Fixed Completion Date.

Adjusted

Adjustment to the days charged for a milestone. This
value is provided by the Change Order function.

Remaining

Total days remaining to complete the milestone work on
time. This value is calculated by the system
[(Bid Days + Adjusted Days) - Charged Days].
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Field Name Description
Credit Days The total number of credit days recorded for the
milestone to date. Calculated by the system.
Bid Hours The original number of hours for the milestone. This

field is required if the Time Charges value is Available
Work Days or Calendar Days and the Rate Time Period
value is Hours. The Bid Hours value must be evenly
divisible by 12. A value cannot be entered if the Time
Charges value is Fixed Completion Date.

Original Milestone
Compl Date

Original date the milestone is to be completed. If the
Time Charges entry is Calendar Days, the system
calculates this value (Work Start Date + Bid Days). This
field is required if the Time Charges entry is Fixed
Completion Date.

Original Milestone
Compl Time

Original time the milestone is to be completed.
Calculated from the Work Start Time if the Time Charges
entry is Calendar Days (Work Start Time + Hours).

Current Milestone
Compl Date

Current expected date of completion. Calculated by the
system. The Change Order function enters this date when
time adjustments for milestones are approved. For new
milestones, this field defaults to the milestone’s original
completion date.

Current Milestone
Compl Time

Current expected time of completion. Always calculated
from the Work Start Time if the Time Charges entry is
Available Work Days or Calendar Days

(Work Start Time + Hours).

Actual Completion
Date

The date the work was completed for the milestone.
Must be greater than or equal to the Work Start Date.

Actual Completion
Time

The time the work was completed for the milestone.

Work Start Date

The date the work is expected to begin and time is
charged against the milestone. Must be less than or equal
to the Current Milestone Completion Date.

Work Start Time

The time the work is expected to begin and time is
charged against the milestone.

5.5 Contract Milestones
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Field Name Description

Incentive Rate Amt | Rate in dollars paid to the contractor if the milestone
work has progressed beyond expectations.

Disincentive Rate Rate in dollars the contractor is to be penalized if the
Amt milestone work has not progressed to expectations.

Incentive Cap Amt | Maximum incentive amount allowed for this milestone.

Rate Time Period The rate time period (days or hours) used to calculate the
incentive or disincentive for the milestone.

Autogen Disincent | Indicates whether a disincentive is automatically
Ind generated for the milestone.

Autogen Incentive Indicates whether an Incentive is automatically generated
Ind for the milestone.

Preconstruction Ind | Indicates the data was entered from a preconstruction
system and cannot be modified.

Milestone Compl Indicates that the Milestone work is completed.
Ind

Table 5-13. The Milestones Window Fields Table

To add a milestone with time charges of Available Work Days or Calendar Days:

1.

On the Contract Records panel, double-click the Milestones icon. The Milestone window
opens and a contract select list displays.

In the Contract ID list box, scroll to and double-click the contract. The Milestones for the
selected contract display.

Click the New button. An empty row is inserted in the Milestone list box.
In the Description field, type a description of the Milestone.

In the Time Charges drop-down list, click the expand arrow and select Available Work Days
or Calendar Days.

In the Rate Time Period drop-down list, click the expand arrow and select either Hours or
Days to be used for the incentive or disincentive calculation.

If the Rate Time Period is days, type the number of days bid for the milestone in the Bid
Days field.
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8.

9.

10.
11.

12.
13.

14.
15.
16.

If the Rate Time Period is hours, type the number of hours bid for the milestone in the Bid
Hours field.

To generate a disincentive automatically, select the Autogen Disincent Ind check box (ON).
To generate an incentive automatically, select the Autogen Incentive Ind check box (ON).

In the Incentive Rate Amt field, type the rate in dollars a contractor is to be compensated if
work has progressed beyond expectations.

Press the Tab key.

In the Disincentive Rate Amt field, type the rate in dollars a contractor is to be penalized if
work has not progressed to expectations.

Press the Tab key.
In the Incentive Cap Amt field, type the maximum incentive amount for this milestone.

Click the Save button. The system enters the next sequential milestone number for the new
milestone.

To add a milestone with a Fixed Completion Date:
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1.

8.
9.

10.

On the Contract Records panel, double-click the Milestones icon. The Milestone window
opens and a contract select list displays.

In the Contract ID list box, scroll to and double-click the contract. The milestones for the
selected contract display.

Click the New button. An empty row is inserted in the Milestone list box.
In the Description field, type a description of the milestone.

In the Time Charges drop-down list, click the expand arrow and select Fixed Completion
Date.

In the Rate Time Period drop-down list, click the expand arrow and select either Hours or
Days to be used for the incentive or disincentive calculation.

In the Original Milestone Compl Date field, type the date the milestone is to be completed.
In the Original Milestone Compl Time field, type the time the milestone is to be completed.
To generate a disincentive automatically, select the Autogen Disincent Ind check box (ON).

To generate an incentive automatically, select the Autogen Incentive Ind check box (ON).
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11.

12.
13.

14.
15.
16.

In the Incentive Rate Amt field, type the rate in dollars a contractor is to be compensated if
work has progressed beyond expectations.

Press the Tab key.

In the Disincentive Rate Amt field, type the rate in dollars a contractor is to be penalized if
work has not progressed to expectations.

Press the Tab key.
In the Incentive Cap Amt field, type the maximum incentive amount for this milestone.

Click the Save button. The system enters the next sequential milestone number for the new
milestone.

To record a Milestone Actual Completion date:

1.

6.
7.

On the Contract Records panel, double-click the Milestones icon. The Milestone window
opens and a contract select list displays.

In the Contract ID list box, scroll to and double-click the contract. The milestones for the
selected contract display.

In the Milestone list box, scroll to and click the milestone. Data for the selected milestone is
displayed in the fields.

In the Actual Completion Date field, type the date of completion.
Press the Tab key.
In the Actual Completion Time field, type the time of completion.

Click the Save button.

A milestone cannot be deleted if it has an associated record, such as a change order or an estimate
adjustment, or if the contract is checked out to the field.

To delete a Milestone:

1.

On the Contract Records panel, double-click the Milestones icon. The Milestone window
opens and a contract select list displays.

In the Contract ID list box, scroll to and double-click the contract. The milestones for the
selected contract display.

In the Milestone list box, scroll to and click the milestone. Data for the selected Milestone is
displayed in the fields.

Click the Delete button. The system asks the user to confirm the deletion.
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5. Click Yes.

6. Click the Save button.

5.6 Projects

The Projects window contains descriptions of the contract projects. Every contract must have at
least one project. The Projects window folder tabs are described in the following table:

Description The Description folder tab displays the project description.
The user can add, modify, and delete the project data.

Counties The Counties folder tab displays a list of available counties
and a list of those associated with the selected project. The
user can add and remove counties to and from the project.

f‘dj.“Stmem The Adjustment Indices folder tab displays a list of available

ndices . . . ; . .
price adjustment indices and a list of those associated with the
selected project. The user can add and remove price
adjustment indices to and from the project.

Table 5-14. The Projects Window Folder Tab Fields Table
ﬂPmiects = E3
Description Counties Adjustment Indices

Contract I1D: ISITEMGH_3D

Project Nbr: { """ Fed St Prj Nbr: | AltPimD:[
Description: | Spec Yr:[1331
Description: | Unit Sps: lEngT
Status: [Spaces [*] I Complete Auth Pay Limit: |$DEIEI—
[ Release Retainage AcctPiiNb:[
Pri Type: Work Type: Surface Type:
Route Nbr: I— Sect Nbr: li Road System:
Road Name: |
Location: | Engr Pct: IDAUEIEIU
Location: | Work Site:

Beg Sta: l— Beg Termini: l— Latitude: ID—
End Sta: I— End Termini: I— Longitude: ID—

Figure 5-13. The Project Description Window
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To access the Project Description folder tab:

1. On the Contract Records panel, double-click the Projects icon. The Project window opens
with the Description folder tab selected by default.

5.6.1 Project Description

The Project Description folder tab lets the user add, modify, and delete projects. New projects can
be added while the contract is in pending or active status. To add a projects to an active contract, an
authorized user may create the projects on the Project Description folder tab of the Project window.
Before any items may be added to a new project, at least one category and one funding source must
be associated to that project. A projects with dependent data, such as categories or items, cannot be
deleted. When a contract has multiple projects, the user must select the primary projects on the
Contract Description folder tab.

Field Name Description
PCN Agency-defined project control number. This field is
required.
Fed St Prj Nbr The federal/state number for the project. Must be unique

within a contract. Cannot be modified after an estimate
has been generated. This field is required.

Alt Prj ID Alternate agency-defined ID for the project. Cannot be
modified after an estimate has been generated.

Auth Pay Limit The Authorized Payment Limit is used to determine if a
voucher will be processed. If the total payments exceed
this amount, the voucher will not be processed. Leaving
this field blank indicates that no cap exists for total
payments. The Authorized Payment Limit cannot be
modified after an estimate has been generated.

Status Indicates the current status of a project (e.g., Complete,
Construction, Active Construction, Awaiting Award).

Acct Prj Nbr An accounting department-defined project number.
Cannot be modified if an estimate has been generated.

Engr Pct The engineering construction percentage represents the
state or province’s cost of managing a project. This
percentage of the total project item amounts can be used
to compute the total project estimated cost as follows:
[total Project Item amount x (100 + Engr Pct)]
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Field Name Description

Description Text description of the project. This field is required.
Two lines are provided.

Prj Type Identifies the type of project (e.g., Federal). This field is
required.

Work Type Agency-defined code that identifies the major type of
work being done in the project (e.g., Grading, Widening,
Overlay, Construction). This field is required.

Surface Type Type of surface grading used in the project (e.g.,
Asphalt).

Road Name Name of the road where the project work is done.

Route Nbr Route number where the project work is done.

Road System

Type of road system where the project work is done (e.g.,
interstate, federal highway, state highway, or county
highway).

Sect Nbr Road section number where the project work is done.

Location Description of the physical location of the project. This
field is required. Two lines are provided.

Work Site Identifies the landscape of the project work site (e.g.,
Urban).

Beg Sta Precisely defines the station number where the project
work begins.

Beg Termini Precisely defines the termini where the project work
begins.

Latitude The midpoint latitude of the project location.

End Sta Precisely defines the station number where the project
work ends.

End Termini Precisely defines the termini where the project work ends.

Longitude The midpoint longitude of the project location.

Complete Indicates that the project work is complete.

5.6 Projects
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Field Name Description

Release Retainage | Indicates that the project retainage is to be automatically
released when the project status is changed to complete.

Table 5-15. The Projects Description Folder Tab Fields Table

To add a project to a contract:

1.

10.
11.

12.

13.
14.
15.

16.

On the Contract Records panel, double-click the Projects icon. The Projects window
opens.

To select a contract, click the Services menu and click the Choose Keys choice. The Select
Contract 1D window opens.

In the Contract ID list box, scroll to and click the contract.

Click OK. The Project window opens with the selected contract ID displayed in the Contract
ID field.

In the PCN field, click the Open button, highlight the desired PCN and click OK.
Press the Tab key.

In the Fed St Prj Nbr field, select the current entry and type the federal or state project
number.

Press the Tab key.
In the Alt Prj ID field, select the current entry and type an alternate ID.
Press the Tab key.

In the Description field, type a description of the project. If necessary, tab to the next line
and add to the description.

In the Status drop-down list, click the expand arrow and click the current status of the
project.

To indicate that the project is complete, select the Complete check box (ON).
In the Auth Pay Limit field, select the current entry and type a limit value for payment.

To automatically release retainage when the project is completed, select the Release
Retainage check box (ON).

In the Acct Prj Nbr field, select the current entry and type an accounting project number.
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17.

18.

19.

20.
21.
22.
23.
24,

25.

26.
27.

28.
29.
30.
31.
32.
33.
34.
35.
36.
37.
38.

In the Prj Type drop-down list, click the expand arrow to the right of the current selection
and click the project type.

In the Work Type drop-down list, click the expand arrow to the right of the current selection
and click the work type.

In the Surface Type drop-down list, click the expand arrow to the right of the current
selection and click the surface type.

In the Route Nbr field, select the current entry and type the affected route number.
Press the Tab key.

In the Sect Nbr field, select the current entry and type the affected section number.
In the Road System field, select the current entry and type the road system type.

In the Road Name field, select the current entry and type the name of the road affected by
the project.

In the Location field, type a description of the location. If necessary, tab to the next line and
add to the description.

Press the Tab key.

In the Engr Pct field, select the current entry and type the percentage of the project cost
charged to the state or province.

In the Urb/Rural drop-down list, click the expand arrow and click Urban or Rural.

In the Beg Sta field, select the current entry and type the station where the work begins.
Press the Tab key.

In the End Sta field, select the current entry and type the station where the work ends.

Press the Tab key.

In the Beg Termini field, select the current entry and type the termini where the work begins.
Press the Tab key.

In the End Termini field, select the current entry and type the termini where the work ends.
Press the Tab key.

In the Latitude field, select the current entry and type the midpoint latitude of the job.

Press the Tab key.
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39. In the Longitude field, select the current entry and type the midpoint longitude of the job.
40. Click the Save button.

If the selected project has dependent data such as categories or items associated to it, the project
cannot be deleted.

To delete a project:

1. On the Contract Records panel, double-click the Projects icon. The Projects window
opens.

2. To select both a contract and a project, click the Open button. The Select Contract ID
window opens.

3. Inthe Contract ID list box, scroll to and double-click the contract. The Project List for the
selected contract is displayed.

4. Inthe Project list box, scroll to and click the project.
5. Click OK. The Projects window displays data for the selected project.
6. Click the Delete button. The system asks the user to confirm the deletion.

7. Click Yes. When the project is deleted, the corresponding project counties and adjustment
indices are also deleted.

5.6.2 Project Counties

The Counties folder tab lets the user add and remove counties to and from the project. For every
county included in the project, the user must enter the percentage of the project work to be done in
the county. The percentages for all counties must add up to 100 percent.

To select the Counties folder tab, the user must open or create a project record on the Description
folder tab.
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9 Projects M= E
Description Counties Adjustment Indices
Contract ID: |SITEMGR_30
Project Nbr: IPHDJ-U1 Fed State Project Nbr: |NEINE

Description: [I0B DESCRIPTION NO. 233-053-508

Location: [FROM: FOUTE 1 TO:ROUT 93

Available Counties

Project County | Proj Len %

-

:I Add -> | ALBEMARLE
Add All ->> |
<- Remove |
<<- Rem All |

o

Figure 5-14. The Project Counties Folder Tab

Field Name

Description

Fed State Project

The federal or state project number for the contract or

Number project.

PCN Agency-defined project control number.
Description Description of the project.

Location Description of the project location.

Available Counties

Counties included in the contract that have not been
associated with this project.

Project Counties

Counties that have been associated with this project.

Proj Len %

Percentage of the total length of the work to be done in
each county. This field is required for every project
county. The percentages for all counties must add up to
100 percent.

Table 5-16. The Project Counties Folder Tab Fields Table
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Button Description
Add The Add button adds a county to the project. If all available
counties have been associated with the project, this button is
disabled.
Add All The Add All button adds all the counties to the project. If all

available counties have been associated with the project, this
button is disabled.

Remove The Remove button removes a county from the project. There is
no message confirming the removal.

Remove All The Remove All button removes all the counties from the
project. There is no message confirming the removal.

Table 5-17. The Project Counties Folder Tab Buttons Table

To add a Project County:

1.

8.
9.

On the Contract Records panel, double-click the Projects icon. The Projects window
opens.

To select both a contract and a project, click the Open button. The Select Contract ID
window opens.

In the Contract ID list box, scroll to and double-click the contract. The project for the
selected contract are listed.

In the Project list box, scroll to and click the project.

Click OK. The Projects window opens with the Description folder tab displayed with data
for the selected project.

Click the Project Counties folder tab.

In the Available Counties list box, scroll to and click the county or use the CTRL key to
select multiple counties. To clear a county, click it again.

Click the Add button. The selection is added to the Project County list on the right.

In each Proj Len % field, type the percentage of the project work to be done in the county.

10. Click the Save button.
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5.6.3 Project Price Adjustment Indices

The Adjustment Indices folder tab lets the user add or delete a Price Adjustment Index to or from a
project. Price Adjustment Indices are used to adjust the cost of items that are known to have
fluctuating prices, such as gas and oil products. If the user adds an item’s Price Adjustment Index to
a project, the index is used during estimate generation to calculate the cost of the item.

To select the Adjustment Indices folder tab, the user must open or create a project record on the
Description folder tab.

E Projects =] B3

e
Description Counties Adjustment Indices

Contract ID: |SITEMGR_30

Project Nbr: |PHDJ-D1 Fed State Project Nbr: |NDNE
Description: [I0B DESCRIPTION NO. 233-053-508
Location: |FF|E|M: FOUTE 1 TO:ROUT 93

Available Price Indices * Indx Type  Project Pay Adimnt Indices

FUEL 0.29 GaL/CY Add > | S001 Fuel Adjustment

FO03 FUEL 0.20 GAL/TON

F201 FUEL 1.44 L/CU M Add All ->> |

Fz02 FUEL 0.83 L/MTON |
<- Remove
POO1

powder fill adjustment

P02 ASPHALT 5.8% <<- Rem All |

-

o | »

Figure 5-15. The Adjustment Indices Folder Tab

Field Name Description
Fed State Project Number | Federal or state project number for the project.
PCN Agency-defined project control number.
Description Description of the project.
Location Description of the project location.
Indx Type Identifying code of a Price Adjustment Index.
Available Price Indices Prige Adjustment Indices that can be associated with this
project.
Project Pay Adjmnt Price Adjustment Indices that have been selected for this
Indices project.

Table 5-18. The Adjustment Indices Folder Tab Fields Table
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Button Description
Add The Add button adds the selected price adjustment index to

the project. If all available indices have been associated with
the project, this button is disabled.

Add All The Add All button adds all the price adjustment indices to
the project. If all available indices have been associated with
the project, this button is disabled.

Remove The Remove button removes the price adjustment index from
the project. There will be no message confirming the
removal. If no indices are associated with the project, this
button is disabled.

Remove All The Remove All button removes all the price adjustment
indices from the project. There will be no message
confirming the removal. If no indices are associated with the
project, this button is disabled.

Table 5-19. The Adjustment Indices Folder Tab Buttons Table

To add a project Price Adjustment Index:

1.

On the Contract Records panel, double-click the Projects icon. The Projects window
opens.

To select both a contract and a project, click the Open button. The Select Contract ID
window opens.

In the Contract ID list box, scroll to and double-click the contract. The projects for the
selected contract are listed.

In the Project list box, scroll to and click the project.

Click OK. The Projects window opens with the Description folder tab displayed with data
for the selected project displayed.

On the Projects window, click the Adjustment Indices folder tab.

In the Available Price Indices list box, scroll to and click the index or use the CTRL key to
select multiple indices. To clear an index, click it again.

Click the Add button. The selection is added to the Project Pay Adjmnt Indices list on the
right.

Click the Save button.
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5.7 Categories

The Categories window lets the user add, modify, and delete categories. Categories are typically
used to group items funded by the same source within a project. To do this, the user can create a
category, associate items with the category, and select a funding source for the category. Each
category in a project can have a different funding source. A category with associated items cannot
be deleted.

The Categories window lists the categories for the selected contract and project. The window
displays detailed data for the selected category below the list. After a category is saved, the project
control number (PCN) and category number cannot be modified. The project number cannot be
modified after an estimate has been generated. When a new project is added to a contract, it must be
associated with at least one category.

E Categories [_ (O] x|
Contract ID: [SITEMGR_O1 PCN: [LT18534BDES-1
Category Number Description Work Class Type
‘ REGULAR BID ITEMS RECONDITIONING
<] | _'l_I
Catg Nbr: |DDEIE Fed St/Pr Prj Mbr: [NH-435-5(081)/0435029F 28
Desc: [REGULAR BID ITEMS Length: |.DDS1
| Width: |50.0000
Catg Wik Cls Type: |:E Bridge ID:| Engr Pct: |.DD

Brdg Type: [Spaces

Fed Wrk Catg Type: |HwY /"WTRWY Iﬂ Brdg Span Nhl:l Rd Sect Nhl:l

Fed Wik Cls Type: [NOT IN USE BY V=] Brdg Length: |.EIDEIEI Hwy Nbl:l
Suppl Wik Cls Type: Brdg Width: [0000 Hwy Type:

Beg Sta Nhl:l Beg Telmini:l Unit Nbr: |DEII]
End Sta Nbl:l End Telmini:l Desc: |

Figure 5-16. The Category Window

Field Name Description

Catg Nbr Category number assigned to items during preconstruction.
Items can be grouped in categories, primarily for funding.
This number must be unique within a project. The Category
Number cannot be modified. Categories created in error
must be deleted.

PCN Agency-defined Project Control Number.

Fed St/Pr Prj Nbr | Federal, state, or province project number for the category.
If not entered, defaults to the Fed St/Pr Prj Nbr for the
project. The user can find, filter, and sort this field.
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Field Name

Description

Desc

Description of the category. Two lines are provided. The
user can find, filter, and sort these fields.

Length

The length of road represented by this category. If more
than one category contains work for the same portion of

road, the length is split between them. The user can find,
filter, and sort this field.

Width

The width of road represented by this category. If more
than one category contains work for the same portion of
road, the width is split between them. The user can find,
filter, and sort this field.

Catg Wk Cls Type

Classification of work for a category within a project (e.g.,
Roadway Construction, Bridge Construction,
Beautification, Furnished Materials, Utilities).

Bridge ID

Agency-defined value that identifies a bridge or other
structure. This field is empty if the category does not
represent structure work. The user can find, filter, and sort
this field.

Engr Pct

Engineering construction percentage that represents the
state or province’s cost of managing a category. This
percentage of the total category item amounts can be used to
compute the total category estimated cost as follows: [total
Category Item amount x (100 + Engr Pct)]. The user can
find, filter, and sort this field.

Brdg Type

Type of bridge represented by this category (e.g., Concrete
Bridge, Steel Bridge, First Tier Overpass, Second Tier
Overpass). This value cannot be modified if the Bridge ID
field is empty.

Fed Wrk Catg
Type

Identifies the type of work for the category (e.g., General,
Roadway, Construction & Engineering, Alternates).

Bridge Span Nbr

Number of spans within the bridge structure. Protected if
the Bridge ID field is empty.

Rd Sect Nbr

Road section number where the category work is done. The
user can find, filter, and sort this field.

Fed Wrk Cls Type

Class of construction used for the category (e.g., General,
Roadway, Construction & Engineering, Alternates).
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Field Name Description
Brdg Lth Length of the structure represented by this category.
Protected if the Bridge ID field is empty.
Hwy Nbr Highway number where the primary category work is done.
The user can find, filter, and sort this field.
Suppl Wrk Cls Federal supplementary work class for a category (e.g.,
Type Emergency Evacuation Routing, Rest Areas, Safety
Improvements).
Brdg Wth The width of the structure represented by this category.

Protected if the Bridge ID field is empty.

Hwy Type Highway type where the primary category work is done.
Agency-defined values such as interstate, state route, county
route, and rest area.

Beg Sta Nbr Precisely defines the station number where the category
work begins. The user can find, filter, and sort this field.

Beg Termini Precisely defines the termini where the category work
begins. The user can find, filter, and sort this field.

End Sta Nbr Precisely defines the station number where the category
work ends. The user can find, filter, and sort this field.

End Termini Precisely defines the termini where the category work ends.

Unit Nbr Unit number under which the category is grouped.

Categories can be grouped under a unit number for
reporting purposes. The user can find, filter, and sort this
field.

Desc Description of the unit number under which the category is
grouped. Categories can be grouped under a unit number
for reporting purposes. The user can find, filter, and sort
this field.

Table 5-20. The Category Window Fields Table
To add a category to a project:

1. On the Contract Records panel, double-click the Categories icon. The Categories window
opens.
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2. To select both a contract and a project, click the Open button. The Select Contract Project
window opens.

3. Inthe Contract ID list box, scroll to and double-click the contract. The projects for the
selected contract are listed.

4. In the Project list box, scroll to and click the project.

5. Click OK. The Categories window opens with data for the first category on the list
displayed in the fields below the list.

6. Click the New button.

7. Inthe Catg Nbr field, type the Category Number.

8. Press the Tab key.

9. To change the default Project Number in the Fed St/Pr Prj Nbr field, select the current entry
and type the Project Number for the category.

10. Press the Tab key.

11. In the Desc field, type a description of the category.

12. Press the Tab key.

13.In t_he Length field, type the length of road represented by this category for the selected
project.

14. Press the Tab key.

15. If necessary, in the second Desc field, add a second line to the description of the category.

16. Press the Tab key.

17.1n t_he Width field, type the width of road represented by this category for the selected
project.

18. In the Catg Wk Cls Type drop-down list, click the expand arrow click the work class type.

19. Press the Tab key.

20. To identify a structure, in the Bridge ID field, type an agency-defined value to identify the
structure.

21. Press the Tab key.

22. In the Engr Pct field, type the engineering construction percentage.

23. Press the Tab key.
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24. If a structure has been entered in the Bridge ID field, in the Brdg Type drop-down list, click
the expand arrow and click the bridge type.

25. In the Fed Wrk Catg Type drop-down list, click expand and click the work category type.
26. Press the Tab key.

27. If a structure has been entered in the Bridge ID field, in the Bridge Span Nbr field, type the
number of spans.

28. Press the Tab key.
29. In the Rd Sect Nbr field, type the road section number where construction will take place.

30. In the Fed Wrk Cls Type drop-down list, click the expand arrow and click the work class
type.

31. Press the Tab key.

32. If a structure has been entered in the Bridge ID field, in the Brdg Lth field, type the length
of the structure.

33. Press the Tab key.
34. In the Hwy Nbr field, type the primary work roadway number.

35. In the Suppl Wrk Cls Type drop-down list, click the expand arrow and click the federal
supplementary work type for the category.

36. If a structure has been entered in the Bridge ID field, in the Brdg Wth field, type the width
of the structure.

37. In the Hwy Type drop-down list, click the expand arrow and click the type of the primary
work roadway.

38. Press the Tab key.

39. In the Beg Sta Nbr field, type the station number where the work begins.
40. Press the Tab key.

41. In the Beg Termini field, type the termini where the work begins.

42. Press the Tab key.

43. To group this category in a Unit with other categories, in the Unit Nbr field, type the unit
number.

44. Press the Tab key.
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45.
46.
47.
48.
49,

50.

In the End Sta Nbr field, type the station number where the work ends.
Press the Tab key.

In the End Termini field, type the termini where the work ends.

Press the Tab key.

If a Unit number has been entered in the Unit Nbr field, in the Desc field, type a description
of the Unit.

Click the Save button.

A category can only be deleted if there are no items associated to it.

To delete a category:

1. On the Contract Records panel, double-click the Categories icon. The Categories window
opens.

2. To select both a contract and a project, click the Open button. The Select Contract Project
window opens.

3. Inthe Contract ID list box, scroll to and double-click the contract. The projects for the
selected contract are listed.

4. In the Project list box, scroll to and click the project.

5. Click OK. The Categories window opens with data for the first category on the list
displayed.

6. Inthe Category list box, scroll to and click the category. The fields display data for the
selected category.

5.8 Items

The Items window lets the user add, modify, and delete items on the selected contract and project.
The agency defines standard items and lists them on the Item Master. The user can add an item to a
contract by selecting the item from the Item Master. While the contract is pending, this can be done
on the Items window. After the contract is active, items are added through change orders. The
Items window fields have specific display, protection, and calculation requirements depending on
whether the data was added through a change order. These requirements are included in the field
definitions.
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5.8 ltems

Figure 5-17. The Items Window

Field Name

Description

Line Item Nbr

The Contract Line Item number that identifies each item
as it appears on the contract. The user supplies this value
for all items added to the contract after construction
begins and all contracts entered online. When entered,
must be unique within the contract. Once saved, this
value cannot be modified. Items added with wrong line
item numbers must be deleted and added again.

Project Nbr

Agency-defined ID for the project. There can be multiple
project Control Numbers per contract. After a value is
entered and saved, it cannot be modified. Items added to
wrong projects must be deleted and added again.

Category Nbr

Category number under which items are grouped for
funding or other various reasons. After a category
number is saved, it cannot be modified. Items added to
wrong categories must be deleted and added again.
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Field Name

Description

Status Type

Code indicating the current status of an item.

Pending. Status defaults to pending when the item is
added.

Active. When a contract’s status is changed to active, the
status of all of the contract’s items is changed to active.
An active item cannot be deleted.

Final. When a Final Item Quantity Change Order is
approved, the status of all of the change order’s items is
changed to Final.

Audited. When an item has been approved or accepted
through an audit, the user must indicate its status as
Audited.

Complete. When a contract’s status is changed to
complete, the status of all of the contract’s items is
changed to complete.

Item Code

Agency-defined code used to identify an item. This value
is supplied by the Item Master list. The user can search
this field. This value is protected from modification once
the contract status is changed from pending to active.

Description

Text description of the item. This value is supplied by the
Item Master list. An Item Description cannot be
modified.

Units Type

The unit of measure for this item. This value is supplied
by the Item Master list and cannot be modified.

Unit Price

Unit price of the item, identified on the invoice and
contract documents. Protected from modification once
the contract status is changed from pending to active.

Spec Year

Specification year from the ltem Master record.
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Field Name

Description

Bid Quantity

This is the original quantity of the line item, as indicated
on the proposal or contract. Must be greater than zero.
Must be equal to one, if the item’s unit of measure is
Lump Sum. Protected from modification once the
contract status is changed from pending to active.
Protected from entry if item is being added through a
change order. If the bid quantity is zero, the item was
added through a change order and its quantity is obtained
through the Change Order Item quantity amount and not
the item bid amount.

Bid Amount

Total dollar amount of item at bid. Protected and is
derived from the formula [Bid Qty * Unit Price].

Proposal Line
Nbr

The line number that identifies the item as it appears on
the proposal. This field is populated by a preconstruction
system and is for display only.

Specialty

Indicates if the line item is a specialty item. Specialty
items are excluded from the calculation to determine the
amount of the contract which can be sublet. Protected
from modification if the contract has an associated
estimate or if the item has any of the following:

An associated Change Order
An associated dispute
An associated plan discrepancy (through a Change Order)

An associated stockpiled material

Major

Indicates that the item is considered major rather than
minor. Major items can have different overrun limits and
parameters for change order approvals. Protected from
modification if the contract has an associated estimate, or
if the item has any of the following:

An associated Change Order
An associated dispute
An associated plan discrepancy (through Change Order)

An associated stockpiled material
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Field Name

Description

Critical

Indicates that the item is considered critical. Used for
tracking the progress of contracts with the Critical Items
Installed progress schedule type. Non-critical items such
as landscaping are not included in progress tracking.

If the Allow Critical Item Indicator Update System
Operational Parameter is set to No., the indicator is
protected from modification if the contract has an
associated estimate or if the item has any of the following:

An associated Change Order

An associated dispute

An associated plan discrepancy (through a Change Order)
An associated stockpiled material

An associated Subcontract

If the Allow Critical Item Indicator Update System
Operator Parameter is set to Yes, the indicator is available
at all times until the item has a Final status.

Pay Plan Qty

Indicates if the line item is paid to plan quantity. If this
indicator is ON, an in-box message indicating that the
item has exceeded the notified quantity is issued to the
user who generated the estimate. Protected from
modification if the contract has an associated estimate or
if the item has any of the following:

An associated Change Order
An associated dispute
An associated plan discrepancy (through a Change Order)

An associated stockpiled material
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Field Name Description
Related Item Allows grouping of line items (e.g., all traffic control

items or all items for a structure) for reporting and
funding purposes. To report items together, the user may
create a related item code such as RPT1 = Report #1 and
then develop a report which selects and groups these items
together. Similarly, to fund a group of items the same but
not within the same category, the user may create a related
item code such as FND1 = Funding Source #1 and select
those items with this code in the funding process, thereby
funding all these items with the same source and
participation percentages. Protected from modification if
the contract has an associated estimate or if the item has
any of the following:

An associated Change Order
An associated dispute
An associated plan discrepancy (through a Change Order)

An associated stockpiled material

Supplemental User-entered description that is supplemental to the item's
Description description from the Item Master. Two lines are provided.
Material When an authorized user adds contract items online in
Discrepancy SiteManager, the item’s adjustment flag is set according
Adjustment to the settings in System Operational Parameters. This

flag’s check box defaults to On if system-wide
discrepancy adjustments flag is selected and if the default
calculation for all items flag is turned on. The default
setting for the item may be changed at any time during the
course of a contract. The item’s check box isdisabled if
the system setting for the discrepancy adjustments flag is
cleared.

Table 5-21. The Item Window Fields Table

A Contract Line Item can be deleted only if the contract status is pending. A supplemental
description is required if the Require Supplemental Description indicator is turned on in an item’s
Master List entry.

To view or modify a contract line item:

1. On the Contract Records panel, double-click the Items icon. The Items window opens.
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2. To select a contract, project, and contract item, click the Open button. The Select Contract
ID window opens.

3. Inthe Contract ID list box, scroll to and double-click the contract. The projects for the
selected contract are listed.

4. In the Project list box, scroll to and click the project. The contract items for the selected
project are listed.

5. Inthe Items list box, scroll to and click the item.

6. Click OK. The Items window opens and displays data for the selected item.

8.

To change the item’s status, click the expand arrow to the right of the current selection and
click the status type in the Status Type drop-down list,.

To save modifications, click the Save button.

Items that are not on the Item Master cannot be added to a contract through the Items window. To
add an item to an active contract, refer to the change order topic.

To add an item to a pending contract:

1.
2.

On the Contract Records panel, double-click the Items icon. The Items window opens.

To select both a contract and a project, click the Services menu and click the Choose Keys
choice. The Select Contract 1D window opens.

In the Contract ID list box, scroll to and double-click the contract. The projects for the
selected contract are listed.

In the Project list box, scroll to and click the project.
Click OK. The Items window opens and displays data for the selected item.

In the Line Item Nbr field, type a unique contract line item to identify the item on the
contract.

Press the Tab key.

To group this item under a category, click the expand arrow and click the category in the
Category drop-down list.

In the Item Code field, perform a Search. After an item is selected from the Item Master,
the system fills in some of the data on the Items window.

10. To indicate that the item is considered major, select the Major check box (ON).

11. To indicate that the item is considered a specialty item, select the Specialty check box (ON).
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12. Press the Tab key.

13. In the Unit Price field, type the unit price of the item.

14. Press the Tab key.

15. In the Bid Quantity field, type the original quantity of the Line item.

16. To group this item with other Line items, click the expand arrow and click the related item
code in the Related Item drop-down list.

17. To indicate that the item is considered critical, select the Critical check box (ON).
18. To indicate that the item is paid to plan quantity, select the Pay Plan Qty check box (ON).
19. If desired, tab to the Supplemental Description field(s) and type a description.

20. Click the Save button.

5.9 Contract Funding

The Contract Funding window lets the user specify funding for the whole contract, and for the
contract’s projects, categories, and line items. The Contract Funding window lists the current
funding specifications in the top datawindow. Data for the selected funding record is displayed in
the bottom datawindow. If the user adds funding that does not match the funding selection on the
Contract Description folder tab (i.e., Federal, State/Province, or Both), SiteManager automatically
updates the Contract Description folder tab.

Active contracts must be fully funded. For any part of the contract funded by multiple sources, the
combined funding must equal 100 percent. If more than one priority level is assigned, the combined
funding for each priority level must equal 100 percent. In addition, each funding source can be
assigned a cap amount. When the highest priority funding source reaches its cap amount, the
funding source with the next highest priority continues the funding. If the lowest priority level fund
has a cap amount, the cap amount is ignored until a lower level fund is added.

When adding a project to an existing active contract, the project must have funding associated with it
prior to creating the change order that adds items to the project. Change orders cannot be approved
without a funding source for line items associated with the project or category.

5.9.1 Related Item Codes

Line items with the same Proposal Line Number or Related Item Code can be funded together.
Related Item Codes can be created specifically to group line items (e.qg., all traffic control items) for
funding purposes. To do this, the user creates a Related Item Code in the system code tables and
associates Line items with this code on the Items window. The user can then select a funding source
for Related Items on the Contract Funding window.
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Funding sources are defined in the Contract Administration reference tables.

E Contract Funding

Contract ID: |SITEMGFI_D1

I[= B3

Contract ID
Number

SITEMGR_O

LT13534BC011

SITEMGR_0N LT13534BC01-1  |0005

Project Humber  Category Line Item

Funding Source Code Priority | Source Parti_~
Number Order | pation Perce

INTERSTATE FUNDS 100.00
CONYERSION FEDERAL FLINDIN1 100.00

<] |

Project Number: |LT18594BCEI1 -1
Category Number: |
Line Item Number: |

Local Agreement Nbr: §

Funding Source Code: |INTEFESTATE FUNDS

Source Participation Percent: | 100.00°  Priority Order: |_1

Combine: | () | e llem Code

Fed/5State Project Mbr: |

State Accounting Code: IW
State Funding Code: I—
Original Cap Amt: I—DDD
Current Cap Amt: I—UDD

O Proposzal Num
@ MHaone
Related Item: |
Proposal Line Nbr: I—
Prev Estimates Amt Used: 0.00
Current Estimate Amt Used: 0.00

Figure 5-18. The Contract Funding Window

Field Name

Description

Funding Source
Code

Identifies a particular source of funding (e.g., federal grant,
federal fuel tax, state general fund). This is a required field.
After a record is saved, this field is protected. To change

the Funding Source Code, delete the record and add it again.

Project Number

Agency-defined ID for the project. Lists projects within the
contract.

Fed/State Project
Nbr

The federal or state project number for the project.

Category Number

A grouping of items assigned during preconstruction. ltems
can be grouped within categories for various reasons,
primarily for funding. Lists categories within the contract
and project.

Priority Order

Indicates the order in which funds are appropriated to the
contract. The valid range is between 1 and 9.
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Field Name

Description

Line Item Number

The Contract Line Item Number that identifies each item as
it appears on the contract. All bid Line Item Numbers are
assigned by the preconstruction function. Line ltem
Numbers added to the contract after construction begins are
assigned by the user.

Local Agreement
Nbr

Number used to identify an agreement between a local
authority and the agency. The agreement defines the
funding provided by the local authority with regard to a
particular job.

Source The percentage of the total amount in the project or

Participation category provided by the Funding Source. (For example,

Percent many federal aid funding sources provide 80 percent of the
funding for the project or category.). This is a required
field; a valid percentage is between 1 and 100.

Combine This field indicates whether items are combined by Related

Item Code or Proposal Line Number for funding purposes.
This is a required field. Select None to combine no items.
To combine items under the same funding source, the user
selects either Like Item Code or Proposal Number. When
Like Item Code is selected, an entry in the Related Item
field is required. When Proposal Number is selected, an
entry in the Proposal Line Nbr field is required.

Proposal Line Nbr

The line number that identifies the item as it appears on the
proposal. This is a required field when the user selects the
Proposal Number radio button.

Related Item

Related item codes allow grouping of items (e.g., all traffic
control items) for reporting and funding purposes. To group
items for funding by the same source and percentage, if the
items are not in the same category, the user creates a
Related Item code and selects items with this code in the
funding process. To report Items together, the user creates a
Related Item code, such as RPT1 = Report 1, and then
creates a report that selects and groups these items together.
This is a required field when the user selects the Like Item
Code radio button. The Related Item codes are defined in
the system code tables.

State Funding
Code

Agency-defined code needed by financial system.

5.9 Contract Funding
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Field Name Description

State Accounting | Agency-defined code needed by financial system.
Code

Original Cap Amt | Original funding limit.

Current Cap Amt | Current funding limit.

Total Amt Used Amount used up to the last paid estimate.

Current Amt Used | Amount used in the current estimate.

Table 5-22. The Funding Source Window Fields Table

To add funding to a contract:

1.

10.
11.
12.
13.
14.

On the Contract Records panel, double-click the Contract Funding icon. The Contract
Select List opens.

In the Contract ID list box, scroll to and click the contract.
Click OK. The Contract Funding window opens.
Click the New button.

To select a project number, click the expand arrow and click the project number in the
Project Number drop-down list.

To select a Category Number, in the Category Number drop-down list, click the expand
arrow and click the Category Number.

To select a Line Item Number, click the expand arrow and click the Line Item Number in the
Line Item Number drop-down list.

Press the Tab key.

In the Local Agreement Nbr field, type the number used to identify an agreement between a
local authority and the transportation agency.

Press the Tab key.

In the Fed/State Project Nbr field, type the federal or state project number.
Press the Tab key.

In the State Accounting Code field, type the state accounting code.

Press the Tab key.
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15.
16.
17.
18.
19.
20.

21.

22.
23.

24,

25.

26.

27.
28.
29.
30.
31.

In the State Funding Code field, type the state funding code.
Press the Tab key.

In the Original Cap Amt field, type the original funding limit.
Press the Tab key.

In the Current Cap Amt field, type the current funding limit.

In the Funding Source Code drop-down list, click the expand arrow and click the source of
funding (e.g., Federal grant, Federal fuel tax, State general fund).

In the Source Participation Percent field, type the percentage of the selected project,
category, or line item provided by the source.

Press the Tab key.

In the Priority field, type a value between one and nine that indicates the order in which the
fund is appropriated to the contract.

To apply funding to combined Line items, click the Like Item Code or Proposal Number
radio button in the Combine field.

If Like Item Code is selected, tab to the Related Item field, click the expand arrow and click
the Related Item Code.

Or

If Proposal Number is selected, tab to the Proposal Line Nbr field, click the expand arrow
and click the Proposal Line Number.

Press the Tab key.

In the Total Amt Used field, type the amount of funding used, up to the last paid estimate.
Press the Tab key.

In the Current Amt Used field, type the amount of funding used in the current estimate.

Click the Save button.

Active contracts must be fully funded. The system prompts the user to fully fund the contract if any
part of the contract is not funded 100 percent.

To modify contract funding:

1.
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2. Inthe Contract ID list box, scroll to and click the contract.

w

Click OK. The Contract Funding window opens.

&

In the Contract Funding list box, scroll to and click the funding record.
In the bottom datawindow, tab to the fields to be modified and enter data.

6. Click the Save button.

5.10 Contract Group Authority

Contract Group Authority works in conjunction with other security features to give users the
authority to access and modify contracts. The user’s ability to add, modify, or delete contract data
also depends on the user group window access rights, the office level assignment, and whether or not
the user is assigned to a group that has Office-wide contract Access. This section includes a brief
summary of Contract Authority and the following three security features:

= Window Access Rights
= Office-wide Contract Access

= Contract Authority (Contract-specific)

5.10.1 Window Access Rights

Window security is the highest security level in SiteManager. Window access rights determine the
user’s ability to view and modify SiteManager windows. To view or modify a specific type of
window, the user must belong to a user group that has been assigned inquiry or update access rights
for that window. Inquiry access rights let the user view the window. Update access rights let the
user add and delete data on a window. The states and provinces assign user groups and window
access rights to meet their specific needs. To be given Contract Authority, a user must first be
assigned to a user group with window access rights to the Contract windows.

5.10.2 Office-Wide Contract Access

Office-Wide Contract Access for a group gives a user the authority to view or modify any contract
delegated to the office to which the user is assigned when the user is logged on under that group.
Most states and provinces have three office levels. In SiteManager, the office labels are user-
defined. The Level 1 office is always the transportation agency headquarters.

= Level 1 Office (Central office or DOT)

= Level 2 Offices
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= Level 3 Offices
= Level 4 Offices
Each user is assigned to an office level.

For example, a user is assigned to the Level 1 office and the user has office-wide contract access for
the Project Manager group. When the user is logged on under the Project Manager group, the user
can view, add, modify, or delete any contract delegated to the user’s state or province.

A user who is assigned to the Level 2 office and who has been assigned to the office-wide contract
access Project Manager group can view, add, modify, or delete any contract within the user’s Level
2 office. A user must have at least Level 2 Office-Wide Contract Access to add or delete contracts,
milestones, projects, categories, and items.

5.10.3 Contract Authority Examples

Window security can give the user window access rights to contract panels. Contract Authority can
only give the user access to specific contracts. The assignment of Office-Wide Contract Access
groups to a user allows the user to access all the contracts administered by their respective office
when the user is logged on under those groups. All states and provinces require a Project Manager
and Project Engineer for all contracts. To give a user the authority to view, modify, or add and
delete contract data, the following assignments are required:

To view contract data, the user must

Belong to a user group with inquiry access rights to the contract panels, and have one of the
following:

= Contract Authority and group access assignment specific to the contract
OR
= Office-Wide Access with group assignment

To modify contract data, the user must

Belong to a user group with update access rights to the contract panels, and have one of the
following:

= Contract Authority and group access assignment specific to the contract
OR
= Office-Wide Access with group assignment
To add or delete a contract, the user must

= Belong to a user group with update access rights to the contract panels
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= Have at least Level 2 Office-Wide Contract Access

= Belong to the office that administers the contract

Contract Authority Example 1

The state or province needs personnel authorized to view and modify all state or province-wide
contracts, add new contracts online, and delete contracts that are incorrectly built.

1. Assign specific users to the Level 1 office.

2. Create a user group, e.g. Contract Administrators, with window update access to all contract
windows.

3. Assign Level 1 office users to the Contract Administrators user group with office-wide
contract access.

To implement Example 1, the Contract Administrators user group would be assigned update access
rights for all contract windows except Daily Work Reports, which would be inquiry access only.
Additionally, the user’s assigned office would be Level 1. The user would be assigned to the
Contract Administrator group and the office-wide check box would be selected ON. If a Contract
Administrator attempts to open a Contract window, the window will first look at the user’s window
access rights. Since the user has window access rights, the window will next look at the user’s
Contract Access, and permit or deny access accordingly. In the case of the Daily Work Report
window, the system would discover that the user has inquiry rights. The system would permit the
user to view the Daily Work Report window but not add, update, or delete a Daily Work Report.

Contract Authority Example 2

The state or province needs personnel authorized to view and modify all Level 2 office contracts.
These users would not be able to view or modify any contracts not assigned to their office.

1. Assign specific users to the Level 2 office.

2. Create a user group, e.g., District Project Engineers, with window update access to all
Contract windows except:

=  Windows relevant to an inspector’s Daily Work Reports (inquiry only)
= Daily Work Report approval window (inquiry only)

3. Assign Level 2 office users to the District Project Engineers user group with office-wide
contract access.

If a user in Example 2 needs to view or update a contract out of the office’s jurisdiction, the user will
need Contract Authority for that contract. Because the user group has window update access, the
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user would be able to modify any contract he is assigned to through Contract Authority. The user
would not be limited to view-only access for this contract.

Contract Authority Example 3

The state or province needs Level 3 office personnel assigned as Daily Work Report Inspectors who
can view and modify specific contracts only.

1. Assign users to the Level 3 office.
2. Create a user group, e.g., Project Inspectors, with the following window access rights:

= Inquiry access to specific Contract windows, such as those related to daily work items
and reporting.

= Update access to windows relevant to an inspector’s Daily Work Reports.
3. Assign the Level 3 office users to the Project Inspectors user group.

4. Assign Contract Authority for specific contracts to individual Project Inspector users.

5.10.4 Contract Authority

The Contract Authority window displays the users, office level assignments, and group assignments
for each individual user. When the Project Manager and Project Engineer are added to the contract,
the system automatically adds a row for each user’s group assignment to the Contract Authority
window. An authorized user can end Contract Authority for personnel no longer needed to work on
the contract.

ﬂ Contract Authority @@@
User Identification
User ID User Hame Cen Reg Res -
ABBOTTR Rodney Abbatt, Region 2 Project Engineer Mo 2 250
ABEYTAR Richard Abeyta, Parsons Brinkerhoff Mo E 211
ADAMSONE Earbara Adamson, Region 3 Mo 3 40
AGUILAR John Aguilar, Region 2 Mo 2 220
ALDORFEB Bill ldorfer, Region 4 Mo 4 240
AMDERSER Eary Andersen, Region 3 Mo 3 130
ARCHULEE Edward Archuleta, Region 3 Mo 3 130
ARTZERD D arrel Artzer, Region 4 Mo 4 340
ASHOURYK Kevin &shoury, HE Resident Enginesr Mo 0 164
ATKINSR Ralph Atking, Region 2 Mo 2 220 ~

Contract Authority Assignment

Group Description Dffice-wide Contract Id Contract Description Authority Authority
Access Start Date End Dt
Administrative Assistant v
Cost Estimates v
Finalz Engineer v
Ingpector Standalone [
Field Inspector/Tester v
Field Ingpector/Tester - Standalone v
Manager - Inquiry Onhy W
Project M v

Figure 5-19. The Contract Authority Window
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Field Name Description
User ID Agency-defined ID of the user.
User Name Name of the user with this ID.
Cen Central Office Assignment. Indicates whether the user is
assigned to the central office.
Reg Region. The user’s level 2 region assignment.
Res Residency. The user’s level 3 office assignment.

Group Description

Drop-down list containing all the current user’s active
group assignments. The administrator selects from
among these groups to assign the user office-wide or
specific contract authority. Upon selecting a new value,
the office-wide access and contract ID fields are cleared.
Required field.

Office-wide Access

This field indicates whether the user has been assigned
group access rights to all contracts within the user’s
assigned office. This field is protected if the user already
has current, non-end-dated, office-wide contract authority
for the specified group. Once this field is selected, the
contract field is cleared and protected.

Contract ID This field is required if Office-wide Access is not
selected. Identifies the contract to which the user is
assigned group access rights. The search capability for
this field is limited to contracts on which the user is not
currently assigned authority.

Contract Protected field. Describes the contract to which the user

Description is assigned group access rights.

Authority Start The date Contract Authority begins for this user. The

Date value defaults to the current date when a save is

performed. This field is only populated for contract-
specific rows. It is not used for office-wide contract
authority.

83



Trnseport SiteManager®
5. Contract Administration - New Contracts 5.11 Key Dates and Checklist Events

Field Name Description

Authority End Date | The date Contract Authority ends for this user. Upon
choosing End Contract Authority from the window’s
Services menu, a popup window displays, allowing the
end user to enter the desired Contract Authority ending
date. This date can be the current or future date. The
current date is the default date. This field is only
populated for contract-specific rows. It is not used for
office-wide contract authority.

Table 5-23. The Contract Authority Window Fields Table

To grant a user Contract Authority:

1.

S.
6.

On the Contract Records panel, double-click the Contract Authority icon. The Contract
Authority window opens.

Select and click the desired user ID.
Click the New button. The New Contract Group Authority window opens.

In the Group Description field, click the down arrow to the right of the field, and select the
desired group.

If desired, use the Search function to select a specific contract.

Click the Save button.

To end a user’s Contract Authority:
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1.

On the Contract Records panel, double-click the Contract Authority icon. The Contract
Authority window opens.

Select and click the desired user ID.
Select and click the desired group in the lower datawindow.

If the authority is specific to a contract, click the Services menu and select the End Contract
Authority choice. In the Contract Authority End Date popup window, enter a valid date and
click the OK button. Valid dates that can be entered in this field are the current date or a
date in the future.

If the authority is office-wide access, click the Delete button.

Click the Save button.
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5.11 Key Dates and Checklist Events

Key Dates and Checklist Events allow the user to establish, monitor, and maintain a series of key
dates and scheduled events specifically related to the administration of the contract. The messages
and discrepancy tracking associated with Key Dates and Checklist Events enhance the ability of the
user to administer the contract. For more information, refer to the Key Dates, Checklist Scheduled
Events, and Checklist Event Dates topics.

5.12 Progress Schedule

The Progress Schedule window lets the user add, modify, and view a contract’s Progress Schedule.
The user selects a schedule type, enters time periods, and enters the percentage of contract work to
be completed in each time period. The time periods are measured in either days or dates, depending
on the Time Charges Type of the contract. If the Critical Path Method schedule type is selected,
only the final day or date can be tracked. If a schedule type is not selected, SiteManager does not
track the contract’s progress.

A daily batch process calculates the actual percentages of the contract time and work completed in
each time period. If the work falls behind schedule by an amount that exceeds the Variance
Percentage, the batch process notifies contract personnel. The user can override the percentages
calculated by the batch process and enter new values. If the user changes the schedule type, any
time period with an actual percentage value is deleted and the user can enter new time periods.

The Progress Schedule window displays a column graph corresponding to the schedule data. The
graph displays the actual percentage completed (amount and time) versus the schedule. The user can
maximize the graph by clicking the maximize box and return it to original size by clicking the
original box.
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4 Progress Schedule

Fed/State/Prov Prj Nbr: INH-485-5[DS1] Time Charges Type: |Calendar Days =

Description: |.JEIB DES. 185-34B; JOBS 20761,22505
Location: |BELTWAY - FAIRF&X CO.

Prime Contractor: |SHIF|LEY COMTRACTING CORP. Curmrent Days: |1 20
Progress Schedule Type: |Percent Complete for a Time Period =] Yariance Pct: |5.EID
[Gched] Sched [Anticp pct|Actual pet| Actual pe _‘l =] B
Date |Compl Amt|Compl Amt|Compl Ti
ate T-0mp” Am-Omp: Aml-0mp” " m Progress Schedule for Contract SITEMGR_01
30 20.00 10.00 25.00 -
60 45.00 0.00 0.00 =
80 55.00 0.00 0.00 g
o
30 73.00 0.00 0.00 -
120 10000 [0.00 0.0 g I
&

Schadu |=|:|=,=

| B 1) ficpfmaun. [ 2) dcumlfmaue. E ) Acusl Time

Figure 5-20. The Progress Schedule Window

Field Name Description

Fed/State/Prov Prj Federal, state, or province project number for the
Nbr contract, project, or category.

Current Days The current number of days required to complete the
contract. This is the sum of the bid days and the total
adjustment days for the contract.

Description Text description of the contract.

Location Text describing the physical location of the contract
work site.

Prime Contractor Short name for the Prime Contractor for the contract.

Time Charges Type | Indicates how time charges are assessed for the contract
(i.e., Available Work Days, Calendar Days, Fixed
Completion Date).

Progress Schedule Type of Progress Schedule used for the contract (i.e.,
Type Percent Complete for a Time Period, Percent of Critical
Items Complete for a Time Period, and Critical Path
Method). If the Progress Schedule type is changed, the
data is deleted and the user can enter a new Progress
Schedule. If the selected schedule type is Critical Path
Method, only the final day or date is tracked.
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Field Name Description
Sched Days/Date Number of days or date in which the work is expected to

be done. Either Schedule Days or Schedule Date is
displayed, depending on the time charges type of the
contract. If the time charges type is Available Work
Days or Calendar Days, only days are tracked. If the
time charges type is Fixed Completion Date, only dates
are tracked.

Anticp Pct Compl Anticipated Percentage Completion of the Contract’s
Amt scheduled dollar amount by the end of the scheduled
period. The sum of the percentages for all time periods
in the schedule must equal 100.

Actual Pct Compl Actual Percentage Completion of the Contract’s dollar
Amt amount by the end of the scheduled period. A daily
batch process calculates this value. The user can
override this value. Actual percentages cannot be
entered for future days. The formula for computation of
this field is as follows: Earnings to date / Contract
amount * 100

Actual Pct Compl Actual Percentage Completion of the contract’s

Time scheduled time by the end of the scheduled period. A
daily batch process calculates this value. The user can
override this value. Actual percentages cannot be
entered for future days.

Table 5-24. The Progress Schedule Window Fields Table

A daily batch process calculates the actual percentages of the contract time and work completed in
each time period.

To create a Progress Schedule:

1. On the Contractor Management panel, double-click the Progress S